


THE 

OPERATING 
SYSTEM 

HANDBOOK 
DAVE PROCHNOW 

No. 2742 
$23.95 



Notice 

The companies Horizons, Inc., and Futures Marketing, Inc., their addresses, personnel, and financial 
histories are totally fictitious. Any similarity between these representations and comparable contem
porary parties is purely coincidental. 

Trademark List 

The following trademarked products are mentioned in The GEM Operating System Handbook: 

AutoCAD 
COMPAQ computers 
Crosstalk XVI 
dBASE III 
GEM Collection 
GEM Draw 
GEM Graph 
GEM Paint 
GEM WordChart 
GEM Write 
IBM BASIC 
IBM PC 3270, PC, PC AT, PCjr, and PC XT 
IBM PC-DOS 
Lotus 1-2-3 
Turbo Pascal 
WordStar 

FIRST EDITION 
FIRST PRINTING 

Copyright © 1987 by TAB BOOKS Inc. 
Printed in the United States of America 

Reproduction or publication of the content in any manner, without express 
permission of the publisher, is prohibited. No liability is assumed with respect to 

the use of the information herein. 

Library of Congress Cataloging in Publication Data 

Prochnow, Dave. 
The GEM operating system handbook. 

On t.p. the registered trademark symbol "TM" is superscript following "GEM" 
in the title. 

Includes index. 
1. GEM (Computer operating system) I. Title. 

QA76.76.063P76 1986 005.4'3 86-14555 
ISBN 0-8306-0942-3 

ISBN 0-8306-2742-1 (pbk.) 



Contents 

Preface 

Acknowledgments 

Introduction 

1 The GEM Environment 
GEMPREP-Working on the Desktop-The GEM Desktop Menus-Additional GEM Desktop Manage
ment Commands-Output-GEMSETUP-Keyboard Equivalents 

2 GEM Cutters 
Apricot PC-Atari 520ST-IBM PC and IBM PC/XT 

3 GEM Collection 
GEM Paint-Installing GEM Paint-Using GEM Paint-GEM Paint Reference-Advanced 
Techniques-GEM Write-Installing GEM Write-Using GEM Write-GEM Write Reference-Advanced 
Techniques 

4 GEM Draw 
Installing GEM Draw-Using GEM Draw-GEM Draw Reference-Advanced Techniques 

5 GEM Graph 
Installing GEM Graph-Using GEM Graph-GEM Graph Reference-Advanced Techniques 

vi 

vii 

viii 

1 

50 

68 

112 

131 



6 GEM WordChart 

7 

8 

9 

Installing GEM Wordchart-Using GEM Wordchart-GEM Wordchart Reference-Advanced Tech
niques 

Some Notes on The GEM Programmer's Toolkit 
GEM VOl-GEM AES-GEM Resource Construction Set 

Twin Gems 
Finder-Desktop 

Paste 
DESQview-Windows-Postmortem 

Appendix A GEM Version 2.1 Summary 

Appendix B GEM-DOS Equivalents 

Appendix C GEM Icon Summary 

Appendix D The GSX Standard 

Appendix E Using Software in the GEM Environment 

Glossary 

Index 

147 

164 

173 

179 

185 

196 

198 

200 

202 

206 

210 



To my dearest Kathy 



Preface 

Not too long ago, a friend of mine was loading DOS into her new IBM PC XT when 
she was greeted by the staid A> prompt. "Is that it? " she asked. In many ways, this 
succinct response clearly illustrates the major problem with DOS. Dealing with an ap
plication as powerful as DOS's COMMAND. COM through such a nondescript inter
face isolates the user from a successful and harmonious interaction with the program. 
Even worse, extreme cases of this DOS isolationism can lead to computer apprehen
sion and "DOS dread." With all of these negative aspects handcuffing DOS, there's 
got to be a better operating system "mousetrap." 

Icons are one method for cutting through the fog created by an obfuscatory oper
ating system. These pictorial representations of system attributes and command se
quences make the actions and functions of an operating system completely invisible 
to the user. Fortunately, there is no exorbitant price to pay for this simplicity. In other 
words, all of the power and versatility of DOS is still present only the visual presenta
tion of the operating system has been changed (obviously, to protect the innocent). Once 
you have been convinced of the merits of an icon-based operating system, your remaining 
task is to locate a suitable environment for controlling your computer. This book is 
dedicated to the exploitation of one such icon-based operating system-GEM. 

GEM has its share of exciting characteristics, some of which were not originally 
intended by the system designers at Digital Research, Inc. These surprises range from 
subtle techniques for deriving the maximum productivity from GEM to the Apple Com
puter copyright infringement lawsuit. Even the current version 2.1 release of GEM 
confronts the GEM user with several interesting problems. All of these situations and 
more are covered within the pages of The GEM Operating System Handbook. 
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Throughout this book you will be guided by tip, warning, and caution "flags." Each 
of these informative passages will enhance your ability to use GEM. You can think 
of these "help sections" as the information that DRI forgot to tell you. 

Basically, the structure of this book supplies in-depth instruction on four key GEM 
topics: the GEM Desktop, GEM system requirements, GEM-based applications, and 
programming the GEM environment. After a brief introduction to operating systems, 
Chapter 1 covers every aspect of the GEM Desktop. Since the remainder of this book 
draws heavily from the principles learned in this chapter, make sure that you compre
hend this information before forging ahead. Of course, should you ever stumble across 
some unfamiliar GEM terrain, you can always return to Chapter 1 for a refresher course. 

Chapter 2 looks at every aspect of the hardware that is necessary for running GEM. 
From computers to monitors, any question about what will and what won't work with 
GEM is answered. Apricot, Atari, and even IBM compatible users will find this chap
ter beneficial in identifying the peculiarities that will tum their computers into GEM 
cutters. 

All five of the major GEM -based applications (the GEM Collection contains both 
GEM Paint and GEM Write) are thoroughly detailed in Chapters 3 through 6. In covering 
each of these applications, a standard chapter format is used. First, the complete in
stallation procedure is annotated with informational messages when necessary. This 
section is followed by instructions on using the special features that are inherent to 
the application. Finally, concluding each chapter are two sections dealing with advanced 
user techniques and reference material for increasing your functional understanding 
of each application. 

The last GEM area that receives special attention is programming your own appli
cations and desk accessory through The GEM Programmer's Toolkit. Chapter 7 de
tails the special features of this programming package, as well as some of the special 
GEM-specific tools that are available to the programmer. 

Supporting these four, information-packed GEM topics is a thorough appendix, a 
detailed index, and over one hundred clear illustrations. And, for you GEM skeptics, 
there is even an unbiased accounting of several other alternative operating systems 
(Macintosh, DESQview, Windows, and Top View). In fact, if you feel that your com
puter is currently a diamond in the rough, then The GEM Operating System will help 
you polish this jewel into a GEM. 

One glowing virtue of a book like The GEM Operating System Handbook is the wealth 
of "inside" information that fills its pages. Granted, much of the labor involved in the 
extraction of this material rests squarely on the shoulders of the author. There were 
several instances, however, where outside help was the only visible option for giving 
you, the reader, the type of in-depth coverage that you demand. In these instances, 
Digital Research, Inc., and Heath/Zenith, Inc., proved receptive to the task of data dis
semination. At DRI, Judy Mervis, Director of Corporate Communications; Bill Higgs, 
Product Marketing Manager; and "transplanted" Tony Harris fielded my every re
quest without hesitation. At Heath/Zenith, Bill Stewart was more than generous with 
his information on Zenith/GEM compatibility. 
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Introduction 

Somewhere along the line of computer evolution, a systems programmer decided that 
communicating with the computer should be powerful, versatile, and flexible. It was 
from this altruistic thought that the computer operating system was born. Actually, 
this was a remarkable breakthrough from the complex binary and hexadecimal "switch
throwing" that marked the computer's infancy. When you wanted your IBM 7070 Data 
Processing System to execute a normal disk read on an IBM 7300 Disk Storage Unit 
(either Modell or Model 2), the mnemonic command DR, along with its associated 
accumulator referencing, would carry out this operation. In a strict sense, however, 
this was not an operating system. The term system, in these early four-digit IBMs, re
ferred to the hardware level and not a software resident control environment. There
fore, the 7070 was not too far removed from its hardwired ancestors. If you doubt this 
claim, just ask any seasoned 7070 or 7090 programmer about wiring an IBM 7500 Card 
Reader Control Panel. 

A truer representation of the beginning of a classical operating system could be 
found in the Burroughs B 2500 and B 3500 Systems. In this case, the Master Control 
Program (MCP) served as the vital link between computer and program. MCP-related 
functions controlled program loading and execution, program memory allocation, lan
guage library creation, input/output supervision, and error handling. The real savings 
in the presence of a crude operating system, like the Burroughs MCP, was the insula
tion of the programmer from primitive opcode and mnemonic coding-not to mention 
the elimination of wired control panels. This reduction in complexity underlined the 
strength of a powerful operating system. 

Further advancements in large system operating systems were made under the 
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direction of IBM. In fact, their 360 system stands as both a hardware landmark and 
an operating system milestone. The Operating System/360 (OS/360) was an elaborate 
operating system supporting complex language processors, symbolic allocation of I/O 
(Input/Output) device drivers, and vast application programs. 

At the heart of OS/360 was the Primary Control Program (PCP), which formed 
the basis for all other control programs and linked basic single-job operating system 
functions. Of course, handling multiple programming assignments concurrently was 
the real forte of OS/360. Multiprogramming with a Fixed number of Tasks (MFT) and 
Multiprogramming with a Variable number of Tasks (MVT) were the concurrent con
trollers for partitioning the 360's core storage environment. 

A much more interesting development with the IBM 360 (at least with regards to 
our examination of emerging operating systems) was Disk Operating System/360 or 
DOS/360. This completely disk-resident operating system was relegated to systems 
with a minimum 16K bytes disk-based system configuration. Like OS/360, DOS/360 
had a core control program that maintained program development, I/O support, and 
application execution. Additionally, DOS/360 was able to execute a maximum of three 
programs concurrently. This multiprogramming ability required a minimum of 24K 
bytes of main storage. 

After the introduction of the IBM 360, programmers' appetites for a complete oper
ating system were whetted, and manufacturers intensified their development of a more 
comprehensive environment. Even with this increased demand for an inclusive oper
ating environment for large systems, it wasn't until the release of the personal home 
microcomputer that the operating system finally matured. An excellent example of this 
mainframe operating system maturation is evident in the Honeywell Series 60 (Level 
66)/6000 System. The General Comprehensive Operating Supervisor, Time Sharing 
System, File and Record Control, General Loader, and Unified File Access System 
formed the basis for this typically complete, late 1970s operating system. 

Gone were the days of switches, hardwiring, and obscure mnemonics and opcodes. 
In order for a microcomputer to be a commercial success, it had to have a simple com
puter/program interface. This simplicity translated into an independence from direct 
machine-level programming. In other words, it was no longer necessary for a computer 
operator to occupy the additional role of programmer. The microcomputer ushered in 
the age of the user. 

THE BIG BREAK 

The first real mover in this new, user-oriented operating system market was CP/M. 
CPIM, or Control Program for Microprocessors, is an 8-bit operating system designed 
by Digital Research, Incorporated, (DR!) for microcomputers based on the Intel 8080 
and Zilog Z-80 Microprocessor Unit (MPU). The flexible structuring of CPIM makes 
for an extremely portable software environment. This programming portability means 
that software applications can run on numerous microcomputer designs and requires 
only a minor alteration in their disk format for successful operation. Vast non-brand 
specific software libraries, whose computational strength rivaled the power of some 
of the larger mainframe systems' programs, are now within reach of the microcom
puter user. Advancing this cause for "universal software" even further are special disk 
formatting utilities that can configure a disk drive to read and write in any manufac-
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turer's CP/M disk format. 
Through all of this software revelry, CP/M exerted only a modest demand on the 

system hardware: a minimum RAM (Random Access Memory) of 20K bytes, at least 
one floppy disk drive, and a single-density Intel MDS 800 disk format. In spite of these 
loose requirements, a hardware standard slowly crystallized for the "typical" CP/M 
computer. The generic CP/M computer contained 64K bytes of RAM, two floppy disk 
drives, and used a single-sided, single-density disk format (Fig. I-I). These initial hard
ware standards were slowly eliminated by manufacturers designing their own machine
specific I/O drivers. 

A fitting tribute to CP/M is that unlike its operating system forerunners, it remains 
a popular environment today. After undergoing several revisions and numerous com
plete facelifts (e.g., CP/M-86, Concurrent CP/M-86), CP/M Version 2.2 stands as the 
definitive standard for this particular operating system. CP/M 2.2 consists of four sub
system segments: 

o Basic I/O System (BIOS) 
o Basic Disk Operating System (BDOS) 
o Console Command Processor (CCP) 
o Transient Program Area (TP A) 

Fig. 1-1. One of the more popular CP/M microcomputers, the KAYPRO II, still serves a large variety of users. 
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The BIOS is a hardware-level control interface for directing the read/write actions 
of both peripherals and mass storage devices (e.g., floppy disk drives). It is this seg
ment that is reprogrammed or "patched" by computer manufacturers for accommodat
ing the peculiarities of their unique hardware design. 

All floppy disk control is monitored by the BDOS. The BDOS maintains each disk 
drive's (there can be up to 16 disk drives) file directory and controls the allocation of 
disk space for optimal access time. Realizing the ideal disk access time is a feature 
that is dependent on the movement of the disk drive's read/write head. Therefore, BDOS 
works to minimize this head traveling distance. 

The most visible CP/M segment to the user is the CCP. This subsystem serves 
as a link between the keyboard and the remainder of the CP/M operating system. Un
der normal operating conditions, the CCP monitors the keyboard and executes every 
built-in CP/M command that it receives. There are six built-in recognizable CCP 
commands: 

ERA a 
DIR a 
REN u1 =u2 
SAVE xu 
TYPE u 
USER x 

Where: 

Erases the specified file (a) 
Lists the specified files (a) 
Renames the file (u2) as the specified file (ul) 
Saves the specified memory location (x) as file (u) 
Displays the specified file (u) on the console 
Specifies user area (x) 

a an ambiguous file reference 
u an unambiguous file reference 
x an integer value 

The TP A is the final segment in CP/M. This subsystem serves as a temporary 
memory holding zone for programs that are loaded through the CCP. An important 
characteristic of this feature is that once a program is loaded into the TP A, the other 
three subsystems can be removed from the computer's memory. There is also a group 
of basic transient commands that are accessed through the CCP for execution in the 
TP A. These ten transient commands are: 

STATe 
ASM u 
LOAD u 
DDT u 
PIP e 
ED u 
SYSGEN 
SUBMIT u p(x) 
DUMP u 
MOVCPM e 

Generates statistical data on the specified command line (c) 
Loads the CP/M assembler and executes the specified file (u) 
Loads and stores in the TP A the specified "HEX" file (u) 
Loads and executes the Dynamic Debugging Tool 
Loads the Peripheral Interchange Program 
Loads and executes the text editor program 
Generates a new CP/M system disk 
Arranges commands for batch processing 
Prints the specified file's (u) contents 
Configures the CP/M system for the specified memory (c) 
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Where: 

a an ambiguous file reference 
c = a command line 
p a parameter 
u an unambiguous file reference 
x an integer value 

As described above, the CP/M user communicates with the operating system 
through the CCP. In turn, the CCP acknowledges its ability to receive these user-initiated 
commands with a prompt symbol. This prompt consists of two individual parts. The 
first part is a letter representing the currently logged disk drive. The letters A through 
P are the possible disk drive identification symbols. The second symbolic prompt part 
is the CCP ready acknowledgment, which is indicated by "> ." Therefore, a complete 
CP/M prompt for an active A disk drive would be: 

A> 

By no means is the logged disk drive mandated to be the A drive. All of the differ
ent disk drives in the CP/M system can be individually logged. Changing the currently 
logged disk drive takes place through the CCP. In this case, the user first types the 
letter that represents the desired disk drive. This letter designation is then followed 
by a colon. Using this command, 

B: 

switches the currently logged drive to the B disk drive, while 

A: 

returns CP/M: to the A disk drive. 
Once the desired disk drive has been correctly logged, CP/M is able to address 

two types of file references: ambiguous and unambiguous. Both of these file references 
consist of three parts: the filename, a delimiter, and the filetype. Furthermore, the for
mat of these file references, with regard to the three parts, is identical: 

FILENAME. FILETYPE 

In this example, FILENAME can be a maximum of eight characters, the delimiter is 
the period (.), and FILETYPE is commonly a fixed three-character (although a desig
nation of less than three characters is permitted) name. This example is applicable to 
either an ambiguous or an unambiguous file reference. 

An ambiguous file reference is used for nondescript file searching. There are two 
special wildcard characters that are especially reserved for ambiguous file references: 
? and *. These wildcards are used as substitutions for known character positions in 
filenames and filetypes. The? acts as a character-for-character wildcard. For example: 
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?S.COM matches 
WS.COM 
SS.COM 
PS.COM 

In contrast, the * is a word-for-word wildcard. In this case: 

WS.* matches 
WS.COM 
WS.OVR 
WS.EXE 

A potential pitfall with the ambiguous file reference is when coupling these wildcards 
with a destructive command like the erase command ERA. 

An unambiguous file reference is used in the specific search for an exact filename 
and filetype. Any alphanumeric character, except the following, can be used for unam
biguous file references: 

?*.".< >[]-()%/" I 

Therefore, 
WS, LETTER.DOC, PASCAL.COM, and 4MAT.EXE are all legal unambiguous 

file references. 
In order to more fully appreciate the power of the CP/M operating system, let's 

perform five separate disk management functions. Starting with the file MEMCO.TST, 
we will (1) rename this file, (2) copy the renamed file to another disk, (3)determine the 
nature of our copied file, (4) output the file to our printer, and (5) execute the program 
file. 

1. Rename the file. 
REN B:MEMTEST.BAS = B:MEMCO.TST 

2. Copy the file. 
PIP A: = B:MEMTEST.BAS(v) 

3. Status of the file. 
B:STAT A:MEMTEST.BAS $S 

4. Print the file. 
B:PIP LPT: = A:MEMTEST.BAS(fp55t5) 

5. Execute the file. 
A:MBASIC MEMTEST.BAS 

Aside from remembering the proper syntax for each of these commands, CP/M 
disk management activities require that the user keep a constant vigil over the cur
rently logged drive. Failure to correctly monitor this designation could result in a BDOS 
error message (e.g., attempting to copy a file to a read-only disk) and necessitate a 
warm or cold system restart. 

DOS 

One slap against CP/M that isn't an actual fault of the operating system at all is its 
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dependence on 8-bit MPUs. Unfortunately, it was this hardware restriction that was 
to sound the death knell of CP/M. After nearly a seven-year domination, the industrial 
8-bit data/address "standard" was supplanted by the 16-bit MPU. The most notewor
thy member of this new chip architecture is from the Intel 8086 MPU family-the In
tel 8088. The increased data/address space of these new MPUs added computing power 
to the microcomputer that had been previously unavailable with the 8-bit MPU. There
fore, the 16-bit MPUs required an operating system that was able to address larger 
chunks of RAM, format higher density disk drives and, most importantly, address large 
megabyte-capacity hard drives. 

Digital Research, Inc., expressed a keen interest in the maturation of their origi
nal 8-bit-dependent operating system into a revised version that would meet the de
mands of the newer 8088 chips. The result of this development was the ill-fated 
CP/M-86. For the record, CP/M-86 handles all of the hardware requirements imposed 
on the system by the 8088. Furthermore, CP/M-86 retains many of the successful ele
ments of the original CP/M 2.2, such as the built-in and transient command structure 
(see Table I-I). DRI felt that this familiarity lent an air of painless transition for users 
upgrading their 8-bit microcomputers to the newer 16-bit models. IBM, however, had 
different plans. 

Even though the 8088 was the premier 16-bit MPU (let's avoid the issue of the 
8088 having a 16-bit internal structure and an 8-bit external data bus), it took IBM 
to make it the 16-bit MPU standard. This chip standardization was initiated through 
the introduction of the IBM PC line of microcomputers. Starting with the inept IBM 
PC, proceeding to the powerful IBM PC XT, and climaxing with the 32-bit 80286-based 
IBM PC AT, each of these systems sported a new operating system that was destined 
to become the next "industry standard." When the design of this system was under
taken, instead of giving the nod to DRI, IBM enlisted the work of Microsoft Corpora
tion. Microsoft's operating system was known simply as IBM Personal Computer Disk 
Operating System or PC-DOS (DOS rhymes with toss). 

In its lifetime, PC-DOS (and its compatible cousin MS-DOS or Microsoft DOS) has 
undergone numerous version changes with more advanced supersets looming on the 
horizon. Where does this constant upgrading leave the IBM PC user? There are two 
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Table 1-1. A listing of the Commands Found In the 
Current Implementation of CP/M-86 for the IBM PC. 

CP/M-86 Command Summary 

ASM86 (Assembler) 
ASSIGN 
CONFIG 
OOT86 
OIR 
OSKMAINT 
ED 
ERA 
FUNCTION 
GENCMO 
HOMAINT 

HELP 
PIP 
PRINT 
REN 
SETUP 
STAT 
SUBMIT 
TOO 
TYPE 
USER 



Table 1-2. Both the Internal and the 
External DOS Commands for IBM PC-DOS 3.21. 

IBM PC-DOS 3.21 Command Summary 

ASSIGN 
ATTRIB 
BACKUP 
BREAK 
CHDIR 
CHKDSK 
CLS 
COMMAND 
COMP 
COpy 
CTTY 
DATE 
DEL 
DIR 
DISKCOMP 
DISKCOPY 
ERASE 

EXE2BIN 
FDISK 
FIND 
FORMAT 
GRAFTABL 
GRAPHICS 
JOIN 
KEYBxx 
LABEL 
MKDIR 
MODE 
MORE 
PATH 
PRINT 
PRINT 
PROMPT 
RECOVER 

RENAME 
REPLACE 
RMDIR 
SELECT 
SET 
SHARE 
SORT 
SUBST 
SYS 
TIME 
TREE 
TYPE 
VER 
VERIFY 
VOL 
XCOPY 

prevalent attitudes which address this question. First, that PC-DOS is an inadequate 
product that is incapable of handling hardware enhancements without revision. In other 
words, PC-DOS is a nearsighted operating system which lacks sophistication. The sec
ond point of view insists that PC-DOS is a brilliant example of programming for the 
future. In this case, PC-DOS represents the ideal operating system due to its flexibility 
for adapting to every new hardware advancement. Of course, Versions 3.0, 3.1, and 
3.2 of PC-DOS were all released in close proximity to each other without a major inter
vening hardware system release. 

PC-DOS consists of two types of commands: £nternal and external. When DOS is 
booted or loaded into an IBM PC, all of the internal commands are placed into RAM. 
This command core remains in RAM until either the system is rebooted or the IBM 
PC is switched off. One benefit of basing the internal commands within RAM is that 
the DOS floppy disk can be removed from its disk drive. Then, in the future, when 
the user enlists an internal command, the action is performed directly from RAM without 
having to read a DOS disk for instructions. 

Conversely, external commands reside permanently on the DOS floppy disk. There
fore, due to the nature of their residence, external commands require that the DOS 
floppy disk remain in a currently logged disk drive for proper execution. In many 
respects, external commands can be thought of as separate, unique programs that must 
be loaded and run just like their conventional software brethren. Table 1-2 lists all of 
the commands, both internal and external, for PC-DOS 3.2. 

At the disk level, DOS mimics the disk drive designation convention that was in
itiated by CP/M 2.2. Therefore, Drive A is known as the Source drive and Drive B is 
called the Destt"nat£on drive. Additionally, extra disk drives, like a hard disk drive, and 
a virtual device, such as a RAM-based disk drive, are labeled with sequential letters 
of the alphabet. For example, if you have an IBM PC XT with two floppy disk drives, 
one hard disk drive, and a properly partitioned RAM disk drive, the letter designa-
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tions would be A and B for the two floppy disk drives, C for the hard disk drive, and 
D for the RAM disk drive. 

In dealing with files, however, DOS uses a slightly different approach from the 
one espoused by CP/M 2.2. DOS no longer relies on ambiguous and unambiguous file 
references. Instead, a new four-part file specification replaces this former file dichotomy. 
A DOS file specification consists of a drive specifier, a filename, a separator, and an 
extension. For example: 

A:WS.COM 

A: drive specifier 
WS - filename 

- separator 
COM extension 

Looking at each one of these file specification elements individually, the drive speci
fier has two distinct parts. First is the disk drive letter used for identifying the disk 
drive location of the desired file. If the desired file is located on the currently logged 
disk drive, the drive specifier can be eliminated from the file specification. The second 
part of the drive specifier is a colon (:) used as a delimiter for the drive letter. 

The next element of a file specification is the filename. Like a filename in CP/M 
2.2, DOS filenames can be a maximum of eight characters in length and use any al
phanumeric character. Unlike CP/M 2.2 filenames, however, DOS filenames can in
clude the following special characters: 

!@#$%"()--{}"-

These characters: 

·"/'-[]:I< > + =; 

are excluded from filename usage by DOS. 
The period separator in a DOS file specification serves the same purpose as its 

CP/M 2.2 counterpart. Likewise, if an extension is omitted from a file specification, 
then this separator is unnecessary. 

An extension is the final element of a DOS file specification. This optional, three
character (maximum) name is placed to the right of the period separator. Once this 
extension is fixed to a file specification, it must always be used with all future referencing 
of that particular file. 

DOS is also able to use the two wildcard characters, ? and *, found in CP/M 2.2 
for file management. The only difference between the DOS-based? and * and the CP/M 
versions is that DOS refers to them as global filename characters. Their implementa
tion and resultant action remains the same, however. Once again, ? is used as a character
for-character substitute, while * is able to represent from one to eight characters on 
a word-for-word basis. For example, the global filename characters in DOS can be used 
to represent: 
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characters, 

1??EX? 

words, 

*.EXE 

and combinations, 

W???????* 

matches 

matches 

matches 

123.EXE 
1AB.EXP 
19Z.EX5 

123.EXE 
WS.EXE 
XTALK.EXE 

WS.COM 
WSMSGS.OVR 
WSCOLOR.BAS 

As a comparison to the file management ability of CP/M 2.2, let's conduct the same 
five disk operations from the previous section under the direction of DOS. As with the 
CP/M examples, we will start with the file MEMCO.TST. After (1) renaming th!s file, 
we will (2) copy the renamed file to another disk, (3) determine the nature of our co
pied file, (4) output the file to our printer, and (5) execute the program file. 

1. Rename the file. 
REN B:MEMCO.TST MEMTEST.BAS 

2. Copy the file. 
COpy B:MEMTEST.BAS A: /V 

3. Determine status of the file. 
B:CHKDSK A:MEMTEST.BAS N 

4. Print the file. 
B:PRINT A:MEMTEST.BAS 
Followed by: Name of list device (PRN): 
Press the ENTER key. 

5. Execute the file. 
A:BASICA MEMTEST.BAS 

There is a small price to pay for the power of DOS. The increase in the performance 
of DOS has also increased the potential for error. The limited number of error mes
sages that were possible with CP/M 2.2 have been replaced by 86 pages of possible 
DOS warnings and statements. Granted, many of these messages are acknowledgments 
and not system faults, but there is still room for overlooking the proper file specifica
tion and receiving a copy error. Only flawless typing and a watchful eye on the drive 
specifier will reduce the likelihood of a disastrous file erasure. 

ICONS 

One disagreeable aspect that is common to all of the former operating systems is their 
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absolute reliance on a rigid, typed command set. This unpleasantness is not caused 
by the presence of a fixed command structure; to the contrary, it is the onerous en
cumbrance placed on the user for memorizing both the syntax and the orthography 
of each command. A user failing to exercise the prescribed caution over entering any 
of these operating system commands can face at the least an error message and at the 
most the destruction of irreplaceable data. A typical scenario that illustrates the latter 
happening de.als with the DOS COpy command. Imagine that you have just finished 
your perfect Lotus 1-2-3 template and saved a copy onto your working disk. After exit
ing to DOS, you decide to ensure your templates safety by copying it to a backup disk 
which currently holds an older version of the same template. Lacking complete con
centration, you erroneously misrepresent the two drive specifiers and mistakenly copy 
the backup onto the perfected working version, erasing all of your successful work. 
Gads, couldn't DOS incorporate some form of warning system which would at least 
minimize the possibility for large-scale data loss? Even elaborate warnings of potential 
data loss wouldn't alleviate the additional need for proper command spelling. For ex
ample, entering DIP won't give you a disk drive file listing, no matter how many times 
you enter it. Likewise, what warning flag would be appropriate in this situation, "Read 
the manual, dummy"? There has to be a better method for handling these file manage
ment duties. 

One innocuous method for dealing with data, and one that is recognizable by virtu
ally any user, is with pictures. Of course, the adage, "one picture is worth one thou
sand words," lends some credence to this assertion. A computer-based application of 
this technique would be in using a universal graphics representation for each operat
ing system command. Under this pictorial tutelage, the potential for user error and 
confusion would be reduced. Likewise, by coupling these graphics images with a sur
rogate finger-pointing device, keyboard-bound typing errors would be completely elimi
nated. The overall benefits derived from graphics-based, or icon, operating systems 
are that they remove the need for typed command entry and they lessen user bewil
derment from complex, convoluted command structures. Currently, in our tracing of 
the computer operating system lineage, we are standing at this exact evolutionary spot. 

The idea of graphics image application to bewildering concepts is not a new en
deavor. Several ancient civilizations throve on various forms of pictographic writing. 
From Aztecs to Zunis, picture writing created a solid foundation for communicating 
the complex ideas of daily life. Without a doubt, the leading proponents of this pic
torial diagraming were the Egyptians. In fact, the special attributes found in the Egyp
tian pictographs coined the term hieroglYPhic (for you etymologists, this is from the 
Greek word hieros or sacred and the Greek word glyphein or to carve) writing. Egyp
tian hieroglyphs were rich in their ability to represent images (ideographic), words and 
syllables (syllabic), quality hand writing (hieratic), and simplified, everyday hand writ
ing (demotic). If nothing else, this elaborate graphics writing style contributed to the 
education of the masses and the advancement of the civilization. But how does all of 
this relate to computer operating systems? 

If we apply the Egyptian hieroglyphic ideal to the complexity of the computer oper
ating system, we are left, once again, at the doorstep of Digital Research, Inc. DRI 
has studied the need for a better operating system "mousetrap" and created the Graphics 
Environment Manager or GEM. GEM is a graphics-oriented, mouse-controlled operat-
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ing system that provides an intuitive, icon-based command structure, which virtually 
eliminates all dependence on syntax memorization, as well as keyboard entry. Further
more, GEM successfully addresses the issue of software portability. In other words, 
GEM applications can be easily adapted to numerous operating systems (e.g., PC-DOS, 
MS-DOS, TOS) and MPUs (e.g., 8088 and 68000) through only a modest amount of 
recoding. This versatility opens the door for GEM to become the first universal oper
ating system. 

Many of the features that are found in GEM have been adapted from previous re
search. Back in May of 1981 the first commercial computer with an icon-based operat
ing system was released to the public. Developed at Xerox Corporation's Palo Alto 
Research Center (P ARC), the Xerox Star (it was subsequently named the Xerox 8010) 
bore a $50,000 price tag and many of today's GEM attributes. Prevalent among these 
GEM precursors were the use of icons to represent disk file management and the em
ployment of a mouse for control of the operating system. 

Building on this graphics environment start, Apple Computer, Incorporated, made 
the next big advancement in icon-based operating systems with the January 1984 re
lease of the Macintosh computer. This unorthodoxly styled microcomputer (Fig. 1-2) 
gained valuable design lessons from the mistakes Apple Computer made through the 
failure of the Lisa (this was a previous, albeit weak, attempt by Apple to introduce 
an icon operating system). Oddly enough, Apple Computer elected to market the merits 
of their new computer squarely on the shoulders of their operating system. Dubbing 
the Macintosh to be the computer' 'for the rest of us, " this marked the first time that 
the benefits imparted by an operating system outweighed the computation prowess 
of the MPU. This odd marketing strategy must have worked because it was with the 
Macintosh that the first commercially successful footnote in the development of a 
graphics operating system was written. 

The next step was up to DR!. In September of 1984, Digital Research made the 
first announcement of the GEM operating system. Like the armies of Pre-Bolshevik 
Russia leading their troops into battle with icons, DRI launched its own icon-laden cam
paign against a firmly entrenched DOS foe. Digital Research's intent was to provide 
all 8088 computer users with a simple and highly efficient operating system alterna-

Table 1-3. All of the Menu- Resident 
Commands Found on the GEM Desktop. 

GEM Desktop 1.0 Command Summary 

Calculator 
Clock 
Close 
Close Window 
Desktop Info 
Enter DOS Commands 
Format 
Install Disk Drive 
Install Application 
New Folder 
Open 
Print Spooler 

Quit 
Save Desktop 
Set Preferences 
Show as Icons 
Show as Text 
Show Info 
Sort by Date 
Sort by Name 
Sort by Size 
Sort by Type 
To Output 
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Fig. 1-2. The unusual lines of 
the Macintosh computer 
broke all of the established 
computer "rules" when it 
was released in 1984. Re
markably, the computational 
strength of the Macintosh 
played second to the unique 
icon-based operating system. 

tive to DOS. In an attempt to accomplish this goal, GEM featured high resolution 
graphics, enhanced color support, consistent icon representations, drop-down menus, 
accurate screen-to-output depiction (sometimes called what-you-see-is-what-you-get), 
application level information interchange, and mouse control. All in all, GEM achieved 
many of DRI's goals, predominantly with new IBM PC users and other 8088 computer 
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beginners. Unfortunately, GEM still lacks a widespread penetration in the established 
base of DOS users. This trend is changing, however, and further GEM-related soft
ware developments are bound to enhance the general adoption of GEM. 

GEM breaks all of the traditions set by the operating systems discussed in the former 
sections. This is best illustrated by viewing GEM's treatment of the five file manage
ment tasks previously assigned to CP/M 2.2 and DOS. Before undertaking this com
parison, however, a brief mention of GEM file naming is in order. Basically, all 
references to file types and file specifications have been removed from GEM. Only 
the generic term item is used for referring to any GEM file, whether it is an application 
or a document. A simple, menu-driven application installation procedure handles all 
of the file management duties that were laboriously manipulated with typed alphanu
meric characters, batch file creation, and pathname selection in CP/M and DOS. Once 
this installation is complete, a descriptive icon is assigned to the application and a unique 
icon is automatically assigned to all of the document files that are produced by that 
application. The subdirectories of DOS, on the other hand, are treated as/alders in GEM. 

Following the conventions used in the CP/M and DOS examples, we will start with 
the item MEMCO.TST. Once this item has been (1) renamed, we will (2) copy the re
named item to another disk, where we will (3) determine the nature of our transferred 
item. After we have completed the item's informational assessment, we will (4) output 
the item to our printer. Finally, we will (5) execute the program item. 

1. Rename the item (Fig. 1-3). 

o Select the item's icon with the mouse. 

ITEM INFORMATION 
Name: 

Size in bytes: 
Last modified: 

Attributes: 

MEMCO.TST 
2562 

3@:::_O~ 

IcanceT] 

Fig. 1-3. The ITEM INFORMATION dialog. 
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Desk File Uiew Options 

DO D[I] 
GEHDESK GEHS'~ HEHTEST.BAS COHHQND.COH 

D[iJ[iJ~ 
I-~.GEH I-4.GEH 

Fig. 1-4. A selected icon is dragged to its new destination. 

o Choose Show Info ... from the File Menu. 
o Type MEMTEST .BAS in the Name field. 

2. Copy the item (Fig. 1-4). 

o Select the item's icon. 
o Drag the selected icon to the A: disk icon. 

3. Determine status of the item (Fig. 1-5). 

o Select the item's icon. 
o Choose Show Info ... from the File Menu. 

4. Print the item (Fig. 1-6). 

o Select the item's icon. 
o Choose Print Spooler from the Desk Menu. 
o Click on the Add N arne ... button. 
o Add name with ITEM SELECTOR dialog. 
o Press the ENTER key. 

5. Execute the item (Fig. 1-7). 
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Fig. 1-5. Show Info .•• determines the status 
of a file. 

MiMTiiT.BAS 

D 
Add RiMe ... 

Fig. 1-7. A double-click on the BASIC program will 
load and execute BASICA. 

Uie~, Options 

op~en~~------I!~~!!~~rr 
~~ snow InfO ... 

I\Jt?w folder ... o 
11EHTEST. ~AS 

Fig. 1-6. Print Spooler desk accessory. 

DO [I] 
11&111 COMMAND. COM aEHDESK antsY's 
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o Double-click on the MEMTEST .BAS icon. 

The real marvel with GEM is that all of these actions take more time and effort 
to describe than they do to execute. A flick of the wrist and a click of the mouse button 
are all that is necessary for performing many of these file management chores. Only 
when entering item names does the keyboard come into play. Thankfully, this key
board independence lessens the chance for typing errors, which could lead to data de
struction. But DRI realizes that there is always room for error. Therefore, GEM contains 
a complete and thorough warning message network (these are known as dialogs), which 
safeguards against the execution of potentially data-damaging commands. Based on 
the combination of these two error-limiting features within the icon environment, GEM 
is able to compete effectively with DOS in the 8088 system. 

CLICKS VS. COMMANDS 

In order to get an effective feel for the differences between GEM and PC-DOS, the 
following file management exercises were performed under the direction of both of 
these operating systems: file directory management, file copying, and hard (or fixed) 
disk drive file manipulation. Representative screen illustrations showing the results 
that are obtained from each of these exercises are given for both GEM and PC-DOS. 

File Directory Management 

GEM (Fig. 1-8): 

o Double-click on the disk drive icon. 
o Double-click on the Document folder. 

o 
BOOK 

o 
* .......... .. 
,. ""t"""" 

INTRO 

Fig. 1-8. GEM deals with subdirectories through the folder icon. 
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A)TREE :t::\F 

DIRECTORY PATH LISTING FOR VOLUME ??????????? 

Path: \DOCUMENT 

Sub-directories: BOOK 

Path: \DOCUMENT\BOOK 

Sub-directories: CHAPTER 

Path: \DOCUMENT\BOOK\CHAPTER 

Sub-directories: None 

A) 

Fig. 1-9. The DOS method for dealing with subdirectories. 

o Double-click on the Book folder. 
o Double-click on the Chapter folder. 
o Double-click on the Intra document. 

PC-DOS (Fig. 1-9): 

o Log disk drive. 
o Display directory. 
o Set Tree command. 
o Load word processor. 
o Start Intra document. 

GEM (Fig. 1-10): 

o Click on the Book folder. 
o Drag the Book folder to disk drive B: icon. 
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• 
Fig. 1-10. To copy the selected folder, just drag the folder to its destination. 

The IBM Personal Computer DOS 
Version 2.10 (C)Copyright IBM Corp 1981, 1982, 1983 

A)COPV A:\DOCUMENT\BOOK B:\DOCUMENT\BOOK 

Fig. 1-11. DOS-based subdirectory copies. 

EJ DD 
GRAPHS RiAD.ME INSTALL. TXT 

Fig. 1-12. Double-click on the INSTALL.APP icon to install the program on a hard disk. 

PC-DOS (Fig. 1-11): 

o Log the disk drive. 
o Display directory. 
o Change directory. 
o Copy subdirectory Book. 

GEM (Fig. 1-12): 

o Close the hard disk drive's window. 
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IBM PERSONAL COMPUTER 
Fixed Disk Setup Program Version 3.20 
(C)Copyright IBM Corp. 1983,1985 

FDISK Dptions 

Current Fixed Disk Drive: 1 

Choose one of the following: 

1. Create DOS Partition 
2. Change Active Partition 
3. Delete DOS Partition 
4. Display Partition Data 
5. Select Next Fixed Disk Drive 

Enter' choice: [1] 

Press ESC to return to DOS 

Fig. 1-13. The DOS command FDiSK is used as a preparatory step for installing an application on 
a hard disk. 

o Double-click on disk drive A:. 
o Double-click on 1NST ALL.APP. 

PC-DOS (Fig. 1-13): 

o Load FD1SK. 
o Create a DOS partition. 
o Format DOS partition. 
o Load application onto hard disk drive. 
o Set partition. 
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Chapter 1 

The GEM Environment 

GEM is an alternate operating environment that lacks concurrent operation. In other 
words, you can't run several programs simultaneously under GEM (see Chapter 9 for 
operating systems that are multitasking). You can, however, use any of your existing 
software with GEM for a marked increase in both your performance and productivity. 
Alternatively, there are special GEM applications that further exploit the advantages 
of the GEM environment (see Chapters 3 through 6). But what exactly is the GEM 
environment? 

The foundation upon which GEM is built is the Desktop. Of course, this is not a 
real desktop. The GEM Desktop is more properly referred to as a desktop metaphor. 
In the GEM operating system environment, however, this figurative likeness is an apt 
descriptor. For all intents, the GEM Desktop turns your computer into an electronic 
desktop, complete with a clock, a calendar, and unlimited file cabinets. Furthermore, 
the GEM Desktop forms an elucidative "shell" around your computer's DOS. This in
sulating barrier serves as an effective means for using DOS commands by breaking 
through the confusion generated by a mute A> prompt. 

Before you will be able to "sit down" at the GEM Desktop, you will need to make 
an assessment of your computer hardware; GEM is very picky about its hardware. Ba
sically, a successful GEM system needs to satisfy the following hardware requirements: 

Computers. IBM PC, IBM PC XT, IBM PC AT, or true, 100% IBM PC com
patibles (other computer implementations are discussed in Chapter 2). 

Storage. Two double-sided, double-density disk drives or one double-sided, double
density disk drive and a hard disk drive. 

DOS Versions. PC-DOS version 2.0 or higher (e.g., version 3.2) or MS-DOS ver-
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sion 2.0 or higher (e.g., version 3.0). 
Memory. Minimum of 256K bytes RAM for any PC-DOS version 2 (e.g., version 

2.10), minimum of 320K bytes RAM for any PC-DOS version 3 (e.g., version 3.1), with 
similar minimal restrictions under MS-DOS. 

Display. Color: IBM Color/Graphics Monitor Adapter or IBM Enhanced Color 
Graphics Adapter with compatible color monitor. Monochrome: IBM Enhanced Color 
Graphics Adapter, Hercules Graphics Card, or compatible with similarly compatible 
monochrome monitor. 

Input Devices (Optional). Keyboard, Microsoft Mouse, Mouse Systems Mouse, 
SummaMouse Model No. 445, Summa Sketch Tablet, or compatible. 

Output Device (Optional). Photographic media, Apple LaserWriter printer, Ep
son LQ, MX, FX, RX printers, Hewlett-Packard LaserJet + printer, IBM Graphics 
Printer, IBM Color Printer, Juki 5510 printer, or Hewlett-Packard plotter. 

There are numerous qualifications that accompany these hardware requirements. 
Chapter 2 provides a thorough accounting of each hardware element and suggests ways 
to circumvent some of their more stringent mandates. 

GEM PREP 
One of either the benefits or the banes of offering such a wide choice of input and out
put devices is in giving the user a diverse selection. Because, along with this outland
ish liD smorgasbord comes the impossible task of updating the selection to reflect today's 
most popular devices. Remember that in the microcomputer market, "here today and 
gone tomorrow" adequately describes the endurance of many manufacturers. At any 
rate, DRI has made numerous adjustments to its selection of GEM Desktop device 
drivers. Therefore, it would be ridiculous to try and represent all of the possible com
binations of GEM input and output device drivers. As a point of reference, only the 
most current DRI device driver release, which contains several special enhanced out
put devices, will be discussed. This release encompasses the following range of serial 
numbers: 

# 5054-0000-065001 through # 5054-0000-070000 
# 5054-0000-080001 and higher 

One important fallout from selecting this broad range of serial numbers is that ev
ery possible device driver release for current and future GEM Desktops (version 1.2) 
is covered. For you GEM users who lack a Desktop that lies within this serial number 
range, contact DRI for upgrading information. 

STOP! Before you go any further, make backup copies of your GEM System Mas
ter Disk and its three accompanying device driver disks (Device Driver Disk #1, De
vice Driver Disk #2, and Device Driver Disk #3). 

Use the following procedure: 

1. Load PC-DOS into your computer. (CTRL+ALT+DEL) 
2. Format four new floppy disks. Leave DOS in drive A: and place your blank disk 

in drive B:. 
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o Type: FORMAT B: 

Answer Y to the Format another (YIN)? prompt three more times. 

3. Copy each DRI GEM disk. Remove DOS from drive A: and insert the GEM Sys
tem Master Disk. Insert one of the blank formatted disks into drive B:. 

o Type: COPY A: * . * B: 

Repeat this process for each of the three device driver disks as well. 

4. Place your DRI GEM disks in a safe, isolated location. Label and use your backup 
disks for all of your future GEM Desktop installation work. 

Creating your GEM Desktop is a simple, menu-driven operation. You will need 
several items before you begin installation, however. First, you need to fully under
stand the nature of your input, output, and display devices. Unlike other installation 
packages, GEM only requires that you know the name of each device. There are no 
complicated address locations or command code sequences for you to excavate from 
the device's documentation. Second, if-and only if-you will be using the GEM Desk
top on a two floppy disk drive-based system, you will need two blank floppy disks (hard 
disk drive users are excluded from this necessity). Third, you will need your PC-DOS 
disk. This disk will be used for copying system tracks to the GEM Desktop. Finally, 
the four copies that you made from the DRI GEM disks will be needed during this 
installation. After you have acquired all of the necessary materials, it is time to install 
the GEM Desktop. 

The actual installation is performed through a single file located on the GEM Sys
tem Master Disk. This GEM Desktop preparation file is called GEMPREP. Use the 
following procedure for initiating GEMPREP: 

1. Insert your PC-DOS disk in disk drive A: and load PC-DOS. (CTRL+ ALT + DEL) 
2. Remove the PC-DOS disk and insert your working copy of GEM System Master 

Disk in drive A:. 

o Type: GEMPREP 

3. Soon your display screen will contain the greeting: 

Welcome to GEM PREP! 
Do you want to put the GEM Desktop on a hard disk? YIN? 

One precaution that you must observe throughout the GEM Desktop installation 
procedure is that you are consistent in your PC-DOS usage. If you boot your system 
with PC-DOS version 2.10, then make sure that you use version 2.10 for the remainder 
of the installation. Carelessness on this point will prevent a successful GEM Desktop 
preparation. Additionally, the version of PC-DOS that you use will determine the mini-
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mum amount of system RAM that is needed for running the GEM Desktop. The mini
mal guidelines for the numerous versions of PC-DOS break down into two broad 
categories: 

1. PC-DOS version 2.X family members-require a minimum system RAM of 
256K bytes. 

2. PC-DOS version 3.X family members-require a minimum system RAM of 
320K bytes. 

Both of these limits are faithfully watched by the GEM Desktop and failure to meet 
either of the minimal RAM values will result in an error dialog and a return to DOS. 
Unfortunately, these RAM values are not observed during the GEM Desktop prepara
tion. It is only during the starting of the GEM Desktop that an evaluation of the sys
tem RAM is made. Therefore, this insufficient memory error action translates into a 
"soft crash" of the GEM environment. Of course, these same RAM limits apply to 
their similarly numbered MS-DOS version counterparts. 

Once you have been greeted by GEMPREP, the following prompts guide you 
through the installation procedure. 

o Prepare the GEM STARTUP disk 
o Prepare the GEM DESKTOP disk (These first two steps are used by floppy 

systems only.) 
o Type of Graphics Card? 
o Type of Mouse? 
o Mouse Port? 
o Type of Output Device? 
o Output Device Port? 

No matter whether the GEM Desktop has been installed on a hard disk drive or a twin 
floppy disk drive, the correct execution of GEMPREP will result in several subdirec
tories, each of which contains numerous files. Table I-I lists all of the subdirectories, 
along with their corresponding files, that constitute the GEM Desktop. 
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GEM Subdirectory and File Structure 

STARTUP 
COMMAND.COM 
MODE.COM 
GEM.BAT 
GEMBOOT <DIR> 

GEM.EXE 
GEM.RSC 
CALCLOCK.ACC 
SNAPSHOT.APP 
SNAPSHOT.RSC 

GEMSYS <DIR> 
GEMVDI,EXE 
ASSIGN.SYS 
IBMCHMPS.SYS 

DESKTOP 
GEMAPPS < DIR > 
GEM DESK < DIR > 

DESKTOP .APP 
DESKTOP.RSC 
DESKTOP.lNF 
DESKHI.ICN 
DESKLO.ICN 

GEMSYS < DIR > 
FORMAT.COM 
*.FNT 
OUTPUT.APP 
OUTPUT.RSC 
METAFIL5.SYS 
DEFAUL T.OPT 

Table 1-1. Running GEM PREP 
Copies These Directories, 
Subdirectories, and Files 

onto Either a Hard Disk or 
Two Separate Floppy Disks. 



WORKING ON THE DESKTOP 

Now that you have prepared the GEM Desktop on either your hard disk drive or as 
two floppy disks, labeled GEM STARTUP and GEM DESKTOP, you may move the 
working copy of GEM System Master Disk and the three device driver backup disks 
(Device Driver Disk #1, Device Driver Disk #2, and Device Driver Disk #3) to the rear 
of your floppy disk storage box. In fact, you probably won't ever need to use these 
disks again. All of your future work with the GEM Desktop will be conducted from 
the files that you created with GEMPREP. 

Whether you will be starting the GEM Desktop from a hard disk drive or a floppy 
disk drive, the description remains the same with only a slightly different series of 
actions. 

Starting the GEM Desktop From a Hard Disk Drive 

1. Boot your system from the active DOS partition on the hard disk drive. From a 
floppy disk drive: 

o Type: C: 

2. If you aren't already there, go to the root directory (this step will be unnecessary 
for most GEM users). 

o Type: CHOIR " 

3. Start the GEM Desktop. 

o Type: GEM 

4. After running through all of the subdirectories, the GEM Desktop will appear (see 
Fig. 1-1). 

Starting the GEM Desktop From a Floppy Disk Drive 

1. Boot your system from the GEM STARTUP disk. (CTRL + ALT + DEL) 
2. If you aren't already there, go to the root directory (this step will be unnecessary 

for most GEM users). 

o Type: CHDIR " 

3. Start the GEM Desktop. 

o Type: GEM 

4. After running through all of the subdirectories, the GEM DESKTOP disk prompt 
will appear. 

5. Remove the GEM STARTUP disk and insert the GEM DESKTOP disk into drive 
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A:. Press the ENTER key. 
6. The GEM Desktop is now ready for use (see Fig. 1-2). 

Typing all of these commands for each entry into the GEM Desktop is nothing 
short of ridiculous. A much better method is to use a batch file that will automatically 
execute a specified set of instructions each time the computer is either started or reset. 
This type of batch file is commonly called an A UTOEXEC.BA T file in DOS. Basi
cally, when DOS is started by the computer (like during power up or following a sys
tem reset), the command processor looks for a file named AUTOEXEC.BAT in the 
root directory of the currently logged drive (either a hard drive or a floppy drive). If 
this file is present, it is executed immediately following the installation of other sys
tem configuration files (e.g., CONFIG.SYS). 

An auto-execution batch file, when properly written, can carry out all of the "dirty" 
work that is needed for starting the GEM Desktop. Furthermore, this AUTOEXEC.BAT 
file can perform all of your other computer "housekeeping" duties (e.g., set the time 
and date) without affecting the initiation of the GEM Desktop. The only drawback to 
the usage of an AUTOEXEC.BAT file is the need for available disk space. This room 
is necessary for holding the AUTOEXEC.BAT file (usually around 20-150 bytes worth) 
and the files that are used by the batch file. Actually, this point is relatively minor to 
a 10M, 20M, or 30M byte hard drive user. On the other hand, this issue is one of major 
concern for the user with a two floppy disk drive system. Happily, even the two floppy 
disk drive version of the GEM Desktop can make full use of an AUTOEXEC.BAT 
file. DRI has left plenty of disk space on the GEM STARTUP disk for accommodating 
virtually any size of an AUTOEXEC.BAT file. 

ooo[I] 
O!HQ"S OEHD!SK OEHSYS COHttaND. COH 

Fig. 1-1. GEM Desktop with two active floppy disk drives and one active hard disk drive. 
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Desk File Uiew Options 

Fig. 1-2. GEM Desktop with two active floppy disk drives. 

Creating an AUTOEXEC.BAT File for Starting the GEM Desktop 

The following examples illustrate numerous forms of AUTOEXEC.BAT files that 
will work with the GEM Desktop. In each instance, there is no regard as to the type 
of drive that will use the batch file. There is essentially no difference between a hard 
drive or a floppy drive resident AUTOEXEC.BAT file. 

An AUTOEXEC.BAT file can be created with either a text editor or through the 
DOS COpy command. If you elect to use a text editor, make sure that invisible text 
formatting commands are not inserted into the file. For example, use W ordStar in the 
non-document file editing mode. 

With the DOS COpy command: 

1. Load DOS into your computer. 
2. Remove the DOS disk and insert the GEM STARTUP disk (hard drive users make 

sure that you are in an active DOS partition that contains the GEM Desktop). 

3. Type: 

o COpy CON AUTOEXEC.BAT 
o Press the ENTER key. 

4. Type each command line of the batch file and press ENTER. Typing errors can 
be corrected by using the backspace key. Pressing CTRL + BREAK will abort the copy 
and cancel the creation of the AUTOEXEC.BAT file. 
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5. When all of the command lines have been entered, type F6 and press the ENTER 
key. The following will be displayed: 

1 File(s) copied 
A> 

Caution! Hard drive users who already have an AUTOEXEC.BAT file in the root 
directory of the active partition on their drive wi11lose all of the command lines con
tained in this file by following the above file creation procedure. A suggested option 
to this problem is to use a text editor for adding the GEM Desktop activating com
mand lines. The DOS EDLIN Line Editor program is ideal for adding the required GEM
specific lines. Only the insert command (e.g., 1I) and the end edit command (E) will 
be used with EDLIN. Refer to your DOS manual for instructions on using these 
commands. 

Examples of AUTOEXEC.BAT files that automatically start the GEM Desktop: 

COPY CON AUTOEXEC.BAT 
GEM 
(F6) 

In this example, steps for logging the current disk drive and changing to the root direc
tory have both been eliminated. This is a fringe benefit of using an AUTOEXEC.BAT 
file. Since this batch file must be in the root directory of the logged drive for proper 
use, both of these actions are unnecessary. 

COpy CON AUTOEXEC.BAT 
DATE' 
TIME 
GEM 
(F6) 

This example allows you to update the date and time before starting the GEM Desktop. 

COPY CON AUTOEXEC.BAT 
CLOCK 
GEM 
(F6) 

Other, non-DOS, programs can be executed from an AUTOEXEC.BAT file. In this 
case, the generic CLOCK command represents any of a number of different time and 
date stamping programs that are currently available. These programs read an on-board 
clock/calendar chip (these are usually found on peripheral expansion cards) and trans
fer the results to the GEM Desktop. Remember to include this special program on the 
GEM STARTUP disk (or the active hard drive partition) that holds the AU
TOEXEC.BAT file. Otherwise, you will experience a system crash when the batch file 
tries to execute the nonexistent program. 
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COPY CON AUTOEXEC.BAT 
DATE 
TIME 
ANSI 
VDISK 
GEM 
(F6) 

Wrong! This example is incorrect. Both ANSI and VDISK (these device drivers are 
found in PC-DOS version 3.X) are special programs for use only with the DEVICE com
mand. Likewise, the DEVICE command is used exclusively for configuring the sys
tem hardware. Additionally, all system configuration is accomplished through a 
CONFIG.SYS file. Finally, this is a unique file that cannot be used in conjunction with 
an AUTOEXEC.BAT file. Refer to Chapter 2 for information on how to use CON
FIG.SYS with the GEM Desktop. 

Fioppy Drive Note 
One point to remember is that this AUTOEXEC.BAT file and its associated refer

ence programs must all be on the GEM STARTUP disk. Once this batch file has run 
its course, you will still have to remove the GEM STARTUP disk and insert the GEM 
DESKTOP disk into drive A:. Of course, starting the GEM Desktop will, for the most 
part, be a "hands free" operation with only one disk swap necessary. 

No matter which path you take, the final result is the GEM Desktop seen in Figures 
1-1 and 1-2. There are five distinct elements that make up the GEM Desktop: the desk
top work area, the Menu Bar, the disk icons, the trash icon, and the pointer. Each of 
these elements functions in a manner that is similar to the function of their analog of
fice cohorts. 

The large solid field in the center of the GEM Desktop is the desktop work area. 
This surface is where all of the "physical" GEM actions are carried out. In other words, 
an opened disk icon displays its contents on the desktop work area for examination 
and manipulation. Similarly, the desktop work area holds the calculator (discussed later 
in this chapter) during the performance of mathematical functions. 

The Menu Bar lists four different command menus: Desk, File, View, and Options. 
Each of these menus is discussed in detail later in this chapter. For the most part, these 
menus contain commands that control the GEM environment. Activation of these com
mands is as simple as pointing and clicking (more about these terms later). By using 
this method, GEM has reduced the need for command memorization and lessened the 
chance for typing errors. 

Components, files, and, to some extent, command actions in the system are 
represented on the GEM Desktop disk with icons. These icons are descriptive pictures 
that increase the user's awareness of the meaning for this symbolic representation. 
For example, the disk icons are used for indicating the number and designation of the 
system's storage devices. A twin floppy disk drive system will have two floppy disk 
icons labeled A and B. A standard IBM PC XT system will have one floppy disk icon 
labeled A and one hard disk icon labeled C. 

Another icon used on the GEM Desktop is the trash icon. This miniature waste-
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basket serves as a visual reminder to the GEM user that files can be erased from disks 
by placing them in the trash icon. In fact, anything that you wish to permanently re
move from the GEM Desktop can be placed in the trash icon-this includes whole disks. 

Movement on the GEM Desktop could be hard to follow since our viewpoint is 
a detached one. In order to facilitate a proper desktop work area perspective, a small 
arrow called the pointer serves as our digital "finger." The movement of the pointer 
is governed by the movement of an input device. A mouse is the preferred input de
vice for working on the GEM Desktop. Throughout the remainder of this book all move
ments on the GEM Desktop will be discussed with reference to a mouse. You diehard 
keyboard users, however, will find a mouse-to-keyboard conversion chart later in this 
chapter. 

There are four mouse actions that are used on the GEM Desktop: moving, click
ing, dragging, and double-clicking. Each of these actions represents a method for data 
manipulation that would be equivalent to numerous command entries in a conventional 
DOS environment. 

Moving 

Mouse movement is used for controlling the position of the GEM Desktop pointer. 
Every action of the mouse is duplicated by a corresponding pointer movement. Try this: 

o Move the mouse right > > > >. 
o Move the mouse left < < < <. 
o Move the pointer up 1\ 1\ ''''. 

o Move the pointer to the floppy disk icon A. 
o Move the pointer to the trash can icon. 

Lifting th~ mouse and repositioning it results in no pointer movement. This technique 
is effective when operating the mouse within a confined space. 

Clicking 

Clicking is used for selecting icons and choosing commands on the GEM Desktop. 
A "click" is performed by placing the pointer over the desired icon or command and 
pressing and quickly releasing the mouse button (on multi-button mouses, like the PC 
Mouse by Mouse Systems, use the left-hand button). Try this: 

o Click on the trash can icon. 
o Click on the floppy disk icon A. 

Clicking the pointer on the desktop work area is used for "de-selecting" an icon or 
command. 

Dragging 

Icon movement on the desktop work area is accomplished through dragging. Fol
low these steps for dragging: 
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Fig. 1-3. Both the floppy disk drive A: icon and the Trash icon have been dragged into the center 
of the desktop. 

1. Place the pointer on the icon. 
2. Press and hold the mouse button. 
3. Move the mouse to the new location. 
4. Release the mouse button. 

In addition to icon movement, dragging is useful for disk management such as eras
ing, formatting, and copying files. Try this: 

o Drag the floppy disk icon A to the center of the desktop work area. 
o Drag the trash can icon next to the new position for the floppy disk icon (Fig. 1-3). 
o Return both icons to their original positions. 

Double-clicking 

Double-clicking is used for opening an icon. Opening an icon can be thought of as 
starting, loading, or running an application program. Additionally, double-clicking can 
list the contents of a disk drive and subdirectory. In this manner, double-clicking func
tions like the DIR command in PC-DOS. Try this: 

o Double-click on the floppy disk A icon. 
o Double-click on the trash can icon (incidentally, you have now received your 

first warning dialog) (Fig. 1-4). 
o Click the "ok" button on the warning dialog. 

11 



Special Mouse Actions 

All four of the previously described mouse actions deal with icons and commands 
on the solitary level. There are two special mouse actions, however, that act on multi
ples of icons and commands. 

Group Select 

A refinement in dragging allows the mouse to capture and move several icons at 
once: 

o Place the pointer in the upper left-hand corner of the floppy disk A icon. 
o Click and hold the mouse button while dragging the pointer to the lower right

hand corner of the other disk icon (either B or C). 
o Release the mouse button. 

If this action is done correctly, a dotted rectangle will form around both of these 
icons and cause both of them to be selected when the mouse button is released. Both 
of these icons are now joined and may be dragged together. When you are finished, 
clicking in the desktop work area will de-select the group select. 

Shift-Click 

Another, more selective, method for choosing several icons or commands is through 
shift-clicking. Shift-clicking uses the keyboard's SHIFT key along with the mouse but
ton for linking isolated icons or commands together into a group. 

o Place the pointer on the floppy disk A icon and click. 
o Press and hold the keyboard's SHIFT key. 
o Move the pointer to the second disk icon (once again, either B or C) and click. 
o After selecting all of the icons (we will only use two icons in this demonstra

tion), release the SHIFT key. 

Once they have been highlighted, these shift-clicked icons will behave just like the 
group-selected variety. 

Windows 

If you foUowed the above examples, the GEM Desktop now contains a window. 

NOTE 

You cannot open tne trasn can icon 
into a window. To delete a disk, 
folder. dooument. or applioation. 
drag it to the trash oan. 

Fig. 1-4. A dialog appears when you double-click on the Trash icon. 
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GEMAPPS GEI10ESK GEHSVS COtt1ANO.COH 

Fig. 1-5. Two open windows are on the desktop. The pointer is inside the active window. 

The GEM Desktop can hold a maximum of four open windows at a single time. A win
dow consists of a Title Bar and numerous other assorted control features contained 
within a defined border. A textured Title Bar, like the one in the window from the 
double-clicking example, indicates an active window. Mouse actions (clicking, drag
ging, and double-clicking) can only be performed in active windows. Furthermore, only 
one active window may be present on the GEM Desktop at one time. 

Activating Windows. Open another disk icon (either floppy disk B or hard disk 
C). Now, this second window is the active window. In order to switch between win
dows, the desired window must be first activated. 

o Activate a window by clicking anywhere within its border (Fig. 1-5). 

Once you activated a window, however, it comes to the surface of the GEM Desk
top, while all other windows recede underneath (Fig. 1-6). 

Closing a Window. In order to remove a window from the GEM Desktop, the 
window must be closed. Closing a window is performed only on an active window. 

o Click on the Close Box on the Title Bar to close a window (Fig. 1-7). 

Upon closing, the next available window becomes the active window. Go ahead 
and close the actiV'e window for floppy disk B (or hard disk C). The window for floppy 
disk A has now come to the surface and is active. 

Sizing a Window. Another method for controlling the active window is by alter-
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GEMAPPS GEMDESK GHISYS COMMAND. COM 

Fig. 1-6. The active window has been switched from B:" to A:". 

ing its size. Dragging the Size Box of the active window alters the dimensions of the 
window (Fig. 1-8). 

Sizing a window is one of the best ways for "cleaning" the GEM Desktop. Vari-

Fig. 1-7. Clicking in the Close Box on the active A:" window removes that window from the desktop. 
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Fig. 1-8. Dragging the Size Box changes the dimensions of a window. 

ously sized windows are also easier for changing to and from the active state. Once 
again, open the floppy disk B icon (or hard disk C). Now, size this window until the 
window for floppy disk A is also visible. 

Full Box. Full Box is used for quickly changing the size of the active window. 
Clicking on the Full Box makes the active window fill the entire desktop work area. 
Clicking on the Full Box a second time returns the active window to its previous size 
and position (Fig. 1-9). 

Dragging a Window. An active window can be moved by dragging it by its Ti
tle Bar: 

o Place the pointer on the textured Title Bar (remember this indicates an active 
window) and drag the window to its new location. 

Work Area 

The large plain field inside the borders of the active window is the work area. Con
tained within the work area is the directory for the selected disk icon. In its default 
condition, the work area displays this directory as a series of three different icons: 
folders, applications, and documents. Collectively, these icons are called directory icons. 
The GEM DESKTOP disk is an ideal candidate for discovering work area features. 
If you haven't been using this disk in the previous examples, place its directory in an 
active window at this time. 

Note: A quick way to update the active window's work area each time you insert 
a new floppy disk is to press the keyboard's ESC (ESCAPE) key. This action will only 
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Fig. 1-9. Clicking in the Full Box makes the active window fill the entire screen. Clicking the Full Box a sec
ond time reduces the window to its original size. 

work on the disk drive that corresponds to the active window. Therefore, make sure 
that the Title Bar's drive designation matches the drive with the changed floppy disk. 

Opening a Folder. Folders are icons that represent the subdirectory file manage
ment system used in PC-DOS. 

o Open a folder by double-clicking on the folder icon. 

The work area now contains the documents and applications that are contained "in
side" the folder. Additionally, the Title Bar changes its name to reflect the name of 
this new folder (or subdirectory). 

Moving the Work Area. Many times the dimensions of the window are insuffi
cient for displaying all of the work area's contents. Sliders, Scroll Bars, and direction 
arrows enable you to move the work area left-right and up-down for viewing the entire 
contents of the directory. These controls are found on the right-hand and bottom borders 
of the active window (Fig. 1-10). 

o Click on arrows. 
o Click on Scroll Bars. 
o Drag Sliders. 

Holding down a Scroll Bar will provide a smooth and continuous scroll. 
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Information Line 

A short string of text immediately under the Title Bar is called the information 
line. The information line indicates the amount of disk space occupied by the directory 
that fills the active window. Additionally, the information line states the number of 
items found in the directory. 

Menus 

Four words are found along the top of the GEM Desktop in the menu bar. Each 
of these words is an identification for a menu. Menus contain lists of commands that 
are chosen by clicking on the desired command. 

Displaying Menus. A menu will continue to be displayed until another menu 
is displayed, a command is chosen, or the pointer is clicked on the desktop work area. 

o Move the pointer onto the Menu Bar. 
o When the pointer makes contact with any of the menu words, a menu is dis

played (Fig. 1-11). 

Choosing Commands. The list of commands that are displayed in a menu are 
represented as either available or unavailable. All commands that are in bold, dark let
ters are available. Conversely, the faint, light commands are unavailable. The availa
bility of a command is determined by the nature of the currently selected icon. Therefore, 
if no icons have been selected, then most of the icon-related commands will be un
available. 

o A command is chosen by clicking on it. 

GEHAPPS GEI10ESK GEI1SYS COMMAND. COM 

Fig. 1-10. Sliders, Scroll Bars, and arrows, move the items that are inside the window. 
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Desk File Uiew 
Install Disk Drive .. . 

.......... ~--~ Install Application .. . 

Set Preferences ... 
Sav~ Desktop 
Enter DOS Comnlands 

Fig. 1-11. When the pointer makes contact with 
the Menu Bar, a drop-down menu is displayed. 

Select an icon (if you have a disk in drive A:, use the floppy disk A icon). Now, 
display the File Menu and move the pointer up and down through the list of commands. 
As the pointer makes contact with each command, the command is highlighted. Posi
tion the pointer on the Open command and click. The window for drive A: will now 
fill the desktop work area. This command serves the same function as double-clicking 
on the floppy disk A icon. 

Another command worth trying is the Show Info ... command. First, select a 
folder's icon. Now, choose the Show Info ... command. A dialog stating the folder's 
name, size, date of creation, and characteristics is placed on the work area. Click on 
the ok button when you are finished. A quick way to identify all commands that will 
produce a dialog is to look for an ellipsis ( ... ) following the command. 

Tip: Responding to a dialog is accomplished by clicking on the appropriate response 
button (e.g., "ok"). For the most part, the preferred response button in a dialog is out
lined with a heavy black border. This emphasized button border is a visual indication 
that the ENTER key can be depressed for acknowledging this response. In other words, 
if the button that you will be clicking has an enlarged border, then the ENTER key 
can be pressed instead of clicking with the mouse. 

Displaying the Directory 

The View Menu allows you to alter the directory's display. Six different represen
tations of the directory are possible through the View Menu. A dotted line on the View 
Menu separates the two types of directory commands. The top View Menu section 
specifies the visual type of the directory, while the bottom determines how the direc-
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tory's entries will be sorted. A command choice from both sections of this menu are 
needed for displaying the directory. Any changes to either the directory type or sort
ing will effect the directories of all windows. Therefore, these commands are not limited 
to the active window (Fig. 1-12). 

o Display the View Menu. 
o Click on the directory type. 
o Display the View Menu. 
o Click on the directory sorting method. 

THE GEM DESKTOP MENUS 

The GEM Desktop has a standard set of four different menus. These menus serve as 
the means for executing commands on the GEM Desktop. Clicking and dragging icons 
plus the GEM Desktop menus form the basis for all disk and file management activities. 

Desk Menu (Fig. 1-13) 

Choosing Desktop Info ... from the Desk Menu displays a dialog containing 
the authors' names and copyright information for the installed version of the GEM 
Desktop. 

Choosing Calculator activates the GEM Desktop calculator. This multifunction 
calculator responds to both keyboard and mouse entry. 

Using the Calculator. There are two powerful keys on the GEM Desktop cal
culator (Fig. 1-14) that aren't found on many conventional calculators: 

EC Entry Clear-Clicking this key erases the current number entry without chang-

• GEt4APPS 
• CEHDESK 
• GEMSYS 

COMMAND COM 

06-10-86 09 : 
06-19-86 B9 ; 
06-10-86 09: 

17792 10-20-83 121 

1169 96-23-86 
7043 06-23-86 
6389 96-23-86 
6212 06-23-86 

Fig. 1-12. By selecting the Show as Text and Sort by Size commands from the View Menu, the presen
tation of the disk's directory can be altered. 
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D~Sktop InfO ... " /, " '. " " ~'" J" ,,',' 

D~ 
GEHSVS COM 

Fig. 1-13. The GEM Desktop Desk Menu. 

ing any of the previous functions. Clear (or C), on the other hand, erases all 
functions and resets the calculator. 

+ "- - Sign change-Reverses the sign of the currently displayed value. For exam
ple, clicking this key would change "5" to" - 5." This key is also useful for 
entering negative data. Keyboard entry of this key is through the backslash 
key ("-). 

DO 
GEHQ"S GEHDESK 

Fig. 1-14. A multifunction calculator appears when the Calculator desk accessory is selected. 
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Calculating percentages on the calculator is accomplished by using the % key, as 
in these calculation examples: 

17744 * 25 % 
17744 * 25 % = 

Calculating with memory is accomplished by using the memory keys (M + , M - , 
MR, and MC); as in these calculation examples: 

6 + 4 M+ 
30 / 6 M
MR 
MC 
66 * 13 M+ 
2559/3 M- MR 

Choosing Clock from the Disk Menu activates the GEM Desktop (Fig. 1-15) clock. 
This is a real-time clock calendar that displays the correct time and date as set through 
DOS (a battery-powered time and date stamp is valuable with this desk accessory). 

Using the Clock. There are two modes of operation with the GEM Desktop clock. 
The first mode is the time mode. A clock's dial icon is visible when the GEM clock 
is in this mode. This is also the mode used for viewing and setting the current time. 
The other clock mode is the alarm mode. A bell icon is used for representing this mode. 
Setting and reading the alarm time is performed in this mode. In both cases, the date 
remains the same in the lower half of the clock window. 

To set the time/date and alarm: 

EJEJEJ[!J 
GEHAPPS GE~ESK GEHSYS CO~NO.COH 

Fig. 1-15. A real-time clock and calendar appears when the Clock desk accessory is selected. 
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o Click on the mode icon to change modes. 
o Click on the hours, minutes, month, date, or year. 
o Use the keyboard's number keys for entering the correct value. 

- Use 12-hour settings for the time (i.e., 01-12). 
- Use only two-digit entries (e.g., 03 = 3). 

o Click on "am" to change to "pm" and click on "pm" to change to "am." 

To activate the alarm: 

o Click on the alarm icon (a musical note to the right of the time). 
- A bold, dark alarm icon indicates that the alarm is "on." 
- A light, faint alarm icon indicates that the alarm is "off." 

o Click on the alarm icon to turn the alarm "off." 

Print Spooler (Fig. 1-16) is the last of the Desk Menu options. This desk acces
sory forms a list of ASCII (American Standard Code for Information Interchange) text 
files for processing through OUTPUT (see a full explanation of this application later 
in this chapter). This list is sent to the printer, starting with the top file. Complete con
trol over the formation of this queue is possible by adding and deleting file names. Each 
list that is created with the Print Spooler is a temporary list that can not be saved. 

Using the Print Spooler. To add a name to the Print Spooler: 

COHHflHO. COM 

[i][i][i][i] 
t-IO.GEM t-It.GEM I-I~.GEH 

Rda RaMe," 

Fig. 1-16. This desk accessory forms a list of ASCII text files for output to the connected perip
heral. 
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Fig. 1-17. The GEM Desktop File Menu. 

New Folder ... 
Close 
Close Window 
Format .. 
To output 
QUit 

co~ 

D Click on the Add Name ... button. An ITEM SELECTOR dialog will ap
pear. Printing is suspended while the ITEM SELECTOR is active. 

D Add the file name. 
D Return to the Print Spooler window. This action is performed automatically 

after the file name has been added to the Print Spooler. 

To Delete a name: 

D Click on the file name. 
D Click on the Delete Name button. If you choose the file that is currently be

ing printed, the printing of that file will be terminated and the next file in the 
print spooler will be printed. 

Warning! The Print Spooler desk accessory should not be used on a floppy-based 
system. Only hard drive systems are able to use this command. 

File Menu (Fig. 1-17) 

Open opens a selected icon. This command is equivalent to double-clicking on the 
icon. 

Show Info ... displays a dialog that describes the selected icon. There are four 
possible information dialogs. 

The Disk Information Dialog contains a listing of the number of folders and items 
that are on the selected disk, the number of bytes used by each of these folders and 
items, and the number of unused bytes remaining on the disk. 

23 



The Folder Information Dialog contains a listing of the number of folders and items 
that are in the selected folder, the number of bytes used by these folders and items, 
and the date and time that the selected folder was created or last modified. 

The Item Information Dialog contains a listing of the name of the selected item, 
the number of bytes used by the item, the date and time of the last modification to 
the item, and the read/write status of the selected item. 

The Trash Information Dialog contains text that describes the function of the trash 
can on the GEM Desktop. 

New Folder ... creates a new folder for the directory in the active window. A 
dialog appears for naming this new folder. A maximum of eight characters can be used 
for naming this folder with a three-character type name as an option. This new folder 
will be empty when it is placed in the directory. 

Close closes the directory of the active window. 
Close Window closes the active window. This command is equivalent to click

ing on the Close Box of an active window. 
Format ... formats the selected disk. A warning dialog appears prior to the ac

tual formatting. In order to initiate the formatting process, you must click the "ok" 
button in this dialog. 

To use Format ... : 

o Place the GEM DESKTOP disk in drive A: (hard drive people will use drive C:). 
o Insert the floppy disk to be formatted into drive B: (this is drive A: on hard

drive-equipped systems). 
o Choose Format ... from the File Menu. 
o Be sure that the drive identified in the dialog matches the one with the blank 

disk. 
o Click the "ok" button. 

To Output loads and starts the GEM OUTPUT application. Refer to the OUT
PUT section later in this chapter for information on this application. 

Quit exits the GEM Desktop and returns to the computer's DOS. The DOS prompt 
is visible when the action from this command is complete. 

View Menu (Fig. 1-18) 

Show as Icons displays directory contents as icons. 
Show as Text displays the directory contents as text. 
Sort by Name sorts the directory alphabetically according to each item's name. 
Sort by Date sorts the directory according to the date of each item's entry or 

modification. 
Sort by Size sorts the directory according to the size of each item as measured 

in bytes. 
Sort by Type sorts the directory alphabetically according to each item's type. 

To use the View Menu: 
o Display the View Menu. 
o Choose a Show ... command. 

24 



D Choose a Sort ... command. 

Remember that when dealing with the View Menu commands, each change affects 
every directory window. 

Options Menu (Fig. 1-19) 
Install Disk Drive ... contains a dialog for either installing or removing a disk 

drive. This command is useful for altering drive designations, as well as identifying 
RAM drives (see Chapter 2 for a discussion of RAM drives). 

Below is an example using the Install Disk Drive ... Command. In this exam
ple, we will work with a Hardcard hard disk expansion card drive on the GEM Desktop. 

D Click on a disk drive icon (floppy disk A is the preferred icon). 
D Choose the Install Disk Drive ... command. The INSTALL DISK DRIVE 

dialog appears. 
D Type a drive designation in the Drive Identifier field of the dialog. The drive 

designation C is used for representing the Hardcard drive. 
D Type a drive name in the Icon Label field of the dialog. HARD CARD DRIVE 

serves as a descriptive name for this new drive. 
D Click on the Icon Type button that represents the installed drive. In this case, 

the Hard drive icon is appropriate. 
D Click on the "Install" button. 

Fewer steps are necessary for removing a disk drive from the GEM Desktop. In 
this example, we will remove the Hardcard drive that we just installed. 

Fig. 1-18. The GEM Desktop View Menu. 

" Sort by Name 
Sort by Date 
sort by size 
Sort by Type 
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Install Disk Drive .. . 
-----~ Install Application .. . 

Set Preferences ... 
Save Desktop 
Enter DOS Commands 

D Click on the disk icon to remove. 

Fig. 1-19. The GEM Desktop Options Menu. 

D Choose the Install Disk Drive ... command. The INSTALL DISK DRIVE 
dialog appears. 

D Click on the "Remove" button. 

It is impossible to remove all of the disk drive icons from the GEM Desktop. At least 
one disk drive icon must be present at all times. 

Install Application ... contains a dialog for installing non-GEM applications, 
programs, and documents. This installation procedure is mandatory for enabling the 
application to make full use of the GEM Desktop. Once an application has been prop
erly installed, mouse actions, like double-clicking, can be used for loading and starting 
the application. GEM applications use a slightly different method for installation. See 
the chapter dealing with each specific GEM application for information concerning this 
installation (Chapters 3 through 6). 

Below is an example using the Install Application ... Command. As a means 
of illustration, W ordStar will be used in these examples (refer to Appendix E for the 
installation of other applications). 
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D Click on the applications icon. An application icon will have one of the follow
ing file types: APP, BAT, COM, or EXE. Also, an application icon can be iden
tified by a thick, dark band along its top border. 



D Choose the Install Application ... command. The INSTALL APPLICA
TION dialog appears. 

D The correct name of the application should appear in the Application Name field. 
D Type all file types that you will ever create with this application in the Docu

ment Types field. There is room for a total of eight types. In the case of W ord
Star, don't forget to include .BAK backup file types. 

D Click the correct Application Type button. The "DOS-takes parameters" selec
tion generates an OPEN APPLICATION dialog each time this application is 
opened. This dialog is used for setting parameters that are understood by the 
installed application. 

D Click the correct Needs Full Memory button. Only memory intensive applica
tions (e.g., Lotus 1-2-3) should respond with a "Yes" click. One drawback to 
any application that makes use of full memory is that returning to the GEM 
Desktop will take longer. This tardiness stems from all but a small kernel of 
the GEM Desktop being removed from the computer's memory (approximately 
20K bytes RAM). 

D Move the Icon Type window until the correct application icon is visible. Use 
the arrows, Scroll Bars, and Slider for moving the Icon Type window. Further
more, the Title Bar of the Icon Type window can be used for identifying the 
proper application icon. 

D Click on the Install button (see Fig. 1-20). 

INSTALL APPLICATION 

Application Name: 'vVS.COM 
Document Types: LTR 1',<T DOC RPT __ _ 

Application Type: I GENII I DOS II DOS - takes parametersl 
Needs Full rvlemory: ~ ~ 

Icon Type: :::::::::::: '}., i rd P ri j.j:J 5 5'- r ::::::::::::::::: 
::::::::::::::: y V ;; ;; .. _ ;; ~.::::::::::::::::::: 

t 
i:':":":':':' 
~ ~Ii

-
~ :::::::::::::!:"..::::: 

, •••••• ,1, ....... ......... 
" ......... M •• _'_ :.:0:0: 

\1pplic~tion documents T 

I Install \ I Remove I I Cancel \ 

Fig. 1-20. Completing the INSTALL APPLICATION dialog is all that's necessary for installing Word
Star in the GEM environment. 
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To remove an installed application: 

o Click on the application's icon. 
o Choose the Install Application 0 0 0 command. The INSTALL APPLICA

TION dialog appears. 
o Click on the Remove button. 

Caution! All installed applications remain installed only during the current GEM 
Desktop session. In other words, once your computer is turned off, all application in
stallations are lost. This action can be prevented by saving the application installations 
through the Save Desktop command (see below). 

Setting a P A THo When you double-click on an installed application, the GEM 
Desktop begins its search for the application in the current directory. This technique 
might be fine for most floppy drive systems, but it is totally inadequate for hard drive 
systems. If you make elaborate use of subdirectories, then you will have to guide GEM 
to the actual resting place of the application. The DOS command PATH can be added 
to a root directory batch file for navigating GEM to the actual location of the application. 

This GEM search path is added to either GEM.BA T (a batch file that is created 
by GEMPREP) or a current AUTOEXEC.BAT file that resides in the root directory. 
Use a text editor for adding the PATH command to one of these batch files. For 
example, 

PATH C: '\. BOOK;C: '\. ARTICLE 

would lead the GEM Desktop from the root directory to two subdirectories named BOOK 
and ARTICLE. By using this DOS search path, applications can be installed in unique 
folders for increased productivity. 

Set Preferences 0 0 0 contains a dialog for controlling the display of delete and 
copy dialogs, setting the speed for a double-click, and turning the GEM Desktop speaker 
on and off (Fig. 1-21). 

SET PREFERENCES 

Fig. 1-21. The SET PREFERENCES dialog is used for controlling the physical characteristics of the 
GEM Desktop. 
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To set preference options: 

D Display the Options Menu and choose the Set Preferences . . . command. 
The SET PREFERENCES dialog appears. 

D Click the "Yes" or "No" button for selecting Delete confirmation. A "no" selec
tion for Delete confirmation eliminates the DELETE FOLDERS / ITEMS dia
log. Therefore, all items dragged to the trash can will be erased without an 
opportunity to cancel this command. The default value is "yes." 

D Click the "Yes" or "No" button for selecting Copy confirmation. A "no" selec
tion for Copy confirmation eliminates the COPY FOLDERS / ITEMS dialog. 
Therefore, once a Copy action has been started, you will not be given a chance 
for canceling this command. The default value is "yes." 

D Click the value button for the speed between mouse button double clicks. Se
lecting one of the five speed settings determines the amount of time that is re
quired for representing a double-click. This option serves as a definition for 
a double-click. The default value is "3." 

D Click the "On" or "Off" button for speaker sound. This selection turns the com
puter's speaker on or off. The default value is "on." 

Save Desktop saves to disk all of the GEM Desktop characteristics that were 
created during the current session. These may include: 

1. Options from the SET PREFERENCES dialog. 
2. Directory type and directory sort from the View Menu. 
3. The GEM Desktop icon positions. 
4. Location and size of all open windows. 
5. All installed applications. This includes the special icons that were assigned to each 

application during the installation procedur~. 

Note: You floppy disk drive users need to have the GEM DESKTOP disk in drive 
A: prior to using the Save Desktop command. 

Before you use the Save Desktop command, up to four windows may be opened 
with their location and size saved for the next GEM Desktop session. With this capa
bility, each window will snap into view with its previously determined location and size 
when the GEM Desktop is started. 

D Open the first window. 
D Use the size box for setting the size of the window. 
D Drag the window to its preferred location. 
D Repeat these steps for each additional window. A total of four windows may 

be saved with this procedure. 
D Display the Options Menu and select the Save Desktop command. 

Enter DOS Commands converts the GEM Desktop into a standard PC-DOS 
environment. The presence of the DOS A> prompt indicates that the GEM Desktop 
is now receptive to DOS commands. 
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Note: Floppy-disk-based systems will be unable to use DOS external commands 
unless a DOS disk is inserted into drive A: following the selection of Enter DOS Com
mands. Additionally: 

1. Any DOS internal or external command may be used. 
2. Alternate pathnames, directories, and subdirectories may be called. 
3. Other applications may be run. 
4. Default disk drive assignments may be changed. 

A special non-DOS command is used for returning to the GEM Desktop. Only this 
command should be used for readmittance to the GEM environment. At the DOS A> 
prompt: 

D Type: EXIT 
D Press the ENTER key. 

Note: On floppy-disk-based systems, the GEM DESKTOP disk should be inserted 
into drive A: before entering the EXIT command. 

Caution! Do NOT type "GEM" for returning to the GEM Desktop from the GEM
initiated DOS environment. A GEM kernel remains in your computer's memory and 
this false command entry will crash the system. The EXIT command is the only safe 
"exit" from DOS back into the friendlier confines of the GEM Desktop. 

ADDITIONAL GEM DESKTOP MANAGEMENT COMMANDS 

There are three additional commands that help with the management of the GEM 
Desktop. 

Copying 

Copying on the GEM Desktop is performed by dragging a source icon or group 
of icons to a destination. 

Source icon-disk, directory, folder, application, and document 
Destination-disk, directory, and folder 
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To copy a source icon: 

D Select the icon that is to be copied. 
D Drag this icon to its destination (the destination may be either another icon or 

an empty space in the destination's work area). 
D Place the dragged icon directly over the destination icon until the destination 

is highlighted by the pointer (this step only applies to copies that are made to 
destination icons), and release the mouse button. The COPY FOLDERS / 
ITEMS dialog appears. 

D Click on the "ok" button. 

These same steps are used for copying groups of icons. Once the group of icons 



has been selected, however, only one member of the group must be dragged for the copy. 
Note: If a name conflict occurs during the copying process, the NAME CONFLICT 

DURING COPY dialog appears. This dialog provides you with an opportunity for nam
ing or renaming the copied item. 

If the Copy's Name field is empty, then you are able to type in a name that will 
be used for the copied item. 

D Type an item name in the Copy's Name field. 
D Click on the "ok" button. 

On the other hand, if the same name appears in the Current Name field as appears 
in the Copy's Name field, then an item with the same name as the source icon's name 
is already on the destination. There are two procedures for dealing with this dialog. 

1. Replace the destination's item with the copied item. 

D Click on the "ok" button. 

This action will erase the item with the same name on the destination and replace it 
with the source item. Another name for this action would be "updating" an item. This 
is a useful disk management utility. 

2. Change the name of the source icon. 

D Use the backspace key to erase the name from the Copy's Name field. (Use 
the Escape key to quickly erase the entire field.) 

D Type in a different name for the source icon. 
D Click on the "ok" button. 

The result of this second item renaming procedure is that the destination will now con
tain two items. One item will be the renamed source item, while the other item will 
be the destination's original item. Another name for this action is "backing up" an item. 

Note: Renaming a name conflict is not the same as renaming an icon. See a com
plete explanation of renaming later in this section. 

Erasing 

The contents of an icon can be erased from the GEM Desktop by dragging the 
icon into the trash can. 

Erasable icons-disks, folders, applications, and documents. 

D Select the icon. 
D Drag the icon onto the trash can icon until the pointer highlights the trash can. 
D Release the mouse button. The DELETE FOLDERS / ITEMS dialog appears. 
D Click on the "ok" button. 
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Renaming 

The name of an icon can be changed with the Show Info ... command. 

Icons which can be renamed-Folders, applications, and documents. 

o Select the icon. 
o Display the File Menu and choose the Show Info . .. command. The ITEM 

INFORMATION dialog appears. 
o Use the backspace key to erase the current icon name from the Name field. 

(Use the Escape key to quickly erase the entire field.) 
o Type the new name in the Name field. 
o Click on the "ok" button. 

Renaming an icon is not the same as resolving a name conflict. Refer to "Copying" 
for an explanation of renaming item's with name conflicts. 

OUTPUT 

To Output is a command found on the File Menu of the GEM Desktop. OUTPUT 
is used for sending output icons that represent GEM -created pictures, graphs, charts, 
designs, and text to selected output devices. These types of output icons include docu
ments created by GEM Draw, GEM Graph, GEM Paint, GEM WordChart, and GEM 
Write. These documents have the types: .GEM, .IMG, or .OUT. The selected output 
devices include camera, plotter, printer, and screen. 

An Overview for Using OUTPUT 

o Create an output list. 
o Determine the final output from the various menus on the OUTPUT menu bar. 
o Choose the Start Output . . . command. The START OUTPUT dialog 

appears. 
o Click on the "ok" button. 

Creating an Output List 

The output list (Fig. 1-22) is a catalog of the documents that will be sent to the 
selected output device. If no output icons are selected prior to choosing the To Out
put command, then the output list will be empty when it appears. The preferred method 
for using OUTPUT, however, is to select the output icons first. 

o Select output icon(s). 
o Display the File Menu and choose the To Output command. The output list 

appears. 

Notes: 

1. The order of document names in the output list does NOT reflect the order in which 
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Fig. 1-22. Choosing the To Output command places a set of selected icons on the OUTPUT list. 

they will be sent to the output device. All document names are placed in the output 
list in the same order as they are found in the directory. 

2. A total of 128 characters are allowed in an output list. This total includes direc
tory path names, drive designations, backslashes, periods, and document names. Any 
selected documents that exceed the 128 character limit will not appear in the output list. 

3. The position of a name on the output list can be changed by dragging the name 
to a new location. Only single names can be dragged in this manner. 

OUTPUT Menu Bar 

Four different menus are available for controlling the final output: Desk, File, Edit, 
and Options. 

Desk Menu (Fig. 1-23) 

The Desk Menu displays an OUTPUT information dialog and activates the vari
ous desk accessories. 

Choosing Output Info ... from the Desk Menu displays a dialog which contains 
copyright and author information about OUTPUT. 

Choosing Calculator displays a multifunction desktop calculator desk accessory. 
Refer to a previous section in this chapter for operation information. 

Choosing Clock displays the current time, date, and an alarm clock feature. Refer 
to a previous section in this chapter for operation information. 

Choose Print Spooler for adding or removing names from an output list during 
printing. Refer to a previous section in this chapter for operation information. 
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Fig. 1-23. The OUTPUT Desk Menu. 

File Menu (Fig. 1-24) 
The File Menu performs all disk activities for output lists and output devices. Ad

ditionally, this menu is used for starting and stopping the final output and returning 
to the GEM Desktop. 

New erases the current output list and displays an empty and untitled output list. 
Possible outcomes from using the New command: 

1. Erases the current output list and displays an empty one. This outcome is only 
possible if the current output list has been previously saved and you have not made 
any additional changes to the names on this current list. 

2. Displays a warning dialog. This dialog appears when the current output list has 
not been saved to a disk. 
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D Click on the "cancel" button to save the current output list (you will need to 
choose either the Save or the Save As ... command to actually begin the 
save of this output list). 

D Click on the "ok" button to erase the current output list and display a new one. 

Open . . . displays the specified output list. 

D Display the File Menu. 
D Choose the Open ... command. The ITEM SELECTOR dialog appears. 



The ITEM SELECTOR contains an index of the previously saved output lists that are 
in the current directory. 

o Double-click on the output list's name. 

Alternatively, the output list's name can be typed into the Selection field (followed 
by a click on the "ok" button). Also, the Directory field can be used for specifying 
another path for searching for a needed output list. 

Close closes the current output list. 

o Display the File Menu. 
o Choose the Close command. 

If this current output list has not been previously saved, the ITEM SELECTOR 
dialog appears. Enter a name for the output list and click on the "ok" button. 

One fringe benefit of using the Close command is that it will automatically "re
save" any output list that has been previously saved. This action is similar to the Save 
command (discussed next). 

Save saves the current output list to disk using its same name. The output list 
remains on the screen following this save. Another name for the action performed by 
the Save command is "updating." 

Save As ... saves the current output list with a specified name. Using the Save 
As ... command automatically adds the type .LIS to the specified name. The Save 

New 
Open ... 
Close 
Save 
Save AS .•• 

Fig. 1-24. The OUTPUT File Menu. 
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As . . . command is always used to save a new output list. The output list remains 
on the screen following this save. The action of this command is also known as "back
ing up." 

D Display the File Menu. 
D Choose the Save As ... command. The ITEM SELECTOR dialog appears. 
D Type the name for the output list into the Selection field. 
D Click on the "ok" button. 

Get Options . . . retrieves the option settings for all of the output devices that 
were previously saved with the Save Options ... command. 

D Display the File Menu. 
D Choose the Get Options ... command. The ITEM SELECTOR dialog 

appears. 
D Double-click on the desired option document. (Type the desired option docu

ment name in the Selection field and click on the "ok" button.) 

To abort the option document retrieval command, click on the "cancel" button. 
Note: You can quickly restore all of the default option settings for all of the output 

devices by selecting DEFAULT.OPT. 

D Display the File Menu. 
D Choose the Get Options ... command. The ITEM SELECTOR dialog 

appears. 
D Double-click on the DEFAULT .OPT option document. 

Save Options ... saves the established options for all of the output devices in 
an option document. The Save Options ... command automatically appends the type 
.OPT to each newly created option document's name. 

D Make all of the necessary changes to the output devices' options. 
D Display the File Menu. 
D Choose the Save Options ... command. The ITEM SELECTOR dialog 

appears. 
D Type a new name for the option document in the Selection field. 
D Cli,ck on the "ok" button. 

To abort the option document creation command, click on the "cancel" button. 

Start Output ... sends the documents contained in the current output list to 
the specified output device. All output device option settings should be made prior to 
using this command. Additionally, an output list must be both open and current before 
any documents can be sent to an output device. 

D Select an output list. 
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o Display the File Menu. 
o Choose the Start Output ... command. The START OUTPUT dialog 

appears. 
o Click on the name of the desired output device in the Device field. 
o Type the number of copies that you want in the Number of copies field. 
o Click on the "ok" button. 
o Output begins. 

Clicking on the "cancel" button returns you to the output list without sending any docu
ments for output. 

Tip: You can easily stop the current output by pressing the Escape key during ex
ecution. The action will "take effect" after the current document has been sent to the 
specified output device. 

Quit terminates OUTPUT and returns you to the GEM Desktop. 

Edit Menu (Fig. 1-25) 

This menu controls the selection, arrangement, and removal of names within an 
output list. 

Add Name . . . adds the specified name to the output list. 

o Display the Edit Menu. 
o Choose the Add Name ... command. The ITEM SELECTOR dialog appears. 

Fig. 1-25. The OUTPUT Edit Menu. 
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D Double-click on the name in the directory window. (Either select the name or 
type the name in the Selection field and click on the "ok" button.) 

Click on the "cancel" button to prevent a name from being added to the output list. 
Tip: All of the documents in the current directory can be added to the output list 

by clicking on the "ok" button without selecting or typing any names in the Selection 
field. This technique is limited to a maximum of 36 documents. 

To change directories on the current disk: 

D To advance-click on a folder name in the directory window. 
D To review-click on the directory window's Close Box. 

To change directories on a different disk: 

D Click in the Directory field. 
D Use the Backspace key to erase the field. (Use the Escape key to quickly erase 

the entire field.) 
D Type the drive designation and folder name and type in the Directory field. 
D Click in the directory window. 

The final list is now ready for saving and/or output to a specified output device. 

Duplicate Name copies the selected document names in the output list. 

D Click on the desired document names. Use group select or shift-click for high
lighting more than one document name. 

D Display the Edit Menu. 
D Choose the Duplicate Name command. 

The Duplicate Name command will automatically dim (or become unavailable) when 
the output list contains the maximum number of document names. 

Delete Name removes the selected document names from the output list. 

D Click on the desired document names. Use group select or shift-click for high
lighting more than one document name. 

D Display the Edit Menu. 
D Choose the Delete Name command. 

Options Menu (Fig. 1-26) 
This menu determines the option settings for the output devices. 

Screen .. . controls the option settings for the computer's screen. 

D Display the Options Menu. 
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Screen .. . 
Printer .. . 
Plotter .. . 
Carmera Film .. . 
camera COlor .. . 

Make Default 

Fig. 1-26. The OUTPUT Options Menu. 

o Choose the Screen ... command. The SCREEN OPTIONS dialog appears. 
o Click on the desired amount of pause in the Wait for field. 

There are two options in this field. 

1. Clicking on "key" causes the output to pause until any key is pressed. Further
more, pressing the up-arrow key when this option has been selected will cause the previ
ous document to be sent to the screen. This action is similar to "leafing" backwards 
through the output list. 

2. Clicking on one of the number settings (2, 5, 10, and 20) sets a pause time interval. 
This time value (in seconds) is used before the next document is sent to the screen. 

o Click on the method of repetition in the Cycle field. 

There are two options in this field. 

1. Click on "yes" to keep sending the same output list to the screen, until the Escape 
key is pressed. 

2. Click on "no" to send the output list only once to the screen. 

o Click on the "ok" button. 

Click on the "cancel" button to abort the screen option settings. 
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Printer . . . controls the option settings for the printer. 

D Display the Options Menu. 
D Choose the Printer ... command. The PRINTER OPTIONS dialog appears. 
D Click on the output's final size in the Scale field. 

There are two options in this field. 

1. Click on "best fit" to proportionately fill the dimensions of an 8 112" x 11" sheet 
with the document. 

2. "Full scale" causes the document to be printed in its exact dimensions. 

D Click on the treatment of the first sheet of paper in the Initial Form Feed field. 

There are two options in this field. 

1. Clicking on "yes" makes the printer perform a form feed prior to printing. 
2. "No" causes the printer to begin printing at its initialized placement. 

D Click on the type of horizontal justification in the Horizontal field. 

There are three options in this field. 

1. "Left" causes the document to be printed on the left of the page. 
2. Clicking on "center" makes the document print in the center of the page. 
3. Click on "right" to print tlie document on the right of the page. 

D Click on the format of the vertical justification in the Vertical field. 

1. Clicking on "top" prints the document on the top of the page. 
2. "Center" prints the document in the center of the page. 
3. "Bottom" causes the document to be printed on the bottom of the page. 

D Click on the treatment of the last sheet of paper in the Final Form Feed field. 

There are two options in this field. 

1. "Yes" causes the printer to execute a form feed at the conclusion of printing the 
document. 
2. Click on "no" to stop the printer at the end of the document's page. 

D Click on the method of printing in the Print in Background field. 

There are two options in this field. 

1. "Yes" enables you to return to the GEM Desktop while the output list sends your 
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documents to the printer. You will need a minimum of 320K bytes RAM for using this 
option (even on PC-DOS 2.X computers.) 

2. Clicking on "no" keeps the user in OUTPUT until the printing has been concluded. 

o Click on the "ok" button. 

To abort the printer option settings, click on the "cancel" button. 
Warning! The "Print in Background" option should not be used on a floppy-based 

system. Only hard drive systems are able to use this option. 

Plotter . . . controls the option settings for the plotter. 

o Display the Options Menu. 
o Choose the Plotter ... command. The PLOTTER OPTIONS dialog appears. 
o Click on the output's final size in the Scale field. 

There are two options in this field. 

1. Click on "best fit" to proportionately fill the dimensions of an 8 112" x 11" sheet 
with the document. 

2. "Full scale" causes the document to be plotted in its exact dimensions. 

o Click on the type of horizontal justification in the Horizontal field. 

There are three options in this field. 

1. "Left" causes the document to be plotted on the left of the page. 
2. Clicking on "center" makes the document plot in the center of the page. 
3. Click on "right" to plot the document on the right of the page. 

o Click on the format of the vertical justification in the Vertical field. 

There are three options in this field. 

1. Clicking on "top" plots the document on the top of the page. 
2. '''Center'' plots the document in the center of the page. 
3. "Bottom" causes the document to be plotted on the bottom of the page. 

o Click on the "ok" button. 

To abort the plotter option settings, click on the "cancel" button. 
Camera Film ... controls the option settings for the camera's film. 

o Display the Options Menu. 
o Choose the Camera Film ... command. The CAMERA FILM OPTIONS 

dialog appears. 
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D Click on the film specification in the Film Type field. 

There are five options in this field. 

1. "Polaroid Type 669" film is in your camera. 
2. "Polaroid Polachrome" film is going to be used. 
3.' Click on "Ektachrome - ASA 100" for using this type of film. 
4. Clicking on "Agfachrome - ASA 100" sets OUTPUT for this film type. 
5. "Fujichrome - ASA 100" is the selected film type. 

D Click on the brightness scale in the Lightness field. 

There are three general options in this field. 

1. Clicking on one of the three negative values ( - 3, - 2, and - 1) causes print film 
to become darker and slide film to become lighter. 
2. "0" is a neutral middle value. 
3. Click on one of the three positive values ( + 3, + 2, and + 1) to make print film lighter 

and slide film darker. 

D Click on the "ok" button. 
Click on the "cancel" button to abort camera film option settings. 

Tip: You will have to experiment with these values to obtain the best results. Two 
better films worth trying are Kodak Professional Ektachrome EPY Tungsten film for 
color slides and Kodak Panatomic X for black and white prints. Color print films lack 
the appropriate lattitude for producing effective results and should be avoided. 

Camera Color ... controls the option settings for the camera's color. 

D Display the Options Menu. 
D Choose the Camera Color ... command. The CAMERA COLOR OPTIONS 

dialog appears. 
D Click on the color code number in the Color Index field. 

There are sixteen options in this field. Each option is a reference value (0-15) that in
dexes a specific GEM application color code. 

D Click on the color assignment in the Basic Color field. 

There are twelve options in this field. The options in this field are specific colors (e.g., 
White, Brown, Blue, and Purple) that can be assigned to a color index. 

D Click on the desired shade in the Lightness field. 

There are ten options in this field. Various shades of the basic color can be assigned 
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to the specified color index by selecting a lightness value (from "light" to "dark"). 

o Edit the color percentages in the Red, Green, and Blue fields. 

There are 101 options in each of these fields. An option in each of these fields represents 
a percentage of color (0-100%). The initial values shown for these fields are determined 
by the settings in the Basic Color field and the Lightness field. Excessive editing of 
the Red, Green, and Blue fields can lead to some bizarre color combinations. Exercise 
caution and restraint when editing these fields. 

o Repeat the four above field selections for each necessary color index. 
o Click on the "ok" button. 

Click on the "cancel" button to exit the CAMERA COLOR OPTIONS dialog. 
Note: The Camera Color ... command stores all of your various color index 

combinations in a temporary memory buffer, until you click on either the "ok" or the 
"cancel" button. 

Make Default saves all of the current option settings in a document labeled DE
FAULT.OPT. 

Caution! Using the Make Default command will replace any document labeled 
DEFAULT.OPT that is in the current directory. 

To Restore the manufacturer's default settings: 

o Display the File Menu. 
o Choose the Quit command. Return to the GEM Desktop (this may require that 

you leave any GEM application that you are using). 
o Double-click on the GEMSYS folder. 
o Drag the DEFAULT.OPT document to the trash can. 
o The o!iginal OUTPUT default settings have now been restored. 

When OUTPUT is first started, all of the options are set according to the values 
specified in a DEFAULT.OPT document. This feature can be an enormous benefit, 
if you always use the same output device settings. 

GEMSETUP 

All of the hardware used in the GEM environment is accessed through device drivers. 
These special applications reside in the computer's memory and tell the printer how 
to print pictures from GEM Paint, the screen how to display W ordChart text, and the 
mouse how to move the pointer on the GEM Desktop. In short, without these device 
drivers, GEM would be just another pretty box. 

Loading the proper device drivers into GEM is accomplished in one of two ways. 
The first way is when you run GEMPREP. At this time, all of the required device drivers 
are placed on the GEM STARTUP disk. The second way is through a special applica
tion called GEMSETUP. GEMSETUP is a menu-driven setup system that allows you 
to change the device drivers for all of your connected hardware devices. Additionally, 
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the communication ports and the system fonts can be changed through GEMSETUP. 
While GEMPREP is used exclusively when you initially create the GEM environment, 
GEMSETUP is used whenever a hardware, port, or font change is made to the GEM 
Desktop. 

If you add a new hardware device to your computer, you absolutely need to use 
GEMSETUP before the GEM Desktop will be able to take advantage of this output 
device. The same thing applies to a change in any communication port designation (e.g., 
LPTI to LPT2 or COMI to COM2); you must run GEM SETUP before you can use 
this new port. Likewise, if you want to use a different set of type fonts on an output 
device (this includes your computer monitor), then you will have to run GEM SETUP . 
One final use for GEMSETUP is in editing or removing unneeded device drivers from 
the GEM Desktop. This is a valuable practice that helps conserve computer RAM for 
GEM application use. 

Using GEMSETUP 

Before you can start GEMSETUP, the GEM Device Driver Disk #1 must be in
serted in drive A:. 

o Double-click on the floppy disk A icon. (Press the Escape key, if this directory 
is already open.) 

o Double-click on the application icon labeled GEMSETUP.APP. 
o Display the Categories Menu. 
o Choose the desired hardware, port, or font command. 
o Make a selection in the chosen window. 
o Display the File Menu. 
o Choose the Save Summary ... command. The warning dialog appears. 
o Click on the "ok" button. 

When a category is selected, there are two different windows that fill the work area. 
Chosen . . . window. This window contains all of the currently used device 

drivers, ports, or fonts that are installed on the GEM Desktop. 
Available ... window. This window lists all of the device drivers, ports, or 

fonts that are available to the GEM Desktop. 
To Make a selection for the Chosen window: 

1. Display the Categories Menu. 
2. Choose the device, port, or font command. 
3. Drag the desired driver or port from the Available window into the Chosen win

dow. More than one font may be taken at a time by using shift-click and dragging one 
member of the selected group. 
4. Repeat steps 1 through 3 for all of the altered device drivers, ports, and/or fonts. 
5. Display the File Menu. 
6. Choose the Save Summary ... command. 

Note: Only one device driver or port may occupy the Chosen window at one time. 
Several fonts may occupy the Chosen window, however, at one time. 

44 



There are three menus available on the GEMSETUP Menu Bar: Desk, File, and 
Categories. 

Desk Menu (Fig. 1-27) 

The Desk Menu contains a GEMSETUP dialog and activates the GEM desk ac
cessories. 

Choosing GEM SETUP Info ... from the Desk Menu displays a dialog that con
tains copyright and author information for GEMSETUP. 

Choosing Calculator starts a multifunction desktop calculator. Refer to the sec
tion earlier in this chapter dealing with the GEM Desktop Menu Bar for operation in
structions. 

Choosing Clock displays a window with real-time clock, alarm clock, and calen
dar features. Refer to the section earlier in this chapter dealing with the GEM Desktop 
Menu Bar for operation instructions. 

Choosing Print Spooler from the Desk Menu forms a list of ASCII files for out
put. Refer to the section earlier in this chapter dealing with the GEM Desktop Menu 
Bar for operation instructions. 

File Menu (Fig. 1-28) 

The File Menu contains commands for dealing with your setup summary. 
Open Summary displays a window that contains all of the current device driver, 

File Categories 
GEMSETUP Info ... 

Calculator 
CloCk 
Print Spooler 

Fig. 1-27. The GEMSETUP Desk Menu. 
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Fig. 1-28. The GEMSETUP File Menu. 

port, and font setups. This information will be saved only through the Save Sum
mary ... command. 

D Display the File Menu. 
D Choose the Open Summary command. The Summary window appears. 
D Click on the Summary window close box. 

Show Info ... provides information about any selected item from the Available 
window. 

D Click on an item in the Available window. (This might require two separate 
clicks, if the Available window is NOT the active window.) 

D Display the File Menu. 
D Choose the Show Info .•. command. The INFORMATION dialog appears. 
D Click on the "ok" button. 

There are four fields in the INFORMATION dialog: 

1. Filename-the name of the selected item. 
2. Disk Label-the name of the floppy disk that contains the selected item. 
3. Description-a description of the selected item. 
4. Details-a technical summary of the selected item. 
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Clear Choice deletes a selected item from the Chosen window. This same item 
is also deleted from the Summary window. 

o Click on the desired item in the Chosen window. (This might require two sepa
rate clicks, if the Chosen window is NOT the active window.) 

o Display the File Menu. 
o Choose the Clear Choice command. 

You can check the setup summary to verify that the unwanted item has been removed. 
Note: Several type fonts can be removed by a single Clear Choice command by 

using shift-click. 
Save Summary ... saves the new setup on the GEM STARTUP disk and erases 

the former setup. 

o Display the File Menu. 
o Choose the Save Summary ... command. A warning dialog appears. 
o Click on the "ok" button. 
o Several disk dialogs appear prompting you to insert the disks that are neces

sary for saving the new setup. 

Click on the "cancel" button to stop the summary save. 

Notes: 

1. Using the Quit command, without first saving a new summary, will display a dia
log informing you of the need to save the summary. In this quit dialog, the "ok" button 
is used for NOT saving the summary. The "cancel" button, however, is used for return
ing to GEMSETUP with the intent of using the Save Summary ... command. 

2. Your setup MUST contain a selected graphics card. Saving a summary that is miss
ing this important item will produce a warning dialog telling you to include a graphics 
card in your setup. 

Quit ends GEMSETUP and returns you to the GEM Desktop. A special safety 
dialog prevents you from exiting GEMSETUP without first saving your setup summary. 

Categories Menu (Fig. 1-29) 

This Menu displays the device driver, port, and font categories for selection in a 
setup summary. 

Graphics Cards lists the monochrome and color graphics cards that are supported 
by the GEM Desktop. 

Screen Fonts lists the type fonts that 'are available for screen display. 
Mouse lists the mouses that are supported by the GEM Desktop. 
Mouse Ports lists the available ports for mouse connection. 
Plotters lists the various plotters that are supported by the GEM Desktop. 
Plotter Fonts lists the type fonts that can be used with the selected plotter. 
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Fig. 1-29. The GEMSETUP Categories Menu. 

Plotter Ports lists the available ports for plotter connection. 
Printers lists the various printers that are supported by the GEM Desktop. 
Printer Fonts lists the type fonts that can be used with the selected printer. 
Printer Ports lists the available ports for printer connection. 
Metafiles lists the batch files that are available to the GEM Desktop. 
Cameras lists the photographic cameras that are supported by the GEM Desktop. 
Camera Fonts lists the type fonts that can be used with the selected camera. 
Camera Ports lists the available ports for camera connection. 
Tablets lists the various tablets that are supported by the GEM Desktop. 
Tablet Ports lists the available ports for tablet connection. 
Miscellaneous lists miscellaneous device drivers, ports, or type fonts. 
Note: Commands that are unavailable during the setup procedure are light colored 

or dimmed. For example, if you don't choose a plotter, then Plotter Fonts and Plot
ter Ports are both dimmed. 

KEYBOARD EQUIVALENTS 

Even if you lack a mouse or tablet, you can still use the GEM Desktop. All of the mouse 
functions (e.g., click and drag) can be duplicated through specific keyboard keystrokes. 
Table 1-2 lists the mouse functions along with their keyboard equivalents. 

You don't need to install the keyboard with either GEMPREP or GEMSETUP. 
The keyboard is a fixed default setting. An important point to remember is that all 
of the keyboard equivalents remain active even when a mouse or tablet is setup on 
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Table 1-2. Every GEM Mouse Action can 
be Duplicated Through Keyboard Interaction. 

GEM Keyboard Equivalents 

Mouse Action 
Click 
Double-click 
Drag 
Move 
Shift-click 

Keystroke (s) 
Home 
Home+Home 
End + Arrow keys + Home 
Arrow keys 
Home + Arrow keys + Shift, Home 

the GEM Desktop. By pressing the Control key (Ctrl), you can activate the keyboard 
mouse control keys. A beep from the IBM's speaker lets you know that keyboard con
trol is now active (NOTE: This control can be removed by pressing the Ctrl key again). 
Therefore, you can make use of the delicate pointer control of the shift-arrow key com
bination, for example, when your hand is too heavy for mouse control. 
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Chapter 2 

GEM Cutters 
Just as a jeweler can turn minerals into precious gems through an assortment of grind
ing wheels and carborundum, computer users can transform inscrutable DOS commands 
into menu-driven GEMs through as application of system hardware and compatible 
peripherals. While the former metamorphosis is dependent on a skilled hand and a scien
tific knowledge of abrasives, the latter change is subject to numerous exceptions, al
terations, and substitutions. In this other GEMology, the type of computer system 
hardware will dictate the available peripherals, which, in turn, will shape the final GEM. 

Beginning with the computer system hardware, there are various microcomputers 
that can be conveniently grouped according to their MPU. The two most prominent 
MPUs that currently support the GEM environment are the Intel iAPX 88/10 8088 
8-/16-bit and the Motorola MC68000 16-/32-bit. The two bit numbers following each 
MPU designation describe the external data bus bit width (8-bit on the 8088 and 16-bit 
on the 68000) and the internal register bit width (16-bit on the 8088 and 32-bit on the 
68000). Make no mistake-the Intel 8088 is a 16-bit MPU and the Motorola 68000 is ' 
a 32-bit MPU. These secondary data bus bit width values just serve as clarification 
of each chips true computational strength. 

These MPUs, whether it's the 8088 or the 68000, control two major functions: mem
ory manipulation and I/O intercourse. Three general lines of communication, each in 
the forni'of a multi-bit bus, are open for these two functions: address, control, and data 
buses. In its dealings with these various functions and buses, the MPU uses a built-in 
command language known as an instruction set. Table 2-1 lists all of the commands 
that make up the 8088 instruction set. Likewise, the instruction set for the 68000 is 
given in Table 2-2. Interacting with this MPU instruction set is the level at which GEM 
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Fig. 2-1. A complete GEM system: the IBM PC XT, Hercules Graphics Card, IBM Monochrome Display, and Mouse Sys
tems mouse. 

controls both the computer system hardware and the associated peripherals. 
One attractive feature of GEM is that it is a portable environment. In other words, 

the GEM Desktop and its related GEM applications can be converted for successful 
operation on different MPUs with no loss of function in any of the GEM elements. All 

Table 2-1. This Partial Accounting of the 8088 Instruction 
Set Lists Only the Mnemonics for Each Instruction. 

AAA 
AAD 
AAM 
AAS 
ADC 
ADD 
AND 
CALL 
CBW 
CMP 
CWO 
DAA 
DAS 
DEC 
DIV 
IDIV 
IMUL 

IN PUSHF 
INC RCL 
JMP RCR 
LAHF RET 
LEA ROL 
LOS ROR 
LES SAR 
MOV SAHF 
MUL SBB 
NEG SHLISAL 
NOT SHR 
OR SUB 
OUT TEST 
POP XCHG 
POPF XLAT 
PUSH XOR 
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ABCD 
ADD 
AND 
ASl 
ASR 
Bcc 
BCHG 
BClR 
BRA 
BSET 
BSR 
BTST 
CHK 
ClR 

CMP 
DIVS 
DIVU 
EOR 
EXG 
EXT 
JMP 
lEA 
LINK 
MOVE 
MUlS 
MUlU 
NEG 
PEA 

RESET 
ROl 
ROR 
RTE 
RTR 
RTS 
STOP 
SUB 
SWAP 
TAS 
TRAP 
TST 
UNlK 

Table 2·2. A Mnemonic Alphabetical listing of the 
Major Members from the 68000 Instruction Set. 

of the translation from one MPU to another is executed through reprogramming with 
the new instruction set. Therefore, dramatically distinct computer systems can receive 
a unique GEM translation with no sacrifice in the GEM-user interface. Currently, three 
major microcomputer manufacturers offer machines that run GEM: Apricot, with the 
Apricot PC; Atari, with the Atari 520ST; and IBM, with the IBM Personal Computer 
(PC) and IBM Personal Computer XT (PC XT). 

APRICOT PC 

Apricot is one computer manufacturer that learns from other's mistakes. Their exten
sive line of microcomputers takes the basis of the IBM PC (the Intel 8088 MPU) and 
adds several features that make the Apricot F series and Apricot PC viable choices 
in the business microcomputer field. 

In Apricot's microcomputer stable there are three candidates that prove quite able
bodied at catering to GEM whims: the F2, FlO, and PC. There are several points that 
are similar among each of these computers. First, they each use an Intel 8086 MPU 
with a clock speed that is near that of the IBM PC's 8088. Another similarity among 
these three Apricots is the incorporation of 3.5" floppy disk drives into each system. 
Finally, the two most common interface ports, RS-232C and Centronics parallel, are 
standard features on the base computer. 

F2 

This small 8086 computer bears a strong resemblance to the Macintosh in its squat, 
compact physical design. Using a true clock speed of 4.67 MHz, the F2 is able to mimic 
the IBM PC in its GEM performance. Two double-sided, double-density 3.5" floppy 
disk drives add 1.44M bytes of total storage capacity to the F2. These high-density 
disks permit the GEM Desktop to be placed on a single disk during installation. 

F10 

The major difference between the FlO and the F2 is the presence of a 10M byte 
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Fig. 2-2. A typical mechanical 
mouse. A rolling ball is used for 
control in this mouse. The Macin
tosh mouse is a good example of 
a mechanical mouse. 
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hard disk in the FlO. Along with the system standard double-sided, double-density 3.5" 
disk drive and 512K bytes RAM, the FlO is functionally similar to the IBM PC XT. 

PC 

The PC is Apricot's attempt at satisfying several of the deficiencies found in the 
F series that reduced their IBM PC compatibility (e.g. an 8087 Math Co-processor 
socket). This includes an open expansion slot for the installation of a user-supplied 
graphics card (the F series comes with their own RGB cards). One point of caution 
with the Apricot PC, however, is the amount of RAM supplied in the base model. The 
modest 256K bytes RAM will have to be increased for realizing the full potential of 
GEM on this computer. 

ATARI520ST 

One of the more popular wars that was waged during the 1985 Christmas season con
cerned the supremacy of a single 68000-based computer. The chief antagonists in this 
fray included: the Atari 520ST, the Apple Macintosh, and the Commodore Amiga. Ap
ple's production headstart over the competition gave the Macintosh a minor victory. 
The Atari 520ST, however, came on strong at the end and currently rivals the sales 
of both the Amiga and the Macintosh. 

The Atari 520ST and its more powerful brother, the 1040ST, share a unique charac
teristic that is not found elsewhere in the contemporary microcomputer world-they 
have GEM in ROM. What this amounts to is the GEM Desktop is permanently installed 
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Fig. 2-3. The Mouse Systems PC 
Mouse uses an IR ~nfrared) sensor for 
detecting mouse movement. 

inside the computer. Therefore, when either the 520ST or the 1040ST is powered up 
the GEM Desktop is available. In this configuration, GEM is a direct part of each com
puter's operating system. Atari has elected to banally name this new operating system 
TOS (The Operating System). 

Both the 520ST and the 1040ST use the Motorola 68000 MPU running at an 8 
MHz clock speed. Ample memory, high-resolution, and large mass storage space make 
these Ataris ideal for reaching GEM's true potential. Early versions of the 520ST, how
ever, lacked the ROM-resident GEM and the computer's total performance suffered 
as a result of this poor production technique. 520ST owners that still must load the 
operating system into RAM prior to using their computers, should consult Atari for 
the required ROM chip upgrade. 

IBM PC AND IBM PC XT 

Invariably, whenever an IBM PC (or PC XT) computer is mentioned, the first question 
asked is, "What about PC compatibles?" By definition, a PC-compatible computer is 
based on an Intel 8088 MPU running at.a 4.77 MHz clock speed with a functional copy 
of the IBM BIOS (Basic 1/0 System) stored in the system ROM. There are several 
points that need to be emphasized in this definition, however. First, the type of MPU 
can vary with little loss in the IBM PC compatibility. Popular substitutions for the 8088 
include the Intel 8088-2 and the NEC V20 I'PD70108. 

A bonus feature of the 8088-2 is that it can operate at a higher clock speed. Unfor
tunately, some programs display adverse results when used at higher speeds. As a so
lution, in most systems that use the 8088-2, both the IBM PC standard 4.77 MHz clock 

54 



speed, as well as a faster 8 MHz are used. Subsequently, a special keystroke sequence 
is used for switching between these two clock speeds. 

PC compatibles that use the NEC V20 MPU generate an entirely different set of 
pros and cons. Basically, the NEC V20 is a pin-for-pin copy of the 8088. The V20 is 
even able to understand the same instruction set used by the 8088. The major differ
ence between these two MPU s is that the V20 handles data much more efficiently than 
the 8088. This is due to increased instruction set performance (multiply/divide and string 
instructions share the greatest boost) inside the V20. Furthermore, the V20 is able to 
operate at 4.77 MHz (also, there is an 8 MHz version of the V20). 

Warning!The following enhancement MIGHT violate the warranty of your com
puter. Only use this suggestion if you are willing to accept the potential consequences. 

Based on the above thumbnail description of the V20's characteristics, a suitable 
substitution for the IBM PC's and IBM PC XT's 8088 would be the NEC V20. Before 
you begin this MPU replacement, remember these two statements of caution: 

1. Avoid the generation of static electricity around either of these MPUs. This dan
ger is especially prevalent with the CMOS (Complementary Metal Oxide Semiconduc
tor) V20. 

2. This is an experimental system alteration that is not sanctioned by IBM. 

NEC V20 substitution procedure: 

o Remove the five hex screws from the rear panel of the IBM PC or PC XT. 
o Gently slide the metal housing forward until the rear edge of this housing makes 

contact with the front edge of the floppy disk drive mounting bracket. 
o Rotate the metal housing upward and completely remove it from the IBM 

chassis. 
o Locate the 8088 socket. (This is along the right rear edge of the main system 

board, near the power supply.) 
o Using a high-quality pair of IC extractors, grasp the 8088 and firmly remove 

it from the socket. This might require a gentle end-for-end rocking motion. Do 
NOT use a side-for-side rocking motion. 

o Place the 8088 in a static-free area-preferably encased in static-free foam. 
o Insert the V20 into the former 8088 socket. Be sure to observe the proper orien

tation of pin #1. 
o Replace the metal housing and secure the five screws. 

The only true test in this type of replacement is to boot some software and observe 
the results. Theoretically, the V20 should work with the GEM environment, but different 
computers will behave differently. For example, one IBM PC might accept the new 
MPU, while another might suffer from floppy disk drive access problems. Both of these 
occurrences have been documented. Therefore, the only solution is to test the V20 for 
yourself. If you don't suffer from any compatibility problems, then you can expect a 
1-25% performance increase over an IBM PC or PC XT that is equipped with the stand
ard 8088. PC compatible computers are also able to take advantage of this V20 substi-

55 



tution. The same operation qualifiers and cautions, however, apply to these computers 
as well. 

One last feature that is buried deep inside the V20 is its ability to execute 8080 
code. On the surface this doesn't sound very impressive, that is, until you stop and 
realize that the CP/M operating system is written in 8080 code (see Introduction). Now, 
by using a V20 inside your IBM PC, you will be able to execute both PC-DOS and 
CP/M 2.2 programming. Right? Well, almost. The only flaw in this logic is that a spe
cial V20 version of this 8080 operating system needs to be used for accessing standard 
CP/M 2.2 software. Once you have this V20 driver, however, then you will actually 
have two computers inside one housing. 

Note: Several independent manufacturers offer a NEC V20 CP/M driver for the 
IBM PC. Try these addresses for availability: 

Micro Interface Corporation, 6824 N. W. 169th Street, Miami, FL 33015 
Micro Solutions, 125 South Fourth Street, DeKalb, IL 60115 
Software Toolworks, 15233 Ventura Blvd., Suite 1118, Sherman Oaks, CA 91403 
The last issue that determines -the true compatibility of an 8088-based system with 

an IBM PC or PC XT centers on the clone's BIOS. This piece of code handles all of 
the read/write activities that are monitored through the MPU. Altering this code in
creases the likelihood that the GEM environment will not work on this computer. Several 
excellent "copies" of the IBM BIOS have been produced, however. One of the best 
of these BIOS recodings is written by Phoenix Software Associates of Norwood, MA. 
But it should be emphasized here that no BIOS rewrite is an exact copy of the IBM 
BIOS. Therefore, GEM could fail to function correctly with an IBM BIOS clone. 

The commercially marketed version of GEM is designed to function on IBM PC 
family computers and 100% true IBM PC compatibles. 

IBM PC 
An IBM Personal Computer comes equipped with two double-sided, double-density 

360K byte floppy disk drives (although other drive choices do exist). The 8088 serves 
as the MPU. An optional 8087 Math Co-processor socket is available. The current in
carnation of this classic has 256K bytes of internal RAM. Early 1981 and 1982 models 
of the IBM PC had only 64K bytes RAM on their main system boards. Without exten
sive mempry upgrading, these models will not support GEM. The remainder of the 
onboard memory consists of a 40K bytes ROM, which holds the BIOS and a BASICA 
subset. 

System expansion is accomplished through five expansion slots. Two of these slots 
are automatically occupied by a floppy disk controller and a display adapter. 

IBM PC XT 
The IBM PC XT has a standard configuration of one double-sided, double-density 

360K byte floppy disk drive. There is also a 10M byte internal hard disk drive. A plen
tiful 200 watt power supply is able to meet the power demands of this hard drive. An 
8088 is the MPU, with an open socket for holding an 8087 Math Co-processor. Stand
ard system board memory with the PC XT is 256K bytes RAM (although newer en
hanced versions hold 640K bytes RAM). An additional 40K bytes ROM is used for 
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holding the BIOS and BASIC. 
There are eight expansion slots on the PC XT. Two of these slots are half-length 

slots, which require shorter "half card" expansion cards. In a standard XT system, 
three slots are taken for the floppy disk controller, hard disk controller, and display 
adapter. 

An exciting option for the IBM PC XT is a dual floppy disk drive model. This con
figuration replaces the 10M byte hard disk drive with another 360K byte floppy disk 
drive. The advantages of a dual floppy drive PC XT over a similarly configured PC 
are the increased number of expansion slots and the larger power supply. Of course, 
a dual floppy drive XT can be readily equipped with a hard drive at a future date through 
a simple user-installable upgrade. All you have to do is purchase a hard disk drive kit. 
These kits come in two common sizes, 10M bytes and 20M bytes, and contain a hard 
disk controller card and all of the necessary installation hardware. An attractive side
light to this hard drive upgrade is that a larger 20M byte drive or 30M byte drive can 
be used instead of IBM's standard 10M byte version (once again, the enhanced IBM 
PC XT's have a standard 20M byte hard drive). 

IBM PC AT 
There are two PC AT models: the basic model and the enhanced model. The basic 

model uses one 1.2M byte floppy disk drive. A total of 256K bytes RAM is housed 
on the main system board. Alternatively, the enhanced model has both the 1.2M byte 
floppy disk drive and a 20M byte hard disk drive. Furthermore, the enhanced model 
has 5l2K bytes RAM on the main system board. 

Both models use an Intel 80286 as the MPU with an open socket available for an 
80287 Math Co-processor. The remainder of the system memory is 64K bytes ROM 
containing the BIOS and BASIC. There are also eight expansion slots on both models. 
Only six slots are open for additional expansion in either model. One of these slots is 
occupied by a combination floppy/hard disk drive controller, while the other is used 
by a display adapter. 

As a rule, GEM will run on an IBM PC AT. Extremely rare and isolated problems 
have been reported in booting GEM from the 1.2M byte floppy disk drive, however. 
Installing and running GEM from the internal hard drive will overcome this problem. 
Another solution is to purchase the optional 360K byte floppy drive (IBM Personal Com
puter AT Double-Sided Diskette Drive). Complete GEM compatibility is possible with 
this disk drive. 

IBM 3270 

This IBM model is a marked departure from the previous microcomputers. The 
main function of the 3270 is that of a workstation terminal. In this case, the host unit 
is primarily a member of either the IBM 4300 family or the IBM 3080 family. The 
superior screen resolutions of the 3270 make the windows of GEM crisp and clear. 
In fact, a major advantage of the 3270 is its multitasking, window-handling capabilities. 

On the hardware level, the 3270 remains virtually identical to the previously men
tioned IBM products. The same 8088 MPU running at 4.77 MHz is supported by a 
minimum of 256K bytes RAM and 40K bytes ROM. Options include extra memory 
through expansion cards, one or two double-sided, double-density 360K byte floppy 

57 



disk drives, and a 10M byte hard disk drive. There are even two sophisticated graphics 
versions of the 3270, the IBM 3270 PC/G and the IBM 3270 GX, that can accommo
date displays with an unbelievable resolution of 960 x 1000 pixels (or picture elements). 
Unfortunately, GEM lacks a suitable driver for these high-resolution displays at this 
time. 

IBM PCjr 

GEM will NOT run on a standard IBM PCjr. Two of the PCjr's features prevent 
this acceptance: 128K bytes RAM and a single 360K byte floppy disk drive. Only 
through costly peripheral purchases can both of these limitations be overcome. First, 
you will need to add a minimum of 256K bytes RAM (for a system total of 384K bytes). 
This excessive amount is dictated by the PCjr's video RAM usage. Also, this value 
is only good for PC-DOS 2.X. If DOS 3.X is used, the minimum amount of total system 
RAM is 448K bytes. 

Second, you will need to add a second floppy disk drive (or a hard disk drive) to 
the PCjr. Several independent manufacturers have supplied these drives through the 
years. Unfortunately, when IBM elected to officially discontinue the PCjr, many of these 
suppliers left the "junior" market. One manufacturer who supplied both memory up
grades and second disk drives for the PCjr was Legacy Technologies, Ltd. (4817 N. 
56th Street, Lincoln, NE 68504). If you are interested in turning your PCjr into a GEM, 
send an inquiry to Legacy Technologies and find out if they are still in the junior 
business. 

By adding these products to the standard IBM PCjr, you MIGHT be able to run 
GEM. There are still several problems with the junior's video display mapping tech
nique. The biggest problem is that GEM lacks a suitable driver for this display. There
fore, even with the extra memory and another disk drive, the PCjr remains GEM -less. 

COMPAQ 

COMPAQ manufactures numerous computer models. Of these, the Portable, PLUS, 
PORTABLE 286, and comparable DESKPRO series offer a verified ability to run GEM. 
Each of these computer models mimics a specific IBM model. For example, the Porta
ble is COMPAQ's IBM PC representative. By using the same MPU, clock speed, disk 
drive configuration, memory characteristics, and display characteristics, the Portable 
is an accurate duplicate of the IBM PC. 

The IBM PC XT is copied by the PLUS. This portable computer faithfully follows 
the MPU, clock speed, drive storage configuration, and display characteristics estab
lished by the PC XT. Even the XT's powerful 10M byte hard drive is somehow squeezed 
into the small confines of the PLUS. One deficient area on the PLUS, however, is the 
standard amount of RAM found on the main system board. Only 128K bytes RAM 
is available on a standard PLUS. Granted, the RAM can be expanded on the system 
board, but this point should be considered prior to attempting to install GEM on an 
unexpanded standard PLUS. 

COMPAQ's clone of the IBM PC AT, the PORTABLE 286, exactly follows all 
of the AT's hardware specifications except one. The PORTABLE 286 uses two differ
ent, switch-selectable clock speeds-6 MHz (the IBM PC AT standard) and 8 MHz. 
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This second clock is used for speeding up applications. By using this special clock speed 
switch, GEM can be operated at the higher speed with a noticeable increase in its per
formance. 

Zenith 

Another computer manufacturer whose products successfully handle the GEM en
vironment is Zenith. Two models were tested for GEM compatibility: the ZF-14S-42 
and the ZF-15S-42. One point to keep in mind with the ZF-14S-42 and the ZF-15S-42 
is that, although two standard video outputs are built into each of these computers, 
they are unacceptable for using GEM. In order to bring these Zenith computers up 
to GEM tolerances, you will need to add one of the display adapter cards that are de
scribed in the next section. 

Both of these computers come equipped with 256K bytes RAM (which can be ex
panded to 640K bytes on the system board by using 256K x 1 byte dynamic RAM 
chips), two double-sided, double-density 360K byte floppy disk drives, and an IBM
compatible ROM. An attractive feature found on these Zeniths is a dual switch-selectable 
clock speed. A standard IBM 4.77 MHz clock speed is supplemented by an additional 
S MHz speed. This "high speed" setting really makes GEM shine. 

The major difference between the ZF-14S-42 and the ZF-15S-42 is the presence 
of six IBM-compatible expansion slots inside the ZF-15S-42. On the other hand, the 
ZF -14S-42 has one Heath/Zenith expansion slot that can accept any IBM expansion 
card through an optional adapter board. 

If you are willing to spend several nights slaving over a hot soldering iron, a tremen
dous price savings can be realized on these two Zenith computers. Special kit versions 
of the ZF-14S-42 and the ZF-15S-42 are available from Heath Company (a corporate 
partner with Zenith). Following assembly (you will need to add one double-sided, double
density 360K byte floppy drive to the Heathkit models), the Heathkit HS-14S-41 and 
the HS-15S-41 are both functionally identical to their Zenith counterparts. Assembling 
a computer kit is exciting, as well as educational; but should you goof up, Heath will 
quickly get you back on the right track. 

Other Computers 

There are probably more SOSS-based IBM PC clones running around than all of 
the other computers with different MPUs added together. For this reason, GEM com
patibility cannot be tested for every model that mimics an IBM PC. Listed below are 
some of the probable GEM cutters: 

AT&T 6300. When somebody as big as the telephone company steps into a mar
ket, you had better see what they're hawking. In this case, it's the computer market; 
and AT&T has decided to do things just a little differently from all of the other PC 
clones. Instead of using the standard S08S and 4.77 MHz clock speed, the AT&T 6300 
features an SOS6-2 operating at a blistering S MHz. The result is a computer that is 
more of an alternative than a copy. Beware of the base model AT&T 6300 which con
tains only 12SK bytes RAM. This version will need a memory upgrade prior to using 
GEM. 

ITT XTRA. Yet another large corporation with a PC-compatible release. There 
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are no pleasant (or unpleasant) surprises in this IBM look-alike, however. All of the 
stock PC features are found inside the XTRA's unusually shaped exterior. Only the 
base model is unable to use GEM without the addition of extra memory and another 
floppy disk drive. All in all, there's not much extra in the XTRA. 

Sperry PC. By using its clout as a major government supplier, Sperry hopes that 
larger firms will look their way instead of always settling for an IBM system. Actually, 
the Sperry PC offers some advantages (increased program execution speed, built-in 
clock, high-resolution graphics) over the IBM alternative that may turn the heads of 
a few corporate buyers. Once again, the entry model of the Sperry PC is equipped with 
only 128K bytes RAM. This memory amount will have to be increased before GEM 
will run on the Sperry. 

Tandy 1000 & 1200 HD. Two well-made PC and PC XT copies from one of 
the founding names in the personal home computer market. Tandy's service is extremely 
professional and there is a store in practically every major city in the United States. 
The Tandy 1000 will need two major upgrades (an increase in RAM and another floppy 
disk drive) before it can use GEM. 

Displays 

There are two general categories of displays that will operate with GEM: mono
chrome and color. There are also a limited number of display adapters that can be in
stalled with comparable GEM device drivers. Selecting the wrong display combination 
usually results in a blank screen and a need to reinstall GEM through GEMPREP. 

Monochrome 
Monochrome monitors must adhere to the TTL (transistor-transistor logic) signal 

loads used by the IBM Monochrome Display for complete GEM compatibility. There 
are also several monochrome display adapters that are supported by GEM. 
Monochrome Monitors: 

COMPAQ Display. These built-in, nine-inch green monitors require a special 
display driver that is supplied with GEM. 

IBM Monochrome Display. This is the standard upon which all other mono
chrome monitors are based. The green phosphor, 11112" screen provides crisp text 
and high-quality graphics. 

Princeton Graphics Systems MAX-12. A high-resolution amber monitor with 
automatic pixel adjustment for different resolution display adapters. 

Tandy VM-3 Monochrome Monitor. A 12" green phosphor screen that is 
matched for the Tandy 1000 and Tandy 1200 HD computers. 

Zenith ZVM-1240. This 12" green CRT (cathode-ray tube) has a special anti
glare filter that is supposed to reduce eye strain during prolonged use. 
Monochrome Display Adapters: 

AST Preview!. This adapter exactingly mimics the popular Hercules Graphics 
Card. As such, special device drivers written for the Hercules card will work with the 
Preview!' Use the special Hercules device driver for installing this adapter in GEM. 

COMPAQ Display Adapter. A special device driver packaged with GEM sup
ports this adapter. 

60 



Hercules Graphics Card. For the absolutely best GEM resolution, use the Her
cules Graphics Card. A fantastic 720 by 348 pixels are possible with this adapter and 
a monochrome display. By using the Hercules Graphics Card and the IBM Monochrome 
Display, it is even possible to make Macintosh owners green with envy. GEM has 
provided a special device driver just for installing the Hercules Graphics Card. 

Paradise Modular Graphics Card. A unique multifunction display adapter that 
is capable of supporting high-resolution text and graphics on a monochrome screen. 
This card is also able to supply output for an RGB (red-green-blue) monitor and a com
posite video c;lisplay. Special Paradise add-on modules can give this display adapter 
a serial port, a parallel port, 384K bytes RAM, and a clock. This adapter is installed 
as an IBM Color/Graphics Monitor Adapter. 

Color 

There are two general color camps with GEM. One side is the standard IBM Color 
Display type of monitor that is able to generate only two different colors. The opposi
tion is the monitors and adapters that support the IBM Enhanced Color Display stan
dards. It is only with this second group that true color can be had with GEM. 
Color Display Monitors: 

IBM Color Display. A 12 112" RGB monitor with text and graphics ability. In 
GEM, this monitor is only able to generate two colors when used with a conventional 
color adapter. When an enhanced color adapter is used, however, GEM is able to dis
play several colors on this display. 

Princeton Graphic Systems HX-12. An IBM Color Display compatible mon
itor with superior resolution in pixel pitch. The result is sharper graphics and text. An 
ideal monitor for using GEM. 

Tandy CM-2 High-Resolution Color Monitor. A close following to the IBM 
Color Display. 

Tatung CM1380. This 13" CRT has dual scan frequencies-one for matching 
the IBM Color Display and another for providing higher resolution. 

Taxan 630. A high-resolution monitor that offers four text modes and a faster 
scanning frequency. A special Taxan color graphics adapter, the 555 Super Color 
Graphics Board, adds even greater performance to the 630. 

Thomson .38mm Color. Like the Princeton HX-12, this Thomson display uses 
a finer resolution in its pixel pitch. Unlike the Princeton HX-12, this monitor has an 
extremely attractive ergonomic exterior that makes it stay beautiful even when the 
power is off. 

Zenith ZVM-1330. The standard text and graphics modes of the IBM Color Dis
play are fully supported by this 13" RGB monitor. 
Color Display Adapters: 

Hercules Color Card. The major advantage that this card has over its IBM com
petition is that the Hercules Color Card will fit into an IBM PC XT short slot. The 
Hercules Color Card also "throws in" a parallel port. But most systems are already 
overrun with this port. Therefore, this bonus is questionable. 

IBM Color/Graphics Monitor Adapter. GEM installs this adapter (and all 
of the ones under this category) as a two-color graphics board. This is exclusive of the 
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type of monitor that is used with this adapter. For example, even if this adapter is used 
with an enhanced color display, the results will still be a two-color display. 

Paradise Modular Graphics Card. Any of the above color displays can be used 
with this adapter. Only one jumper must be changed on this card for receiving a color 
display. 
Enhanced Color Display Monitors: 

IBM Enhanced Color Display. Many of the failings with the IBM Color Dis
play have been successfully addressed by this monitor. Increased text resolution, greater 
color display, and greater pixel numbe~s are all present in the Enhanced Color Display. 

NEC MultiSync. A wide range in scanning frequencies makes this monitor adapt
able to an equally wide range of display adapters. Its extremely high resolution graphics 
ability (a maximum of 800 by 560 pixels), however, makes this monitor best suited 
for enhanced graphics. 

Princeton Graphic Systems HX-12E. An enhanced version of their popular 
HX-12 color monitor. In trying to match the superior performance that the HX-12 
demonstrated over the IBM Color Display through pixel pitch, the HX-12E doesn't fair 
as well against the IBM Enhanced Color Display. Only a modest increase in pixel pitch 
has been accomplished this time around. 
Enhanced Color Display Adapters: 

IBM Enhanced Graphics Adapter. This versatile adapter is able to work with 
all three of IBM's microcomputer displays. 

STB EGA Plus. Each of the graphics and text feature of the IBM EGA are ac
curately duplicated on this adapter with the addition of a bonus parallel port. The value 
of this "extra" is dubious on a fully equipped computer. 

Orchid TurboEGA. Now this is an adapter for the future. Instead of just copy
ing the technical features of IBM's EGA, Orchid added a faster 7.2 MHz 80286 MPU 
for processing all of the video information. By including this special high-speed chip, 
all graphics, which are a major part of GEM, now explosively burst onto the screen 
in blinding colors. This adapter is even able to support the Hercules Graphics Card 
monochrome resolution. This is truly the finest display adapter for using with GEM. 

Input 

There are three different methods of inputting data into the GEM environment: 
a keyboard, a mouse, and a tablet. A keyboard is an integral part of every computer 
system and, therefore, requires no further explanation. On the other hand, several differ
ent mouse and tablet brands are supported by GEM device drivers. 
Mouse Input Devices: 

LOGITECH LOGIMOUSE C7. A three-button mouse with a difference. That 
difference is the independence from both an external power supply and an optical pad. 
The LOGIMOUSE C7 is a mechanical mouse with extremely fine resolution for its 
breed. Up to 200 dots per inch can be resolved on any smooth surface. This is by far 
the best input device for use with GEM. 

Microsoft Mouse. Two different models of this mouse are manufactured by 
Microsoft. The first version uses a special interface card that plugs into one of the IBM's 
expansion slots. This is the Bus Mouse. The jumper block of the Bus Mouse must be 
set to jumper position 3 for proper operation with GEM. 
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The other Microsoft Mouse runs out of any RS-232C port. This is the Serial Mouse. 
In either case, whichever mouse you use, you will need the special Microsoft Mouse 
driver software that is shipped with this mouse. During GEMPREP you will be prompted 
for this disk. Both of these mouses use two buttons. 

Mouse Systems Mouse. This three-button mouse, known as PC Mouse, is a 
radical departure from other conventional mechanical mouses. A special metal pad is 
placed underneath the PC Mouse during operation. The mouse then "reads" its loca
tion with a red LED (light emitting diode) that is located on its ventral side. This tech
nique classifies this mouse as an optical mouse. There are several drawbacks to this 
mouse-the need for the special optic pad being chief among them. 

SummaMouse. Another three-button, optical mouse that is an exact copy of the 
Mouse Systems Mouse. None of the weak points that are so prevalent in this mouse's 
parent have been corrected in this offspring. 
Tablet Input Devices: 

Summagraphics MM Series Tablets. There are two different sizes of Sum
magraphics Tablets: 12 by 12 inch (designated the 1201) and 9 by 6 inch (designated 
the 961). Both of these tablets connect to any RS-232C port. Holding a large, awkward 
tablet over a keyboard and trying to move the GEM pointer is pointless. Tablets of 
any make have a limited practical application with GEM. Look for these "tablets" in 
the Mouse Options of GEMSETUP. 

Output 

In order to obtain a hard copy printout from GEM's OUTPUT, an output device 
must be properly connected to your computer. A rich and diverse group of peripherals 
is supported by GEM device drivers. Four different groups of output devices are avail
able to OUTPUT: dot matrix printers, plotters, laser printers, and photographic 
cameras. To a certain extent, daisy wheel printers are also supported by GEM, but 
strictly for text production. 

Too many serial devices can cause problems for the GEM system that tries to use 
a mouse, a plotter, and a printer. In these cases, you will have to make some special 
allowances. First, only two RS-232C ports are recognized by GEM. These are labeled 
as COM1 and COM2. It doesn't matter if you have three serial devices, only two of 
these peripherals can be connected to GEM at one time. One solution to this limitation 
is to install a standard version of the GEM Desktop with your mouse on COM1 and 
your plotter attached to COM2. Then, when you want to use your serial printer, all 
you have to do is run GEMSETUP and install the printer at COM2. The biggest draw
back to this solution is that you will have to restart your system in order for the new 
setup summary to take effect. 

Another possibility for handling several serial devices is to install several unique 
versions of the GEM Desktop. Each of these various desktops could then address a 
different set of peripherals. Once again, you would have to reboot your system to real
ize the full use of this technique. 

If one of these serial peripherals is an output device, like a plotter, printer, or cam
era, then GEM will automatically create two additional lines for a batch file that is on 
the GEM STARTUP disk. This batch file will be either the GEM-created GEM.BAT 
or the user-created AUTOEXEC.BAT. These lines serve as a means for telling DOS 
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to redirect all output from the parallel port (LPT1) to the designated RS-232C port 
(COM1 or COM2) and to use a special communications protocol during all future out
put. The DOS MODE command is used for signaling this port and protocol change. 
Therefore, MODE will be on your GEM STARTUP disk for executing either of these 
modified batch files (GEM copies this file onto the disk automatically). 
Dot Matrix Printers: 

Epson FX, JX, MX, and RX. These are the classics of the dot matrix printer 
field. No other printer has achieved such a clear domination of a market segment as 
that expressed by Epson printers. Two resolution modes are supported for these printers 
in GEM. With the MX, however, only the low-resolution graphics mode should be used. 
If you have further questions about dot matrix printers, please refer to the definitive 
book on the subject, EPSON, EPSON, Read All About It! (Addison-Wesley, 1985), which 
just so happens to have been co-authored by me. 

IBM Color Jetprinter. If you need a color dot matrix printout from any GEM 
application, this is the printer for you. While the output won't be as precise as that 
generated by a plotter, the copies will be suitable for draft purposes. 

IBM Graphics Printer. Who's kidding who? This printer from IBM is nothing 
more than an Epson RX printer with a different ROM and nameplate. Of course, the 
different ROM on this IBM printer has the ability to print all of IBM's oddball charac
ter set. This point, however, doesn't mean much in GEM. 

Juki 5510. Now here is a printer that doesn't know what to be when it grows 
up. By flipping several internal DIP (dual in-line package) switches, you can turn the 
Juki into an Epson or the Juki into an IBM or the Juki into a color dot matrix printer. 
Each of these different modes has further variations on its character set and foreign 
language font. Two GEM installations are possible with the Juki 5510: as an Epson 
and as an IBM Graphics Printer. This versatility endears the Juki to the GEM en
vironment. 

Star Micronics SG, SD, and SR. Star knows a good thing when they see it. 
All of their printers follow the escape code sequences used by the Epson printers. There
fore, all graphics and text that is sent to an Epson will print equally well on a Star. 
These printers should be installed with GEM's IBM/Epson drivers. 
Plotters: 

Hewlett-Packard 7470A, 7475A, 7440, and 7550 and IBM 7372. 
These plotters connect to any RS-232C port. DIP switch settings, pen placement, and 
paper adjustment are left to the user. With a plotter installed in GEM, high-resolution 
color output is possible. This quality is particularly important when using GEM Graph. 
Laser Printers: 

Apple Computer LaserWriter. Nothing can compare to the print quality of 
a laser printer. And, in laser printers, the Apple LaserWriter represents a landmark 
achievement. This is one of the first commercially successful laser printers that ad
dresses the personal computer market. Qriginally intended to connect with a Macin
tosh computer, the LaserWriter is also able to interface with an IBM microcomputer 
(through any RS-232C port). 

Resolution is superb and the speed of production is outstanding. For GEM OUT
PUT, this is the ultimate output device. 

Hewlett-Packard LaserJet +. This is the most recent release of the original 
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personal computer market laser printer. Even this newest model, however, loses a lit
tle in performance to the LaserWriter. The older LaserJet I is also supported by GEM. 
Photographic Cameras: 

Polaroid Palette. Recording GEM documents off of a standard display is an im
practical proposition. Very few office environments would permit a total exclusion of 
overhead lighting for snapping a few screen shots. Furthermore, setting up a camera 
and tripod would try any executive's patience. Leave it to Polaroid to come up with 
the perfect solution. Just connect the Palette to an RS-232C port and a composite video 
signal port and you can snap screen pics without a tripod or dimming any room lights. 
Each GEM image is first saved on a floppy disk by the Palette and then processed later. 
The actual processing takes place on the Palette with a built-in 35mm camera (an op
tional Polaroid back will give you instant results). After the film has been exposed by 
the Palette, it is developed by conventional means. This is the best method for con
verting GEM Graph and GEM Word Chart documents into presentation-quality trans
parencies. 

Memory 

GEM isn't near the memory hog as are some of the other alternate DOS environ
ments. Both DESQview and Windows require memory amounts of 512K bytes RAM, 
with 640K bytes RAM being the preferred value (see Chapter 9). GEM, on the other 
hand, can get by with considerably smaller RAM values. 

These GEM memory sizes are determined by the version of DOS that you will be 
using. For example, the version 2 DOS family has a GEM RAM minimum of 256K 
bytes. Alternatively, when a version 3 DOS family is used, this minimum RAM value 
increases to 320K bytes. Therefore, any IBM PC user who installs the GEM Desktop 
with PC-DOS 3.21, for example, will need at least 320K bytes of RAM for proper sys
tem operation. Achievjng this necessary RAM value in an IBM PC with a maximum 
system board configuration of 256K bytes RAM is only possible through memory-laden 
expansion boards. 

Note: While GEM can "get by" with these minimums, the best performance will 
only be realized through larger memory computers. In this case, 640K bytes RAM 
should be considered the ideal memory size. 

One of the better ways to improve your GEM performance is through the addition 
of one or more RAM drives. These RAM drives are volatile data storage devices that 
wi11lose all of their information each time the computer's power is turned off. They 
can, however, dramatically increase the overall speed of application loading by avoid
ing the inevitable delays invoked by mechanical drives (yes, this also includes hard 
drives). 

Because of GEM's need for conventional memory, a RAM drive can only be used 
in expanded memory. Expanded memory is a special convention established by several 
manufacturers as a way of circumventing DOS's 640K byte RAM limit (see below un
der Intel Above Board). If you elect to use a RAM drive with GEM, make sure that 
you correctly notify DOS of this drive's existence. Additionally, use the GEM Desktop 
for assigning an icon to the RAM drive. The Install Disk Drive ... command under 
the Options Menu is used for giving the RAM drive its designation (usually C: in a 
dual floppy system or D: in a hard drive system) and its icon. Due to the RAM drive's 
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speed factor, you might prefer to use a hard drive icon for identification on the GEM 
Desktop (although either a floppy or a hard icon will work). 

The RAM drive itself will have to be configured during the GEM startup phase. 
This usually involves placing special commands inside a CONFIG.SYS file. In the case 
of most RAM drive software, DOS's DEVICE = command is used along with the name 
of this software and any of its special RAM drive parameters. Once this RAM drive 
has been installed during GEM STARTUP, the icon assignment will take place fol
lowing the loading of the GEM DESKTOP directory. After you have completed all 
of these chores, applications and documents can then be copied to the RAM drive 
through standard GEM icon dragging techniques. 
Memory Expansion Boards: 

AST SixPakPlus. This is one of the first multifunction memory expansion cards 
for the IBM PC. A maximum of 384K bytes RAM can be installed on this board. The 
SixPakPlus also has a serial port, a parallel port, a battery powered clock/calendar, 
and a software package that provides RAM drive and print spooler applications for 
the additional RAM. 

IBM 64/256Kb Memory Expansion Option. IBM must feel that this mar
ket is being adequately satisfied by independent manufacturers. Their cast into the 
memory expansion board arena is a weak product that is a throwback to the days when 
256K bytes RAM was enough memory to choke a spreadsheet. Today's power GEM 
user, however, needs huge amounts of memory where even 640K bytes RAM is an 
inadequate amount. 

Intel Above Board. Lotus, Intel, and Microsoft put their corporate heads to
gether and concocted a method for breaking DOS's self-imposed 640K bytes RAM bar
rier. This method, known as the Expanded Memory Specification (EMS), can provide 
up to 8M bytes RAM for programming, RAM drives, and print spoolers. The only prob
lem with EMS is that software manufacturers must adhere to this specification in or
der for their programs to use this extra memory. Intel supplies this type of special 
programming for placing RAM drives and print spoolers inside this expanded mem
ory. This leaves GEM free to exploit a full 640K bytes of conventional RAM. 

Orchid Conquest. Add a multifunction board to an EMS board and you have 
the Conquest. The Conquest is an attempt by Orchid to kill several markets with one 
card. By combining 2M bytes RAM with a serial port, a parallel port, and a battery 
powered clock/calendar, Orchid hopes that all of your expansion needs will be satis
fied. Ther~ is also the now requisite software package with RAM drive and print spooler 
applications. To be fair, Intel also offers a multifunction EMS board. The Intel board, 
however, is only able to supply 1.5M bytes RAM. In either case, one of these two ex
pansion boards is the ideal GEM memory embellishment. 

Hard Disk Drives 

Using·GEM on a twin floppy disk drive system can cause problems-namely disk 
swapping (although the number of swaps is relatively minor). The best way to avoid 
these infrequent disk changes is to place GEM and all of its associated applications 
onto a hard disk drive. 

Contrary to popular belief, hard drives can be installed by the user. The entire 
process can usually be performed in under 30 minutes and the results are of a profes-
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sional stature. No special tools are required and no soldering is needed. Just discon
nect the power cables and remove the right-hand floppy disk drive from your IBM (this 
drive slides forward after a side mounted set screw has been removed). Next slide in 
the new internal hard drive. Finally, install the hard drive's controller board and con
nect the necessary cables. You can now install GEM with GEMPREP onto this hard 
drive. 
Hard Disk Drives: 

Mountain Computer 20M byte DriveCard. This revolutionary device is a 
functionally complete hard drive and controller housed on a single expansion board. 
The drive itself is a 3 112" technological breakthrough. Installation of the DriveCard 
differs dramatically from that of a more conventional hard drive. A single expansion 
slot is used for holding this hard drive and there is no wrestling with cables or mount
ing hardware. Even better, installing the DriveCard does not require the removal of 
a floppy disk drive. Therefore, a system equipped with the DriveCard retains the dual 
floppy drives for added storage. An unfortunate blemish on the DriveCard is its exces
sive depth. Even though this card installs in one slot, its thickness blocks an adjacent 
slot. Therefore, the DriveCard actually uses two slots. 

Plus Development Hardcard. A complete 10M or 20M byte hard disk drive 
and controller all on a single expansion board. Actually, the Hardcard was the first 
of these new "hard drive on a card" products. Its ability to slip into a single IBM ex
pansion slot has made the Hardcard an attractive alternative to the standard internal 
hard drive. In the case of the Hardcard, only one expansion slot is actually used. This 
highly regarded feature separates the Hardcard from the rest of the hard disk drive 
card market. Furthermore, the Hardcard comes with a marvelous directory program 
that enhances GEM's ease of use. Another Hardcard plus is that both floppy disk drives 
can stay in the system. By far, the Hardcard is the best storage method for using GEM. 

Seagate 20M byte Internal Hard Drive. Of all the common hard drives, this 
brand and size remains the most popular for the GEM user. Each Seagate (there is 
a version for XT, as well as AT computers) hard drive comes with all of the necessary 
mounting hardware and cables. A Western Digital Controller board also comes with 
the Seagate (like the drive that it drives, this is one of the better controller cards). 
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Chapter 3 

GEM Collection 

When you hand someone a pencil and a piece of blank paper, what do they do? Some 
people sketch a portraiture of a classmate, others calculate their checking account's 
balance, and still others set their pen to a short piece of prose. No matter which action 
is undertaken, the end result is always the same-people are being creative. 

If we distill the myriad of possible pencil and paper actions down into their most 
basic elements, we are left with two broad categories of action: writing and drawing. 
Coincidentally, these are also the two most prominent categories in computer software. 
In the terminology of computers, however, these writing and drawing categories are 
known as word processing software and graphics software, respectively. Of the hundreds 
of programs that fill both of these select software niches, very few reach a point of 
consumer recognition. Even fewer of these packages become widely accepted enough 
to be considered a standard for their specific category. WordStar, in the word process
ing category, is probably the best example of a program that has reached this coveted 
celebrity status. Unfortunately, there is no similarly definitive product for graphics soft
ware. Well, GEM Collection is out to change the complexion of both the word process
ing software standard and the graphics software standard. 

DRI has combined these two prominent software categories into a single package 
that is known as GEM Collection. Actually, GEM Collection is two separate software 
disks, GEM Paint and GEM Write, that are linked together by the GEM Desktop. These 
are true GEM applications, which fully exploit all of the mouse, menu, and command 
activities that you discovered in Chapter 1. 

Basically, there are two ways of working with GEM Collection. GEM Paint and 
GEM Write can either be used individually from the GEM Desktop or they can be com-
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bined into a powerful word processing/graphics package that would make even Word
Star envious. But which mode of operation is best? 

The real beauty of working with GEM Paint and GEM Write on the GEM Desk
top is that you don't have to make a choice. Just point and click and you'll be using 
these applications individually, or point and click again for placing GEM Paint images 
inside a GEM Write document. During all of your carefree pointing and clicking, GEM 
manages all of the file and disk dirty work and lets you print a full-color, illustrated 
text (if your system is so configured), which will generate avaricious thoughts from 
your corporate competition. Attempting a similar process through DOS and software 
like W ordStar would be literally impossible. Happy painting and writing. 

GEM PAINT 

Imagine a blank sheet of paper and an unlimited supply of paintbrushes and pigments. 
Couple to this vast assortment of tools the ability to draw perfectly straight lines, grace
fully smooth arcs, and finely detailed patterns. Believe it or not, you have just high
lighted the outstanding features found in GEM Paint. 

GEM Paint is a graphics development package that deals with imagery on the pixel 
level. In other words, each line, arc, and pattern that you place on the GEM Paint Paint
ing Surface is composed of numerous screen pixels. In tum, each of these pixels can 
be individually controlled through GEM Paint and placed in either an "on" or an "off" 
condition. This "on" and "off" state is equivalent to a dark pixel and a light pixel, 
respectively. The result is a detailed, high-resolution picture that can be transcribed 
"pixel for pixel" onto a dot matrix printer. 

Note: This pixel method of graphics production is radically different from the tech
nique used by GEM's other graphics program, GEM Draw. GEM Draw creates its im
agery on an element level. Refer to Chapter 4 for more information on GEM Draw. 

The one drawback to this type of image creation is the enormous consumption of 
disk storage space. Basically, each pixel is represented by one or more bits of data 
(the extra bits serve as characteristics of color, hierarchy, etc.). Subsequently, each 
of these bits are stored on the disk media (either floppy or hard). All of this means 
that an average GEM Paint image will cost around 18K bytes of disk storage space. 
Conversely, a highly detailed image could run up to 35K bytes of data. These are im
portant points to remember when committing your images to storage. 

Tip: Based on this knowledge of GEM Paint image size, hard disk drive users should 
realize that it is far more practical to use a floppy disk for holding all of your GEM 
Paint work. This strategy prevents the wasting of precious hard disk space with memory
hungry graphics imagery. Additionally, a nice graphics library can be constructed from 
this practice. 

INSTALLING GEM PAINT 

DRI sells GEM Paint on one floppy disk. In GEM Collection, this disk is identified 
as disk 1 of 2 (disk 2 of 2 is GEM Write). Before you go any further, you should make 
a backup copy of this floppy disk. You will then use this backup copy for your GEM 
Paint installation. An unfortunate oversight by DRI has left this GEM Paint master 
disk in a write-enabled condition. In other words, if you use the wrong DOS command, 
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you could erase this disk and destroy GEM Paint. Remember, in first grade, when 
Tommy Baker broke all of your crayons? Well, to prevent this possible calamity, im
mediately write protect your DRI-issued GEM Paint master disk (use the small sheet 
of rectangular, self-adhesive tabs that came packaged with your floppy disks). Now, 
you are ready to back up your GEM Paint disk. 

Backing Up GEM Paint 

D Place your DOS disk in drive A:. 

Format a floppy disk. 

D Type: FORMAT 

D Press the ENTER key. 

Follow the formatting instructions. (Remember to remove your DOS disk from A: 
before you begin.) 

D Insert the GEM Paint master disk in drive A:. (Make sure that you have write 
protected this disk.) 

D Insert your newly formatted disk in drive B:. (This disk should NOT be write 
protected.) 

Copy the root directory. 

D Type: COpy A: * . * B: 
D Press the ENTER key. 

This command will copy INSTALL.APP and INSTALL. TXT. 
Make two new subdirectories on the disk in drive B:. (The abbreviation MD will 

be used for the make directory command MKDIR.) 

D Type: MD B:" GEMAPPS 
D Press the ENTER key. 
D Type: MD B:" IMAGES 
D Press the ENTER Key. 

Copy the contents of one master disk subdirectory to the disk in drive B:. 

D Type: COpy A:" GEMAPPS B:" GEMAPPS 
D Press the ENTER key. 

This command will copy PAINT .APP, P AINTH.RSC, PAINT .RSC, SNAP
SHOT,ACC, and SNAPSHOT.RSC. 

Copy the contents of the other master disk subdirectory to the disk in drive B:. 
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o Type: COpy A: "-. IMAGES B: "-. IMAGES 
o Press the· ENTER key. 

This command will copy TIGER.GEM, FLORPLAN.GEM, MAP.GEM, POREQ.GEM, 
RPTCOVER.GEM, SHORTHI.GEM, SHORTCUT.GEM, HOUSE.GEM, SHIP.GEM, 
FLORPLAN.IMG, MAP.IMG, POREQ.IMG, RPTCOVER.IMG, TIGER.IMG, 
SHORTCUT.lMG, SHORTHI.IMG, SHIP.IMG, and HOUSE.lMG. 

Make an additional subdirectory for a subdirectory. 

o Type: MD B:"-.GEMAPPS"-.PATIERNS 
o Press the ENTER key. 

Copy the contents of the master subdirectory subdirectory to the disk in drive B:. 

o Type: COpy A: "-.GEMAPPS"-.PATIERNS B:"-.GEMAPPS"-.PATIERNS 

o Press the ENTER key. 

This command will copy COLORO.PAT, COLORl.PAT, COLOR2.PAT, 
COLOR3.PAT, COLOR4.PAT, COLOR5.PAT, COLOR6.PAT, MONO 1. PAT, 
MON02.PAT, MON03.PAT, COLOR. PAT, LINES. PAT, and MONOO.PAT. 

The backup disk is complete. Remove and label this disk. Place the DRI GEM Paint 
master disk in a Swiss bank vault. 

Installing GEM Paint 

You are now ready to install GEM Paint on the GEM Desktop. To perform this 
installation, you will need two blank floppy disks. 

o Start the GEM Desktop. 
o Select the floppy disk B: icon. 
o Display the File Menu. 
o Choose the Format ... command. The warning dialog appears. 
o Insert a blank floppy disk in drive B:. 
o Click on the "ok" button. (Label this disk "GEM Paint Application.") 
o Repeat the above steps for the second blank floppy disk. (Label this disk' 'GEM 

Paint Data.") 
o Insert the copied GEM Paint disk in drive A:. 
o Double-click on the floppy disk A: icon. 
o Double-click on the INST ALL.APP icon (Fig. 3-1). 
o A warning dialog appears informing you that this installation requires two for

matted floppy disks, called GEM Paint Application disk and GEM Paint Data 
disk. 

o An insert dialog appears. Insert GEM Paint Application disk in drive B:. 
o An insert dialog appears. Insert GEM Paint Data disk in drive B:. 
o An insert dialog appears. Insert GEM STARTUP in drive B:. 
o An insert dialog appears. Insert GEM DESKTOP in drive A:. 
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oo[IJO 
GEM~PPS IM~QES INSTALL. ~pp INSTALL. TXT 

Fig. 3-1. Double-click on the INSTALL.APP 
icon for installing GEM Paint. 

Warning! Failure to place the GEM DESKTOP disk in drive A: will result in a 
complete system crash. This error can't be corrected by a normal system reset. You 
will have to turn the computer off and then restart the entire installation procedure again. 

D An insert dialog appears. Insert GEM Paint Application disk in drive B:. 
D A finish dialog appears. GEM Paint is now in the GEMAPPS folder on the GEM 

Paint Application disk and several sample images are on the GEM Paint Data 
disk. 

D Return to the GEM Desktop. 

Granted, several of the DRI-provided GEM Paint images are quite pretty, but they 
are wasteful of disk space. For example, the nine type .IMG images on the GEM Paint 
Data disk use l08K bytes. After you have had a chance to examine them, erase them 
from your GEM Paint Data disk (they will still be on your copy of the GEM Paint mas
ter disk, as well as the GEM Paint master disk itself). This will leave you plenty of 
room for your own images. Additionally, new image disk should mimic the directory 
path naming convention used on the GEM Paint Data disk. This information is entered 
through an ITEM SELECTOR dialog. The proper directory path for hard drives is: 

Directory: C:" IMAGES" * .IMG 

or, for floppy drives: 

Directory: B:" IMAGES" * .IMG 

There is a valuable desk accessory that comes packaged with GEM Paint. This acces
sory, which is found on the Desk Menu, is called Snapshot. The operation of this util
ity is explained more fully later in this chapter. You will, however, only be able to use 
Snapshot on systems with a minimum of 320K bytes RAM (this value is inclusive of 
your DOS version). Furthermore, Snapshot is automatically copied onto your GEM 
STARTUP disk. Therefore, you will have Snapshot permanently available on both the 
GEM Desktop and in other GEM applications as well. 
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USING GEM PAINT 

To start GEM Paint, enter the GEM Desktop and insert the GEM Paint Application 
disk into drive A: and your GEM Paint Data disk in drive B:. 

D Double-click on floppy disk A: icon. 
D Double-click on GEMAPPS folder icon. 
D Double-click on PAINT .APP icon. 

Following this brief loading exercise, you are greeted by a blank GEM Paint screen 
(Fig. 3-2). There are seven landmark features on the GEM Paint screen: the Menu Bar, 
the Title Bar, the Pattern Palette, the Line Palette, the Color Palette, the Tools Pal
ette, and the Painting Surface. Each of these features performs exactly like their sib
lings on the GEM Desktop. 

Menu Bar 

Along the top border of the GEM Paint screen, is a line containing all of the drop
down menus. Every GEM Paint command is accessed by displaying these menus. There 
are seven GEM Paint menus: Desk, File, Tools, Selection, Patterns, Font, and Style. 
Each of these menus is described in complete detail in the Gem Paint Reference sec
tion later in this chapter. 

Title Bar 

This explanatory line at the top of the Painting Surface provides all of the disk 

Desk File Tools Selection Patterns Font Style 

Fig. 3-2. The opening GEM Paint screen. 
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information related to the current picture. These descriptive elements include: the drive 
designation, the Directory Path Name, the Picture Name, and the Picture Type. While 
three of these elements can vary, the Picture Type will always be .IMG when dealing 
with GEM Paint pictures. 

Pattern Palette 

Occupying the entire right-hand side of the GEM Paint screen is the Pattern Pal
ette, giving you a selection of 22 different patterns. Each pattern is individually selected, 
with the currently chosen pattern being displayed in the Current Pattern box located 
at the top of the Pattern Palette. When you select a pattern, all subsequent painting 
is carried out in this new design scheme. 

Line Palette 

Situated along the bottom of the left-hand border is the Line Palette, which offers 
a selection of five different line widths. A check mark is placed next to the currently 
selected line width. Once a selection has been made from the Line Palette, GEM Paint 
uses this line for painting any geometric shape. The dashed line at the top of the Line 
Palette signifies a transparent line. 

Color Palette 

The variably-sized Color Palette section lies in the middle of the left-hand border. 
The actual number of colors filling this palette is determined by the color capabilities 
of your graphics card/monitor combination. For example, IBM Enhanced Display Adap
ters are capable of displaying the GEM Paint maximum of eight colors. At the other 
end of this color spectrum lies the monochrome boards, which can display only four 
colors in the Color Palette. Once you click on a Color Palette choice, the selected color 
is applied by the tools during painting. In order to keep track of the currently selected 
color, the lines in the Line Palette are used to represent the selected color. 

Tools Palette 

Sitting on top of the other two palettes along the left-hand side of the GEM Paint 
screen, is GEM Paint's major work palette, the Tools Palette. These fifteen tools are 
individually selected and used for working on the Painting Surface. Each tool brings 
with it a unique painting attribute. 

Painting Surface 

The Painting Surface is the large blank space that fills the entire center of the GEM 
Paint screen. Think of the Painting Surface as a piece of paper. GEM Paint is able 
to work with large 8 112" x 11" pieces of artwork, but can only display small portions 
of this image size on the screen. Various menu-driven commands allow you to control 
the presentation size of your picture on the Painting Surface. 

GEM PAINT REFERENCE 

The numerous elements found in the Menu Bar and in the Tools Palette can lend profes-
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sional results to a picture created with GEM Paint. Each menu contains several differ
ent commands that control the Painting Surface's visual activity, as well as the 
file-related picture archiving. The tools found in the Tools Palette, on the other hand, 
perform the actual picture creation. This difference in duty can be simplified even fur
ther by labeling all tools as pixel controllers and referencing all commands as picture 
controllers. 

Desk Menu (Fig. 3-3) 

This menu contains the GEM Paint information and desk accessories. Note: These 
desk accessories will only be visible and, therefore, active on systems with a minimum 
of 320K bytes RAM. Without this extra memory, the Desk Menu will not display any 
desk accessories. 

Paint Info ... displays an information dialog containing the copyright assign
ment and the number and byte size of pictures which can be painted on the GEM Paint 
screen. 

Calculator displays a multifunction calculator. Refer to Chapter 1 for complete 
operation instructions. 

Clock displays a real-time clock and calendar. Refer to Chapter 1 for complete 
operation information. 

Print Spooler creates a list of documents for output. Refer to Chapter 1 for com
plete operation information. 

Snapshot displays a screen "camera" which can store any GEM Desktop or GEM 
application image on a disk (Fig. 3-4). 

Fil~ Tool~ 

Calculator 
ClocK 
Print spOOler 
snapsnot 

Fig. 3-3. The GEM Paint Desk Menu. 
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Fig. 3-4. A new desk accessory 
is added by GEM Paint-Snapshot. 

During GEM Paint installation this desk accessory is automatically copied onto both 
your GEM Paint Application disk and your GEM STARTUP disk. On the GEM 
STARTUP disk you will find the Snapshot utility in the GEMBOOT folder. 

Any image saved with Snapshot becomes a graphics image file on the designated 
disk. By using a GEM Paint file type (i.e., .IMG), you will be able to load this Snap
shot image into GEM Paint for composition, revision, and output. 

Tip: Use floppy disks for holding your Snapshot pictures. This way you can build 
a complete graphics file library without wasting valuable hard drive space. 

To Use the Snapshot Command: 

D Display the Desk Menu. 
D Choose the Snapshot command. The Snapshot window appears. 
D Click on the camera icon inside the Snapshot window. The ITEM SELEC

TOR dialog appears. 
D Enter a directory path name for your Snapshot disk in the Directory field. 

(Be sure to include a drive designation different from the GEM Paint Applica
tion disk drive.) 

D Enter a name for your Snapshot picture in the Selection field. (If you plan 
on working with this picture in GEM Paint, you have to use a GEM Paint file 
type. Therefore, use .IMG after your chosen name (remember, the period is 
already in the Selection field). 

D Click on the "ok" button. 
D The pointer changes to a cross hair. 
D Drag the cross hair from upper left corner of the desired Snapshot area to 

the lower right corner. A dashed rectangle appears around the selected area. 
D Release the mouse button. Snapshot saves the selected area onto the desig

nated disk under the specified name. 
D Repeat this process for as many pictures as you want. 
D Click on the Snapshot window close box to stop. 

On-screen Snapshot Help is available through the presence of friendly, on-screen 
operational information (Fig. 3-5). 
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D Display the Desk Menu. 
D Choose the Snapshot command. The Snapshot window appears. 
D Click on the question mark icon (?). The Snapshot information dialog appears. 
D Click on the "ok" button. 



File Menu (Fig. 3-6) 

New erases the current picture and creates a blank Painting Surface. This com
mand does not save an active picture. 

Open ... loads the specified picture from disk into GEM Paint. This loaded pic
ture becomes the active window. For information on loading two different pictures, 
see the Advanced Techniques section later in this chapter. 

Close removes the active window picture from the Painting Surface. This com
mand saves the removed picture onto the specified disk drive. 

Tip: The Close Box on the active window functions identically to the Close com
mand. Use the Close Box as a shortcut for saving a finished picture. 

Save saves the active window picture on the specified disk drive under its current 
name. This action will replace the picture with the same name on the disk with the 
active window one. This command does not remove the picture from the active win
dow. Another name for this action is "updating." 

Save as ... saves the active window picture on the specified disk drive under 
a requested name. This name should be different from the current name. A dialog 
prompts you for this name change. Another name for this action is "backing up." 

Abandon restores the original picture prior to the current non-saved changes. 
To Output ... generates the hardcopy output of a GEM Paint picture. Refer 

to Chapter 1 for operation information. 
Quit ends GEM Paint and returns to the GEM Desktop. 

Tools Menu (Fig. 3-7) 

Undo removes the action created by the last tool use. An action refers to a mouse 

How to Use SnapShOt. .. 

1. ClicK on tne oamera ioon to start snapsnot. 

2. wnen tne Item Selector appearsl enter a name for tne 
snapshot you are about to take. 

3. vVhen the Item Selel::tlx disappears, drag th@ l~rQSS hair 
pOinter from the upper left to 11:lwer right to form a 
IIrubber rectangle" that enl:;loses the area you want tel 
pnotograpn, snapsnl)t reo(lras the image wnen YI:IU release 
me mouse button, 

Fig. 3-5. The Snapshot help screen. 
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Tools Sel~ction Patterns Font Style 

Fig. 3-6. The GEM Paint File Menu. 

Desk File Selection 
unoo (ES'::) 

Grill On/Off 
Transparent on/Off 

Brush Shape ... 
t:iI)JIliii!ilio+""";+IIlr-...u I Show Picture ... 

Size Picture ... 

Fig. 3-7. The GEM Paint Tools Menu. 
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click-defined painting "stroke." For example, if three stray lines have been painted 
with the Line tool, only the last line will be removed with Undo. This is due to the 
last mouse click coming on the third, and final, line. 

Grid On/Off activates or removes the grid plotting system. The grid is an invisi
ble piece of graph paper that can be placed underneath the Painting Surface. The Grid 
On command places this grid in the active window. The Grid Off command removes 
the grid from this window. When the grid is active, every tool action "snaps" to the 
nearest grid point. By using this command, perfect alignment of every paint action is 
ensured. 

Transparent On/Off causes overlaying patterns to become transparent and re
veal lower pattern layers. The Transparent On command makes the light-colored 
areas in the topmost pattern transparent. The Transparent Off command restores 
the native opacity of each pattern layer. 

Brush Shape ..• offers a selection between several different Paint Brush shapes. 
To Use the Brush Shape ••• Command: 

D Display the Tools Menu. 
D Choose the Brush Shape ..• command. The brush shape box appears. 
D Click on the desired brush shape. A box forms around your selection. 
D Click on the "ok" button. 

Show Picture ... shows your entire picture on the GEM Paint screen. If your 
current picture is larger than the Painting Surface, this command places the entire pic
ture on the screen. 

Tip: When you use the Show Picture ••• command, a dashed rectangle frames 
the part of the picture that is currently visible on the Painting Surface. You can drag 
this rectangle around on the picture for framing any area that you want to view on 
the Painting Surface. 

Size Picture .•• is a dialog for changing the size of your active window picture. 
Any change in size that eliminates a portion of your current picture will permanently 
erase this area from the picture. If this erasure is going to happen, a warning dialog 
will announce this effect. 

Selection Menu (Fig. 3-8) 

Note: All of the commands in this menu work concurrently with the Selector tool. 
If the Selector tool has not been used, then all of these commands are dimmed and 
ineffective. 

Clear erases the Selector-defined area. 
Complement reverses the colors in the Selector-defined area. For example, all 

black lines will change to white and all white spaces will reverse to black. 
Flip Horizontal flips the Selector-defined area around its horizontal axis. 
Flip Vertical flips the Selector-defined area around its vertical axis. 

Patterns Menu (Fig. 3-9) 

Hide/Show Patterns activates and removes the Pattern Palette from the GEM 
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Desk File Tools Patterns Font S Ie 

~liliiili~~~~g~l~e~ar -:~-------r~~~~~iiliiiiilitl I Complement 
Flip Horizontal 
Flip Vertioal 

Fig. 3-8. The GEM Paint Selection Menu. 

Desk File Tools Selection 

Fig. 3-9. The GEM Paint Patterns Menu. 
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Hide/Show Patterns 

Make Pattern 
Edit Pattern ... 

save Patterns ... 
Load Patterns ... 



Paint screen. The Hide Patterns command removes the Pattern Palette from the 
screen. The Show Patterns command places the Pattern Palette on the screen. 

Make Pattern creates a pattern based on a selected region on the Painting Surface. 
To Use the Make Pattern Command: 

o Click on the Pattern Palette pattern that you want to replace. 
o Click on the Selector tool. 
o Place the pointer in the upper left corner of the new pattern. 
o Click the mouse button. A dashed square, 16 pixels by 16 pixels, will outline 

the new pattern area. 
o Display the Patterns Menu. 
o Choose the Make Pattern command. 
o The new pattern replaces the old pattern in the Pattern Palette. 

Tip: When placing the Selector pointer in the correct spot for the new pattern, 
first determine the exact center of the new pattern. Then count eight pixels up and 
eight pixels to the left, before fixing the new pattern outline with the mouse button click. 

Edit Pattern . . . customizes the preparation and illustration of a new pattern. 
To Use the Edit Pattern ... Command: 

o Display the Pattern Menu. 
o Choose the Edit Pattern ... command. An editing box appears. 
o There are three windows for editing a pattern: 

Click on the desired color window. 
Place pixels inside the work window. 
Observe the final pattern's appearance in the pattern window. 

o Click on the "ok" button. 

Save Patterns ... saves the current Pattern Palette on the designated disk drive. 
An ITEM SELECTOR dialog appears after you choose this command. Pattern docu
ments saved with this command should be labeled with the type .P AT. Later, the Load 
Patterns ... command is used for loading this Pattern Palette into GEM Paint. 
Tip: Monochrome system users can create a custom Pattern Palette that will be auto-
matically loaded during the starting of GEM Paint. 

o Create a custom Pattern Palette. 
o Display the Patterns Menu. 
o Choose the Save Patterns . . . command. An· ITEM SELECTOR dialog 

appears. 
o Type the following name and type in the Selection field: 

MONO.PAT 

o Click on the "ok" button. 

Now, every time you start GEM Paint, this custom Pattern Palette will be loaded 
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automatically. When you want to switch back to the default Pattern Palette during GEM 
Paint starts, just remove MONO.PAT. 

Load Patterns .•. loads a previously saved pattern set into the Pattern Palette. 
An ITEM SELECTOR dialog appears with this command and prompts you for the 
name of the desired pattern set. 

Font Menu (Fig. 3-10) 

All of the commands in this menu are only active when the Text tool has been 
selected. A check mark is placed next to each currently active command. 

System. This command activates the standard IBM system font. 
Swiss. This is an optional font that won't be available on all systems. 
Point. This command allows you to select one of seven different text point sizes, 

each of which is relative to the system's screen. These actual text sizes might vary 
on the selected output device. The Point command has the following sizes: 8,10,14, 
16, 18, 20, 28, 36, and 72. 

Style Menu (Fig. 3-11) 

All of the commands in this menu are only active when the Text tool has been 
selected. A check mark is placed next to each currently active command. 

Normal. The Normal command selects the standard text style. 
Bold. The Bold command selects a dark, emphasized text style. 
Italic. The Italic command selects an italic text style. 

Dpsk File Tools Splection 

8 pOint 
10 pOint 
14 pOint 
16 point 
18 pOint 
20 pOint 
28 point 
36 point 
72 point 

Fig. 3-10. The GEM Paint Font Menu. 
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Desk File Tools Selection 

Fig. 3-11. The GEM Paint Style Menu. 

Normal 
Bold 
Italic 
Underline 

.,I Align Left 
Align Middle 
Align Right 

Underline. The Underline command selects an underlined text style. 
Align Left. When the Align Left command is selected, the text is justified along 

the left-hand border of the selected area. 
Align Middle. When the Align Middle command is selected, the text is evenly 

centered in the selected area. 
Align Right. When the Align Right command is selected, the text is justified 

along the right-hand border of the selected area. 

Tools Palette (Fig. 3-12) 

Microscope enlarges the selected area for highly detailed work. 
To Use the Microscope Tool: 

o Click on the Microscope tool. 
o Place the pointer over the area that is to be magnified. 
o Click the mouse button. The Microscope window appears. 
o The Microscope window has four parts (Fig. 3-13): 

The exit window shows the area of the Painting Surface where you are working. 
Click in this window to exit the Microscope window. 

The movement window is used for moving the main Microscope window around. 
To move, drag the small rectangle, in this window, to a new location. 

The color window is used for selecting the current pixel color. Click on the color 
of your choice. 
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Fig. 3-12. The GEM Paint Tools Palette. 

The main Microscope window is used for turning pixels on and off, by clicking 
the mouse button on the desired spot. 

Selector defines a work area. This selected area is marked by a dashed border. 
All of the commands in the Selection Menu are activated when this tool is used. This 
tool is also used with the Make Pattern command (see above). 

Fig. 3-13. Using the Microscope tool produces a special enlargement screen for working with individual 
pixels. 
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ABC or Text adds keyboard-typed text to your picture. All of the commands in 
both the Font Menu and the Style Menu are activated when this tool is used. 

To Use the ABC Tool: 

D Click on the ABC tool. 
D Move the pointer to the position for text placement. 
D Click the mouse button. 
D Type the text. 
D Press the ENTER key or move the pointer to a new location to stop text entry 

on that line. 

Pencil draws a single pixel-width line. Drag the pointer to produce a line. Release 
the mouse button to stop. 

Eraser removes any painted area on the Painting Surface. Drag the pointer to 
erase pixels. Release the mouse button to stop. Selective areas can be erased by click
ing the mouse button while the pointer is over the objectionable area. 

Line paints a straight line. To make a line, drag the pointer from the line's start
ing point to its ending point. Release the mouse button to "fix" the line. 

Paint Brush paints a line whose size, shape, and pattern have been determined 
by various commands. The current Pattern Palette choice establishes the Paint Brush 
pattern. The Brush Shape ... command sets the size and shape of the painted line. 
Drag the pointer to paint a line. Release the mouse button to stop. 

Paint Sprayer paints an irregular blob whose size, shape, and pattern are set 
by the Brush Shape ... command and the Pattern Palette, respectively. Click the 
mouse button to paint a single blob. 

Paint Tap fills the defined area with the selected pattern. The pattern is deter
mined by the Pattern Palette. Click inside the area that you want filled by the selected 
pattern. 

Warning: Any gaps in the defined area will cause the pattern to "leak" outside 
into the surrounding picture. Even a gap of only one pixel width will start a leak. To 
stop a leak or to halt a Paint Tap fill at anytime, press the mouse button (or, press 
any keyboard key). 

Rectangle paints a rectangle. To make a rectangle, drag the pointer from one 
corner of the rectangle to its opposite corner. Release the mouse button when the rec
tangle is the right size and shape. 

Rounded Box paints a rounded box. To make a rounded ~ox, drag the pointer 
from one comer of the rounded box to its opposite corner. Release the mouse button 
when the rounded box is the right size and shape. 

Polygon paints a multi-sided shape. To make a polygon, click the mouse button 
at the starting point of the first side. Move the mouse to the ending point for the first 
side and click. Repeat this click-move-click procedure until the polygon is complete. 
Double-click when you are finished. If you fail to finish your polygon, GEM Paint will 
automatically connect your starting and ending side for you. 

Arc paints an arc. First, click for your center starting point. Now, drag the pointer 
along the outside periphery of the arc. Release the mouse button when the arc is the 
right size and shape. 
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Circle paints a circle. To make a circle, drag the pointer from the center of the 
circle to its outside radius. Release the mouse button when the circle is the right di
ameter. 

Free Form paints any freehand shape. Drag the pointer around the circumfer
ence of the shape. Release the mouse button when the shape is complete. 

ADVANCED TECHNIQUES 

There are several tricks and shortcuts that can make your GEM Paint life much eas
ier. In many cases, these examples are time-saving alternatives to the standard GEM 
Paint techniques. Others in this group, however, serve as methods for exploiting all 
of GEM Paint's power. Learning this little bit of mouse magic will enable you to fully 
exercise your creative talents. 

Alt Key is used with the Microscope tool. Hold this key while clicking in the 
Microscope window for changing a pixel to its complementary color. 

Backspace Key is used with the Text tool. Press this key for erasing typing 
mistakes prior to changing lines. 

Ctrl Key is used with the Selector tool. Hold this key while dragging the selected 
area for moving the selected area without duplication. 

Escape Key executes the Undo command. Press this key instead of using the 
menu selection. 

Shift Key is used for making accurate geometric shapes. For example: 

D SHIFT + Any Geometric Tool-Constrains the alignment into a perfect shape. 
D SHIFT + Selector Tool-Makes the selected area a perfect square. 

Space Bar is used with the Selector tool. After making an initial duplicate, press 
this key once before each drag for making additional duplicates. 

Item Selector is used for disk and picture maintenance. 
Open ... Command is used for copying graphics between two different pictures 

(Fig. 3-14). 

D Open your first picture. 
D Open your second picture. 
D Size the two windows so that they are both visible on the screen. 
D Use the Selector tool for outlining the area to be copied in the active window. 
D Drag the selected area from one window to the other window. 
D Dragging will duplicate the selected area into both windows. 
D Using the Ctrl key will move the selected area without duplication. Also, this 

method permanently removes the selected area from the first window. 

Edit Pattern ... Command. Click in the pattern window for filling the pattern 
with the current color. 
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Selector. Drag the selected area for a single duplicate. 
Selector. Double-click on this tool for selecting the entire Painting Surface. 
Eraser. Double-click on this tool for erasing the entire Painting Surface. 
Paint Brush. Double-click on this tool for displaying the Brush Shape ... dialog. 



HORIZONS, INC 

Fig. 3-14. Two different GEM Paint windows may be opened at the same time for exchanging pictures 
between them. 

Paint Sprayer. Double-click on this tool for displaying the Brush Shape 
.•. dip.log. 

Free Form. Use this geometric tool as a paint brush. 

o Choose a line width from the Line Palette. 
o Select the None pattern from the Pattern Palette. 
o Choose a color from the Color Palette. 
o Drag the pointer to paint with this new "brush." 

Pattern Palette. Double-click on any pattern for executing the Edit Pattern 
••. command. 

GEM WRITE 

First of all, GEM Write is not WordStar, nor is it a WordStar clone. GEM Write is 
a powerful graphics-based superset of the Volkswriter Deluxe word processing pro
gram developed by Lifetree Software. This distinguishing heritage is an important point 
to remember when dealing with GEM Write. Other graphics-based word processing 
software, most notably Mac Write, fail to provide enough feature enhancement over 
conventional programs. Conversely, GEM Write has enough features, power, and per
formance to endorse it as a strong word processing alternative. 

A graphics-based word processing program offers a strong compositional tool over 
packages like WordStar. Pictures, images, and designs can be imported into the text 
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of this graphics-based writing software. GEM Write takes this graphics insertion abil
ity one step further by working with pictures from any GEM application. Therefore, 
you can write a business report that is fully illustrated with charts from GEM Graph, 
layouts from GEM Draw, and even a corporate logo from GEM Paint. Each picture 
is faithfully inserted into the text at the desired location. This ability eliminates the 
need for a separate illustration packet with accompanying figure referencing. In an 
overworked art department, this graphics-text merging ability will bring dividends. 

A frequently leveled criticism of W ordStar centers on command memorization. 
Granted, WordStar supplies an excellent reference card and a thorough set of online 
help screens, but your productivity with this program is restricted until you can exe
cute the commands spontaneously. And this spontaneity translates into memorization. 
GEM Write has completely eliminated this need for command memorization by using 
an extensive set of drop-down menus that adhere to the simplicity of the GEM Desk
top. Every command that is used in GEM Write is contained on these menus. Relying 
exclusively on these menus for complete command execution might retard the produc
tivity of the mentally gifted GEM Write user who wants to type for speed. Therefore, 
there are numerous keyboard equivalents for these menu resident commands. This du
ality gives GEM Write the best of both worlds. 

One final valuable commodity with a word processing program is the ability to 
demonstrate an exact reproduction of your final printed output on the computer's mon
itor screen. In the jargon of the word processing crowd, this feature is called what
you-see-is-what-you-get (or, WYSIWYG). To a limited extent, WordStar has this abil
ity, but only if you are able to decipher the exact meaning of numerous control codes. 
GEM Write, on the other hand, displays a completely accurate WYSIWYG screen. 
For example, fonts, underlining, and margins are all visible on the screen in the exact 
form that they will appear on the printed page. This versatility removes any chance 
for an unpleasant surprise spoiling the final GEM Write output. 

INSTALLING GEM WRITE 

DRI sells GEM Write on one floppy disk. In GEM Collection, this disk is identified 
as disk 2 of 2 (disk 1 of 2 is GEM Paint). Before you go any further, you should make 
a backup copy of this floppy disk. You will then use this backup copy for your GEM 
Write installation. 

Backing Up GEM Write 
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o Place your DOS disk in drive A:. 
o Format a floppy disk. 

Type: FORMAT 

o Press the ENTER key. 
o Follow the formatting instructions. (Remember to remove your DOS disk from 

A: before you begin.) 
o Insert the GEM Write master disk in drive A:. 
o Insert your newly. formatted disk in drive B:. 



Copy the root directory. 

D Type: COpy A:*. * B: 
D Press the ENTER key. 

This command will copy INST ALL.APP and INSTALL. TXT. 
Make two new subdirectories on the disk in drive B:. (The abbreviation MD will 

be used for the make directory command MKDIR.) 

D Type: MD B:" GEMAPPS 
D Press the ENTER key. 
D Type: MD B:" DOCUMENT 
D Press the ENTER Key. 

Copy the contents of one master disk subdirectory to the disk in drive B: 

D Type: COpy A:" GEMAPPS B:" GEMAPPS 
D Press the ENTER key. 

This command will copy WRITE.APP, WRITE.RSC, WRITE.FMT, and WRITE.lNF. 
Copy the contents of the other master disk subdirectory to the disk in drive B:. 

D Type: COpy A:" DOCUMENT B:" DOCUMENT 
D Press the ENTER key. 

This command will copy README.DOC and README.FMT. 
Make an additional subdirectory for a subdirectory. 

D Type: MD B:" DOCUMENT" TUTORIAL 
D Press the ENTER key. 

Copy the contents of the master subdirectory subdirectory to the disk in drive B:. 

D Type: COpy A:" DOCUMENT" TUTORIAL B:" DOCUMENT" TUTORIAL 
D Press the ENTER key. 

This command will copy TUTORl.DOC, TUTOR2.DOC, TUTOR3.DOC, 
TUTORl.FMT, TUTOR2.FMT, TUTOR3.FMT, and GEMLOGO.GEM. 

The backup disk is complete. Remove and label this disk. Place the DRI GEM Write 
master disk in a mayonnaise jar and bury it in your backyard. 

Installing GEM Write 

You are now ready to install GEM Write on the GEM Desktop. To perform this instal
lation, you will need two, blank floppy disks. 

D Start the GEM Desktop. 
D Select the floppy disk B: icon. 
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o Display the File Menu. 
o Choose the Format ... command. The warning dialog appears. 
o Insert a blank floppy disk in drive B:. 
o Click on the "ok" button. (Label this disk "GEM Write Application.") 
o Repeat the above steps for the second blank floppy disk. (Label this disk "GEM 

Write Documents.") 
o Insert the copied GEM Write disk in drive A:. 
o Double-click on the floppy disk A icon. 
o Double-click on the INSTALL.APP icon (Fig. 3-15). 
o A warning dialog appears informing you that this installation requires two for

matted floppy disks, GEM Write Application disk and GEM Write Documents 
disk. 

o An insert dialog appears. Insert GEM Write Application disk in drive B:. 
o An insert dialog appears. Insert GEM Write Documents disk in drive B:. 
o An insert dialog appears. Insert GEM DESKTOP in drive A:. 

Warning! Failure to place the GEM DESKTOP disk in drive A: will result in a com
plete system crash. This error can't be corrected by a normal system reset. You will 
have to tum the computer off for a full 5 minutes and then restart the entire installation 
procedure again. 

o An insert dialog appears. Insert GEM Write Application disk in drive B:. 
o A finish dialog appears. GEM Write is now in the GEMAPPS folder on the 

GEM Write Application disk and a tutorial is on the GEM Write Documents disk. 
o Return to the GEM Desktop. (Optionally, you can go directly into GEM Write 

from this step.) 

The GEM Write Documents disk contains a set of three tutorials that demonstrate 
many of GEM Write's word processing features. The educational nature of these docu
ments makes their retention worthwhile. Therefore, this disk should be used strictly 
as a tutorial disk. All of your "working" documents, letters, and reports that are created 
with GEM Write should be saved on other floppy disks (or, even a hard disk). A good 
practice with this technique is to devote a floppy disk to each unique document form. 

• I~::::::::::::::::::::::::::~~:::~~::::::::::::::::::::~::::::::::::: 9.: \ :::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::~:::::::::::: • 
17280 bytes uspd in 4 itpMs. 

DO 
DOCUMENT GEtfAPPS INSTALL. APP INSTALL. TXT 

I 
+J 

"un""",,, .. ,.,.,,,, I."unl ... III",IIIIIII.,'IIIIIIIrIlIlIIlIlIl,,,"",,.,'II'"1I ,,!'" "".fllI'UUII"."III".,UIt, ... "u, .. " """UUIIIII" tnU,"tI,",,'""1 " "Unlt 1191 I I 

Fig. 3-15. Double-click on the INSTALL.APP icon for installing GEM Write. 
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For example, you might create a GEM Write Letters disk and a GEM Write Reports 
disk. This filing method will simplify your efforts in locating a needed reference. 

Whatever disk labeling method you adopt, there are several specific GEM Write
dictated guidelines that must be followed. 

1. Always allow plenty of free disk space on your GEM Write Documents disk. This 
free space is used for holding "spill" files. A spill file is created when you compose 
a document which is larger than your available system memory. These are temporary 
files that are automatically created, edited, and erased by GEM Write. In terms of free 
disk space, allow one and one-half times the byte count of the current, working 
document. 

Warning! Never change Documents disks during editing, writing, or reading. Tem
porary files, such as spill files, are constantly being written, erased, and updated by 
GEM Write. Inserting a new Documents disk will upset this automatic and invisible 
file management system. Always save your current document before changing disks. 

2. Approximately 75 pages of GEM Write text can be held on a single 360K byte 
floppy disk. 

3. Roughly 30 pages of text can be held in a 256K byte system with accommodations 
for 250 pages in 640K bytes RAM. 

4. When inserting graphics into a GEM Write document, make sure that there is suffi
cient disk space for holding the picture. 

Warning! Never attempt to insert a graphics picture inside another graphics pic
ture. The printed results will be erratic and unpredictable. 

USING GEM WRITE 

To start GEM Write, enter the GEM Desktop and insert the GEM Write Application 
disk into drive A: and your GEM Write Documents disk in drive B:. 

o Double-click on the floppy disk A icon. 
o Double-click on the GEMAPPS folder icon. 
o Double-click on the WRITE.APP icon. The WELCOME TO GEM WRITE! 

dialog appears. (This dialog only appears during the initial starting of GEM 
Write.) 

o Type your name in the name field. 
o Click on the mass storage method used by your system. 
o Click on the "ok" button. 

Following this brief loading exercise, you are greeted by the GEM Write identifi
cation dialog. A click on the "ok" button of this ID dialog takes you to a blank GEM 
Write document window (Fig. 3-16). Th~re are four distinct features on the GEM Write 
document window: the Menu Bar, the Title Bar, the Status Line, and the Cursor. Each 
of these features, plus the others accompanying them (Slider, Scroll Bar, up-arrow, 
down-arrow, Size Box, and Full Box), functions exactly like those found on the GEM 
Desktop. 

Menu Bar 

Running along the top of the GEM Write document window, is a "bar" containing 
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all of the drop-down menus. In tum, each of these menus holds all of the commands 
that can be called during composition with GEM Write. Seven different menus are found 
on the Menu Bar: Desk, File, Edit, Search, Font, Page, and Options. For complete in
formation on each of these menus, refer to the Gem Write Reference section later in 
this chapter. 

Title Bar 

This explanatory line situated underneath the Menu Bar, presents all of the disk 
information that is relevant to the current document. This information includes: the 
drive designation, the Directory Path Name, the Document Name, and the Document 
Type. As a rule, there are two accepted Document Types for dealing with GEM Write: 
.DOC and .FMT. Only the former of these two types is applied by the user. The latter 
type refers to a format file (containing the margin, line spacing, page length, etc.), which 
is automatically saved by GEM Write for recreating the file's visual characteristics 
on both the computer's screen and the selected output device. During operation one 
.FMT file is saved for every file of the same name. For example: 

File Saved 
FORM.LTR 
PRESS.DOC 
JOURNAL.TXT 
PRESS.LTR 
SALES.RPT 

.FMT File Saved 
FORM.FMT 
PRESS.FMT 
JOURNAL.FMT 
PRESS.FMT 
SALES.FMT 

Desk File Edit Search Font Page OPtions 

Fig. 3-16. The opening GEM Write screen. 
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From this example, the format file for PRESS.L TR and PRESS.DOC would be 
identical. Unpredictable results will occur from this double format file conflict. To avoid 
this potentially damaging event, always supply unique Document Names to each GEM 
Write document. 

Status Line 

This information area sitting along the bottom of the GEM write document win
dow continually displays the present location of the cursor. Two values, a page num
ber (in the field Page X), and a line number (in the field Line X), relay the exact cursor 
location. In reading these values, the page number refers to the full, formatted page, 
while the line number indicates the line on that page containing the cursor. The Status 
Line is also used for displaying command messages. 

Cursor 

Unlike other GEM applications, GEM Write makes use of two indicators. The first 
indicator is the standard mouse-controlled GEM pointer. In GEM Write, the pointer 
is used for many of the same functions that receives its attention on the GEM Desk
top. For example, displaying menus, choosing commands, clicking, and dragging. An
other function of the pointer, that is a departure from these GEM standards, is cursor 
placement. Simply place the pointer anywhere within the document and click. The cursor 
immediately jumps to this new location (also the Status Line indicates this change in 
location). 

The other GEM Write indicator is the cursor. The cursor is a flashing line segment 
used for referencing the point for text insertion. Once the pointer has positioned the 
cursor for text entry (or for editing purposes), the pointer disappears whenever text 
is typed from the keyboard. Any movement of the mouse will make the pointer visible 
again, however. 

Highlighting Text 

During the text editing phases of GEM Write, the selected character, word, phrase, 
or section of text must be highlighted. This highlighting procedure is similar to icon 
clicking on the GEM Desktop. Following the identification of the text which is ready 
for editing, the required menu is displayed and the needed command is chosen. 
Methods for Text Highlighting: 

Dragging. Drag the pointer across the selected text. Place the pointer prior to 
the beginning of the dubious text (e.g., character, word, line, phrase, etc.). Now drag 
the pointer (horizontally, vertically, or both) over the erroneous passage. Release the 
mouse button and execute the desired editing command. 

Tip: You can drag in both a horizontal and a vertical line of travel. The vertical 
drag allows you to highlight several lines, sentences, and paragraphs at the same time. 

Column Clicking. Place the pointer in the far left, blank column of the line for 
highlighting. Click the mouse button for selecting that line. Other lines can be simul
taneously highlighted by dragging the pointer down along this column. 

Shift-Clicking. Place the cursor at the beginning of the text that is ready for high
lighting. Now, shift-click. All of the text from the cursor location to the end of the docu-
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ment is highlighted. 
If you only want to highlight a portion of the remainder of the document's text, 

perform the above shift-click technique. Then move the cursor to the end of the text 
that you want to highlight (use either the scroll method or the Go To ... command). 
Now, shift-click. This second method highlights a defined portion of text that lies be
tween the two shift-clicks. 

Function Keys. Two function keys, F5 and F6, perform the same actions as the 
previously described double shift-click method. The F5 key is used to indicate the ini
tial shift-click. The F6 key is equivalent to the second constraining shift-click. Similar 
to the shift-click method, the cursor placement is vital to the proper execution of the 
function key highlighting. 

There will be times when you accidentally highlight the wrong textual passage. 
In this case, there are several ways that you can "de-highlight" the selected portion 
of text. The simplest way to remove a text highlighting is to click the mouse button. 
This click can occur anywhere in the document. Pressing the FlO function key will 
also de-highlight text. Finally, if you change your mind in mid-drag, you can just re
verse your flow and drag the pointer to the line above the beginning of the drag. Now, 
release the mouse button and GEM Write will not highlight the text. 

GEM Write Keystrokes 

A unique characteristic of GEM Write, which separates it from GEM Paint, is that 
the keyboard, instead of the mouse, serves as the primary input device. Obviously, 
writing is a text-oriented process and the keyboard is the ideal interface for generating 
this product. There are times, however, when the preferred GEM interface, the mouse, 
must be used. Examples of this mouse activity include: cursor placement, editing, and 
command selection. Unfortunately, each time you remove one of your hands from the 
keyboard to use the mouse you suffer a typing lapse. Some typists even find that this 
lapse can lead to a disconcerting loss in continuity. GEM Write's solution to this predica
ment is to include a set of keyboard equivalents for certain mouse activities. 

Table 3-1 contains all of the mouse activities that have equivalent GEM Write key
board representatives. When using this table, the notation that links two keys together 
( + ) is defined as pressing and holding the first key, followed by pressing the second 
key. Furthermore, the notation that indicates that two keys are pressed in succession 
(,) means that two individual keystrokes (the first key followed by the second key) are 
needed for executing the specified action. 

Note: The keyboard arrow keys can direct the movement of either the cursor or 
the pointer. Press the Ctrl key to toggle the function of the arrow keys back and forth 
between cursor direction control and pointer movement. 

Special GEM Write Features 

When you are typing with GEM Write, the RETURN key is pressed only at the 
conclusion of each paragraph (or fixed line, e.g., titles, subheads, and addresses). This 
is called a hard return. In the case of paragraphs, GEM Write compensates for this 
continuous string of text with a process known as word wrap. Word wrap conveniently 
breaks each line of text at a space or hyphen adhering to your formatting commands. 
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Table 3-1. A Listing of Mouse Activities 
and Their GEM Write Keyboard Equivalents. 

ACTION 

Backspace 
Center, line 
Copy, text 
Delete 

, from cursor to line's end 
, line 
, text 

Find, next occurence 
Font, bold 

, italic 
, u,nderline 

Format .. . 
Go to .. . 
Insert, line 

, mode 
, text 

Line, beginning 
, beginning 
, end 
, end 

Margin, set 
Move, text 
New 
Page, 1, line 1 

, 1, line 1 
, closest previous top 
, last, last line 
, last. last line 
, top of next 

Print Draft 
Reformat, paragraph 
Replace, next occurrence 
Save 
Screen, bottom, same column 

, down one 
, lower left corner 
, top, same column 
, up one 
, upper left 

Short Cuts ... 
Space, forced 
STOP ... 
Symbols, show/hide 
Tab, 

, set 
Word, delete 

, next 
, previous 

KEYSTROKE(s) 

Backspace 
Alt+F9 
Alt+F6 
Delete 
Alt+F4 
Ctrl + F4 
Alt+F8 
F7 
Shift + F7 
Shift + F10 
Shift+F9 
Ctrl +F1 
Ctrl+F7 
Alt+F3 
Insert 
Alt+F2 
Home, Left-arrow 
F3 
F3 
Home, Right-arrow 
F9 
Alt+FS 
Alt + F10 
Ctrl+Home 
Home, Home, Home 
Ctrl+PgUp 
Ctrl+End 
Home, End 
Ctrl+PgDn 
Alt+ F1 
F8 
Alt+F7 
F2 
Home, Down-arrow 
Home, PgDn 
End 
Home, Up-arrow 
Home, PgUp 
Home, Home 
F1 
Ctrl+Z 
F10 
Ctrl+ F3 
Tab 
F9 
F4 
Ctrl + Right-arrow 
Ctrl + Left-arrow 

In other words, all of the text will be automatically aligned with both the left and right 
margins and no words will be cut off at the end of a line. 

Every time you press the RETURN key at the end of a paragraph or other fixed 
line, a proofreader's paragraph symbol appears (9f). In addition to indicating the pres
ence of hard returns, the paragraph symbol also prevents the highlighting of text. There
fore, the keyboard command Ctrl + F3 (see above) is used for hiding these symbols 
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during editing and text highlighting. After these symbols have been hidden, pressing 
Ctrl + F3, again, causes them to reappear on the screen. 

Tip: If you do a lot of text editing, and that is one of GEM Write's strong points, 
then you should leave the paragraph symbols permanently hidden. Two hard returns 
at the end of each paragraph will serve as an alternate marking method. 

There may be times when you will want a phrase to stay together. For example, 
the pronouncement "You're fired!" loses much of its impact if the two words are writ
ten on separate lines. In this case, a/orced space should be placed between the contrac
tion "You're" and the word "fired!." A forced space fixes words and phrases together 
so that they can't be separated by formatting and automatic word wrap. To make a 
forced space, type Ctrl + Z, instead of pressing the spacebar, between each word of 
the phrase. 

Altering the right margin will also prevent words and phrases from being sepa
rated. Up to 250 characters can be carried on one line of GEM Write by adjusting the 
left and right margins. Most computer monitors lack the resolution for displaying this 
wide of a manuscript, however. Therefore, GEM Write can horizontally scroll in ten
character jumps with the arrow keys. Alternatively, the F3 function key (see above) 
can be used for quickly jumping to the beginning or the end of any given line. 

Two final GEM Write features concern file management. Any document that car
ries the .DOC type can be used for quickly loading and starting GEM Write. Just double
click on any icon with a .DOC type and GEM Write will be loaded and the selected 
document will be opened. The selected .DOC type file can be on any disk drive (hard 
or floppy, A: or B:) and any floppy disk (GEM Write Application disk or GEM Write 
Documents disk). This technique can eliminate several steps when leaving the GEM 
Desktop to enter GEM Write. 

GEM Write also has the facilities for importing other files, documents, and graphics. 
Other than graphics, a file created by any word processing program can be used by 
GEM Write. The only provision that GEM Write exercises over these outside word 
processed files is that they must be written in a standard ASCII format. 

In dealing with outside graphics, GEM Write can only use pictures that have a .GEM 
type. This restriction includes pictures that have been produced by GEM Draw and 
GEM Paint (GEM Graph pictures must be converted from their .GRF type to a .GEM 
type before use with GEM Write). 

GEM WRITE REFERENCE 

Each of GEM Write's menus contains several different commands that can be accessed 
either with the mouse or by typing a special command keystroke. The following sec
tion describes all of GEM Write's menus and the function of their individual commands. 
In applicable cases, the keystrokes necessary· for choosing the command are also 
provided. 

Desk Menu (Fig. 3-17) 

GEM Write Info ... displays a dialog containing author and copyright informa
tion. A point of interest with this dialog is that the Licensed to field contains the name 
that you supplied in the WELCOME TO GEM WRITE! dialog during the initial 
starting of GEM Write. 
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Fig. 3-17. The GEM Write Desk Menu. 

Calculator displays a full function desktop calculator. Refer to Chapter 1 for com
plete operation information. 

Clock displays a real-time clock and calendar. Refer to Chapter 1 for complete 
operation information. 

Print Spooler displays a list of GEM documents waiting for output. Refer to Chap
ter 1 for complete operation information. 

Snapshot. This desk accessory is available only from the previous installation 
of GEM Paint. Refer to the GEM PAINT REFERENCE section earlier in this chapter. 

File Menu (Fig. 3-18) 

New creates a new, blank document named "UNTITLED.DOC." 

o Press: A1t+FIO 

Open ... displays an ITEM SELECTOR dialog for selecting a document which 
will be read from the specified disk into GEM Write. Manipulation of this dialog fol
lows the conventions discussed previously in this book. 

Insert Text ... reads a document from disk into the current document at the 
specified cursor location. 

o Press: Alt + F2 
o Place the cursor at the desired insertion point. 
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o Display the File Menu. 
o Choose the Insert Text ... command. The ITEM SELECTOR dialog appears. 
o Double-click on the document that is going to be inserted. 

This selected document is then read into the current document at the cursor's lo
cation. All of the text following the cursor is automatically moved "down" to make 
room for this new text. There is no limit as to the number of times that any given docu
ment c~n be inserted into another document. 

Insert Graphics ... reads a .GEM type picture into the current document at 
the specified cursor position. 

o Place the cursor at the desired insertion point. 
o Display the File Menu. 
o Choose the Insert Graphics ... command. The ITEM SELECTOR dialog 

appears. 
o Double-click on the picture that is going to be inserted. 

This selected picture is then read into the current document at the cursor's pres
ent location. All of the text following the cursor is automatically moved "down" to make 

. room for this graphics image. The selected .GEM type picture can be used more than 
once and in as many different documents as is needed. 

Two other GEM Write commands play an important role in the successful inser-

Desk ~ Edit Search Font Page Options 
gili§j~~;;j~~~~Jj;j New • F10 B: 'UNTITLED, DOC jmmjjjjmjj~~jjjjmjjj?'jjjjmmjilljjjmjj~~jilijj@jjj[[?'j~~j[mj[[~f:~m~m~m~m~;j~ • 

open... ..i. 
_ Insert Text... • F2 

Insert GrapniCS ... 

Save F2 
Save AS ... 
Abandon 

Print Draft • F1 
To Output 
QUit 

Pa~e 1 Line 1 

I 
I 
i 
I 

~ 
- - - ~ - - -- - - -- - - ---- --- -_. - - -- _. - - .. . - --- _ .. _. " - - -

Fig. 3-18. The GEM Write File Menu. 

98 



tion of graphics into a document. The current status of the Turn Graphics On/Off 
command will determine whether or not the inserted graphics is visible on the screen. 
If this command is Off, then GEM Write inserts a special "double-dot" command (see 
the ADVANCED TECHNIQUES section later in this chapter) at the picture's in
sertion point. 

The other GEM Write command that can affect an inserted graphics picture is For
mat •.. (from the Page Menu). Several different elements are influenced through 
this command. Both the Pagination and Page Length field will determine the final suc
cess or failure of a graphics insertion. As a rule of thumb, if the graphics picture runs 
over a page break (which is set by the page length and made visible through pagina
tion), then unpredictable and incorrect results will occur during output. 

Removing an Inserted Graphics Picture. There may be times when you have 
accidentally inserted a picture that runs over a page break. To remove this picture: 

o Tum graphics Off with the Turn Graphics On/Off command. 
o Highlight the double-dot command line and all of its associated spacing lines. 
o Erase the picture with the Delete command. 

Tip: You can also move and copy this highlighted picture, just like a block of text, 
with the Move and Copy commands, respectively. 

Save saves the current document on the current disk under its same name. This 
command is also called "updating." 

o Press: F2 

Tip: Use this command frequently during your writing process. This practice en
sures that your disk contains a reasonably up-to-date copy of your document. Then, 
in the event of a power failure, you won't have to spend all day recreating what you 
have already typed. 

Save As ... saves the current document on the current disk under the specified 
name. This command can also be used for saving a highlighted portion of a document. 
This command is also known as "backing up." 

o Highlight the text portion of the document. 
o Display the File Menu. 
o Choose the Save As ••• command. The ITEM SELECTOR dialog appears. 
o Type a new name for this document portion. 
o Click on the "ok" button. 

Abandon erases the current document and reads the same document from a disk. 
This command is similar to "starting over." For example, if you have been editing 
a document and you dislike the changes that you have made, the Abandon command 
will remove this edited copy from the screen and replace it with the original document. 

Print Draft quickly prints a document from the current cursor location to the 
end of the file. Only a draft printer mode is used for this output, therefore, no text 
characteristics, fonts, or graphics are printed. Because of the elimination of these fea-
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tures, this output is ideal for virtually any printer. This command is exclusive of GEM's 
OUTPUT. 

o Press: Alt+FI 

To Output transfers·control of GEM Write to GEM OUTPUT. Under OUTPUT's 
direction the current document is placed in an output list ready for production on the 
selected output device. This command is used for making final, presentation copies 
of documents. Refer to Chapter 1 for complete OUTPUT operation information. 

Quit exits GEM Write and returns you to the GEM Desktop. 

Edit Menu (Fig. 3-19) 

Many of the commands in this menu are unavailable unless a piece of text has been 
highlighted. These unavailable commands are indicated by light, dimmed command 
names. Once a portion of text has been highlighted these commands are active and 
represented by dark, bold names. 

Insert Line inserts a blank line at the cursor's location. All text following the 
position of this blank line insertion point will be automatically moved down. 

o Press: Alt + F3 

Center Line centers a line of text, from the left margin to the right margin, at 
the cursor's location. 

Desk File 

-
Delete • Fe 

Fig. 3-19. The GEM Write Edit Menu. 
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D Press: Alt+F9 

Delete Line deletes a line at the cursor's location. This deletion command does 
not require the highlighting of the line prior to execution. 

D Press: Ctrl+F4 

Move moves a highlighted portion of text from one location to another location 
anywhere within the current document. All of the text following the move's destina
tion is automatically moved down. During a move the pointer changes its shape to that 
of a large "I." 

D Press: Alt + F5 
o Highlight the text for moving. 
D Display the Edit Menu. 
D Choose the Move command. The pointer changes into an "I." 
o Place the pointer at the move's destination. 
o Click the mouse button. 

Copy duplicates a highlighted portion of text from one location to another loca
tion anywhere within the current document. All of the text following the duplicate's 
insertion point is automatically moved down. Both the pointer shape change and the 
procedure for using this command are similar to those same features found in the Move 
command. 

D Press: Alt+F6 

Delete permanently erases a highlighted portion of text from the current document. 

o Press: Alt + F8 

Search Menu (Fig. 3-20) 

Two of the commands in this menu are unavailable unless one of the other com
mands in this menu is in current use. These unavailable commands are indicated by 
light, dimmed command names. Once a required command is in operation these com
mands are active and represented by dark, bold names. 

Find ... locates every occurrence of a character string within the current docu
ment. A maximum string length of 40 characters is permitted in this field. 

o Display the Search Menu. 
o Choose the Find ... command. The Find dialog appears. 
o Type the search string in· the Find field. Any alphanumeric keyboard charac-

ters may be used in this search string. ' 
D Click on the "ok" button. 

The Find ... command searches for the string exactly as it is typed in the Find 
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Fig. 3-20. The GEM Write Search Menu. 

field. In other words, upper- and lowercase letters, spacing, and punctuation are all 
relevant in the identification of the search string. Additionally, Find ... examines 
the entire document, no matter where the search is instigated. For example, if you start 
the search near the end of your document, the Find ... command will first examine 
the end of the document followed by a search from the document's beginning to the 
current cursor location. 

Replace ... locates and substitutes the specified string for the search string. The 
substitution string is specified in the "Replace With" field of the Replace ... com
mand dialog. An optional field in this dialog also enables you to select the automatic 
replacement of e'very occurrence of the search string with the specified string. This 
automatic replacement is called "global substitution." A maximum string length of 40 
characters is permitted in both fields. Other than these field differences, the execution 
of the Replace . . . command is exactly like that of the Find . . . command. 

Find Next locates the next occurrence of the search string. This is a continuation 
command that is activated by using either the Find . . . command or the Replace 
•.. command. 

o Press: F7 

Replace Next locates and substitutes the specified.string for the search string. 
This continuation command is only activated by using the Replace ... command. 

o Press: Alt + F7 
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Go To ..• jumps to the specified page and line number. This command displays 
a dialog for entering the exact page and line number where you want to move the cursor. 

o Press: Ctrl + F7 

Font Menu (Fig. 3-21) 

Normal displays all typed text in the standard system font. This command also 
cancels the actions produced by the other Font Menu commands. 

Tip: The effects of the Normal command can be duplicated by erasing all type 
style symbols from the margins of a document. 

Bold displays all typed or highlighted text in a bold type style. This command re
mains in effect until it is canceled, reaches a hard return, or completes the conversion 
of a highlighted portion of text. 

o Press: Shift+F7 

Italic displays all typed or highlighted text in italics. This command remains in 
effect until it is canceled, reaches a hard return, or completes the conversion of a high
lighted portion of text. 

o Press: Shift+FIO 

Desk File Edit Search 

-
Page OPtions 

Normal 
BOld 
Italic 
Underline 

+ f7 
+ f10 
t F9 

Fig. 3-21. The GEM Write Font Menu. 
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Desk File Edit Searoh Font Options 
Turn Graphics On/Off 
Turn Auto - Reformat On/Off 

- Turn I nsert Mode On/Off 

Fig. 3-22. The GEM Write Page Menu. 

snow RUler/Hide RUler 
Set TabS & Margins ... 

Format... .....F1 

Underline displays all typed or highlighted text with underlining. This command 
remains in effect until it is canceled, reaches a hard return, or completes the conver
sion of a highlighted portion of text. 

o Press: Shift - F9 

Page Menu (Fig. 3-22) 

Turn Graphics On/Off selectively displays or hides any graphics pictures that 
have been imported into the current GEM Write document. When the Turn Graphics 
On/Off command is Off, a double-dot command ( .. GEM) is displayed at the point 
of the graphics picture insertion. Furthermore, blank lines are used to occupy the same 
space that will be filled by the picture after the Turn Graphics On/Off command is on. 

Turn Auto-Reformat On/Off selectively reformats all edited text automatically. 
When the Turn Auto-Reformat On/Off command is Off, edited text will be left 
in an unformatted condition until you specifically reformat the passage with the F8 
function key. 

Turn Insert Mode On/Off selectively activates the character insertion mode. 
The default condition for this command is Off. In this mode, when a character is typed 
it replaces any character underneath it. When the Turn Insert Mode On/Off com
mand is On, typed characters push all of the current characters to the right and down. 
The cursor changes to a vertical line when this command is On. 

o Press: Insert key 
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Show Ruler/Hide Ruler selectively displays or removes a ruler along the top 
margin of the current document. This ruler is used for displaying the inch width of 
the document's page, the current left and right margin settings, and the current tab 
positions. Tenths of an inch gradations are used on this ruler. The ">" represents 
the left margin and the "<" is used for the right margin. Black diamonds are used 
for indicating the current tab positions. 

The pointer changes its shape into a hand when crossing over the ruler. This hand 
pointer is used for changing the tab and margin positions. By placing the hand in the 
desired column and clicking the mouse button, a new tab position can be set. By the 
same token, tabs can be removed by clicking in an occupied column. Conversely, the 
margin settings are changed by dragging their respective markers to the desired column. 

Set Tabs & Margins ... alters tab and margin positions. This command is used 
when the ruler has been hidden. By using this command, the ruler is temporarily placed 
along the top margin of the current document and the pointer is changed into a hand 
shape. Also, the TABS & MARGINS dialog appears. This dialog outlines the proce
dure for changing tab and margin settings. After the tabs and margins have been 
changed (by using the same clicking and dragging techniques discussed under the Show 
Ruler/Hide Ruler command), a click on the "ok" button of the dialog saves these 
new settings. 

D Press: F9 

Tip: This command can also be used selectively for reformatting single paragraphs. 
In this case, choose the Set Tabs & Margins ... command. Make all of your tab 
and margin adjustments. Now use the reformat keystroke (F8) only on the paragraphs 
(or other text passages delimited by hard returns) that require adjustment. By using 
this method, several different text formats can be included in the same document. 

Format ... controls the final printed output's characteristics. The PAGE FOR
MAT FOR OUTPUT dialog appears for determining these output parameters. 

D Press: Ctr1+Fl 

There are eight fields in the PAGE FORMAT FOR OUTPUT dialog (Fig. 3-23): 
Document mode, Pagination, Justification, Line spacing, Page length, Text begins on, 
Text ends on, and Left margin. 

Included below is a description of the Format ... command's fields: 
Document mode. There are two choices in this field: On and Off. Straight AS

CII text is produced when the "Off" choice is selected. This text is devoid of all Font 
Menu commands, reformatting commands, and hard returns. Use this "Off" selec
tion whenever you are working with non-GEM Write documents. The "On" selection 
generates GEM Write text. 

Pagination. There are two choices in this field: On and Off. The "On" selec
tion displays the correct page breaks for the final printed output on the GEM Write 
screen. The "Off" choice removes all page breaks from the displayed document. 

Justification. There are two choices in this field: On and Off. "On," activates 
text justification (in other words, flush left and right margins). Justification is inacti
vated by the "Off" choice. 
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PAGE FORMAT FOR OUTPUT 

Document mode: I On I I Off I 
paginatiC,n: lonl I Off I 

Ju;tification: Ion I I Off I 
Lin~ spacing: [}] [[J @] 

Page length: 
Text begins on: 

endS on: 
Left margin = 

Fig. 3-23. The Format ... command sets up the printed format of a GEM Write document. 

Line Spacing. There are three choices in this field: 1, 2, and 3. Each of these 
values refers to the type of spacing that will be used in the text-single, double, or 
triple spacing. 

Page length. Type the value for the number of lines which equals the length of 
your selected output device's page. 

Text begins on. Type the value for the starting point of first printed line of text 
on each output page. 

Text ends on. Type the value for the ending point for the last printed line of 
text on each output page. 

Left margin. Type the character value for setting the left margin on the output 
page. This value is added to the left margin that is set on the document's ruler. 

Options Menu (Fig. 3-24) 

Short Cuts ... displays the SHORTCUTS help dialog. This dialog is a brief list
ing of the keystroke equivalents used by GEM Write. 

o Press: Fl 

Set Preferences ... displays the SET PREFERENCES dialog. This dialog con
trols several of GEM Write's standard command default settings. Each of these set
tings can be overridden by their respective menu-driven command. There are six fields 
in this command: Turn Graphics, Turn Auto-Reformat, Create * .BAK files, Delete 
* .OUT files, Document Disk, and Spill-file Disk. 
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Listed below is a description of the Set Preferences ... command fields: 
Turn Graphics. There are two choices in this field: On and Off. This field de

termines whether or not graphics pictures are initially displayed in the current document. 
Turn Auto-Reformat. There are two choices in this field: On and Off. The 

selection in this field determines whether or not text is automatically reformatted fol
lowing each edit. 

Create * .BAK files. There are two choices in this field: On and Off. The "On" 
choice makes automatic backup files (named with the .BAK type) of each document 
that is saved. These .BAK type files can be thought of as insurance should the original 
.DOC type file become unusable. An "Off" selection does not make these automatic 
backup files. 

Caution! Using this field and creating .BAK type files will consume extra disk stor
age space. 

Delete * .OUT files. There are two choices in this field: On and Off. When the 
"On" selection is used, GEM Write will automatically erase each output list following 
completion of the To Output ... command. By using the "off" selection, each of 
these output lists are saved on the specified disk drive. 

Document Disk. Type a letter disk drive designation which specifies the loca
tion of the GEM Write Documents disk. 

Spill-file Disk. Type a letter disk drive designation which specifies the location 
of the spill-file disk. The letter "X" can be entered into this field for requesting the 
omission of spill-file usage. . 

Desk File Edit Searoh Font Page 'JI1"{IIIJ.~ 
~§'E~~f.~~E~~~~~~~m~~~~~~~~;;~~;~g~~;~~~[~~~~~;.~~~;~~mmm~f:~~ B: \U NT I T l S h 0 rt Cuts ... 

Set Preferences ... -

Page 1 Line 1 
tr 

._~ - _..- __ • ~ ___ .. _ ••• __ .. ____ 0 __ • __ ~ ___ • _________ • ____ .... _. ____ ~ _____ ... ___ ...... ____ ~--... __ _ 

Fig. 3-24. The GEM Write Options Menu. 
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Desk File Edit Search Font Page Options 
f:f:l~~lf:~~jl~il~?1111~~if:lmili~?jf:f:lll~~~mf:;mi?~?;m;~~E~iilimf:~;l~iliili;~~~i;ifu;if: B:' FU T U R ES f:~~;ilijjilf:~~;~i?~f:i~~~;im?;;iE~gm;;Wj~;;~;,?mi;f:?;?ii;iif:~?~~Eii;?;f:?;;~~;ilif:;~ • 
o ~ ? 

28 APR 1987 

~e~t~~~~n Powers ~ 
Futures Marketing, Ino. 
8088 Intel Wa~ 
Carborundu~ Clty, CA 90706 

Dear Mary, 
l recently stu~bled across a piece of software that is bound to 
enhanc~ your productivity. This bit of prOgraMMing wizardry is called 
GEM Desktop and it's developed by DRI in Monterey, CA. You won't 
believe the diversit oP 0 erations that this DOS shell is able to 

Fig. 3-25. Double-dot commands control the printing of GEM Write document characteristics. 

ADVANCED TECHNIQUES 

GEM Write's double-dot commands control several special printing effects that add 
the final professional touch to your document. The usage of these commands differs 
from all of your previous experiences with GEM applications. There are no menus to 
drop down and no commands to choose. A GEM Write double-dot command is typed 
into the text (Fig. 3-25). Another name for this type of textually inserted command 
is an embedded command. There are four simple rules that govern the use of these 
double-dot commands: 

1. All double-dot commands must be preceded by two periods ( .. ). 
2. These two periods or dots must fall in columns one and two of the command line. 
3. Double-dot commands are isolated on their own line. This line remains invisible 

to GEM Write's Status Line, pagination, and page length. 
4. Either upper- or lowercase letters may be used in a double-dot command. But your 

character case must remain consistent throughout the command (e.g., .. page-good 
example; .. PaGe-bad example). 

GEM Write Double-dot Commands 

There are eight different double-dot commands. Several of these commands re
quire parameters that must be typed immediately after the command. These parameters 
are inserted exclusive of spaces. 

00 A comment or remark line which is only displayed on the computer's monitor. 
This comment is not sent to the output device. The comment's length is limited to docu-
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ment's margin settings. Any characters can be placed in this comment. 
Caution! Do not begin a comment with any of the other double-dot command words. 
Example of a correct comment line: .. this memo is a rough draft 
.. page forces a page break at this location. This action will cause the printer to 

execute a form feed at this point . 
. . head prints a header on every page following its location. Three parameters are 

applied to this command: line number, position description, and header text . 
.. headLPT 

L = line number-the two-digit line where the header is to be printed. 
P = position description-indicates how the text should be printed in the header. 

L displays text flush left 
R displays text flush right 
C displays text centered 
A displays text alternating flush left and flush right 

T = text-the text that is to be printed in the header. 
Example: .. head03LChapter 3 - GEM COLLECTION 

This example would place the header "Chapter 3 - GEM COLLECTION" flush left 
on line three of every page following this command. 

Any number of different headers can be used throughout the document. Addition
ally, these headers can fill several lines on each page. If a header with the same line 
number is used later in the document, then the new header replaces the older one that 
shared the same line number. This is the same stunt that is used for canceling a header. 

Example: .. head03 
This command would cancel the previous header example . 

. . foot prints a footer on every page following its location. This command is best 
suited to placing page numbers on each page of text. Three parameters are applied 
to this command: line number, position description, and footer text . 

.. footLPT 
L = line number-the two-digit line where the footer is to be printed. 
P = position description-indicates how the text should be printed in the footer. 

L displays text flush left 
R displays text flush right 
C displays text centered 
A displays text alternating flush left and flush right 

T = text-the text which is to be printed in the footer. 
Example: . .foot54CPage 3-## -MORE-

This example would place the footer "Page 3-X -MORE-" centered on line 54 of every 
page following this command. The double number symbols (##) are used by GEM Write 
to indicate the insertion of the current page number. Therefore, if the printing was 
on page 43, the footer would read "Page 3-43 -MORE-." 

Any number of different footers can be used throughout the document. Addition
ally, these footers can fill several lines on each page. If a footer with the same line 
number is used later in the document, then the new footer replaces the older one that 
shared the same line number. This technique is used for canceling a footer. 

Example: . .foot 54 
This command would cancel the previous footer example. 
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.. pgno resets the printed page number to the specified number. 
Example: .. pgno44 

This example would reset the page number to page 44. 
This double-dot command can also be used with the footer command for placing 

a page number on the first page of any manuscript. In order for this action to be prop
erly executed, the following two command lines must appear at the top of the first page. 

Example: .. pgnol 
.. foot63Cpage## 

These two commands would print "page I" centered on the 63rd line of the first page . 
. . end stops all printing . 
.. cmd sends a special command sequence directly to the printer. This command 

is useful for transmitting special effects printer ASCII character codes to the selected 
output device. These codes must be typed with their exact keystroke representations, 
however. 

Example: .. cmd < SI 
This example activates the superscript printing mode on an Epson FX dot matrix printer. 
In this case, the" <" symbol is created by pressing the ESCAPE key. Remember, 
don't place unnecessary spaces in these character code sequences . 

.. gem labels a .GEM type graphics picture. Two parameters are used by this com
mand: line number and graphics location . 

.. gem,L,G 
L = line number-the number of document lines used by the graphics picture. 
G = graphics location-the exact drive, directory, and file name location of the graphics 
picture. 
_ Example: .. gem,13,B:" IMAGES" SALES.GEM 
This example shows that 13 document lines are used by the .GEM type picture named 
SALES which can be found on the B: drive in the IMAGES subdirectory. 

Finally, for those of you who can't wait to compare the strengths and weaknesses 
of GEM Write versus WordStar, Table 3-2 provides a complete command compari
son. In addition to providing some concrete facts for direct competition between these 
two word processing programs, this table also serves as a "translation dictionary" for 
those WordStar users who've sought the quiet power of GEM Write. 
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Table 3-2. A Comparative Analysis of the WordStar 3.31 Command 
Structure and the Similar Command Counterparts Found in GEM Write 1.01. 

Comrnand 

Move Cursor 
Right one character 
Left one character 
Up one line 
Down one line 
Right one word 
Left one word 
Top of file 
End of f i l~? 

Scroll (Move Screen) 
Up one line 
Down one 1 i m? 
Up one ~;C:l' een 
Down CJr18 scr'een 

Forrnat 
Center text 
Re-forrn paragraph 
Display Print menu 

Delete and Insert 
De 1 ete character' 
Delete character left 
Delete word right 
Delete line 
Delete to end of line 
Delf::!te a block 
I nsel"t. On/Off 
Insert blank line 

Find ":Ind f~E)P 1 ~Ic:e 
Find text 
Find dnd repldce text 
Find t€::!X t i:~':3c:.d n 
Replace text again 

SCI.ve F i I E)S 

Save and resume edit 

WordStar 3.31 

""1) 

·····S 
""E 
·····X 
·····F 
·····A 
·····Clr~ 
..... Q(: 

·····c: 

·····oe 
..... 1:: 
..... p 

·····G 

Del 
·····-r 
·····Y 
·····OY 
·····.:::Y 
... ··v 
·····N 

·····OF 
... ··0(1 
..... L. 

·····L 

·····KS 

Save and return to menu AKD 
Abandon file w/o saving AKQ 

File and Block Operations 
Mark/unmark block beginning AKB 
Mark/unmark block end AKK 
Copy block AKC 
Delete block AKY 
Move bl~ck AKV 
Write block into another file AKW 
Read file into document 

Design the Printed Page 
Boldface 
Underline 
Ital ic 

Dot Comrnands 
Comment 
Footing 
Heading 
New page 
Page nLHober 

·····KR 

"''PE: 
"'PS 
""PQ 

.16 

.fo 

.he 

.pa 

.pn 

GEM Write 1.0 

Right Arrow 
Left Arrow 
Up Arrow 
Down At'rolo'J 
·····F: i ght Ar'row 
·····L(?ft Arrolo'J 
·····Horn~'? 

····-End 

·····F 
·····X 
Hc)mf:~+P<;JUp 

Home+PgDn 

Alt+F9 
Fe 
····F 1 

Del 
Backspace 
F4 
·····F4 
?ilt+F4 
Alt+F8 
Ins 
Al t+F:~~ 

F7 
Alt+F7 
F7 
Alt·t-F7 

F2 
F2'I-Al t+Fl0 
Alt+Fl0 

F~i 

F6 
Alt+F6 
Alt+F8 
Alt+F5 
F2 
Alt+F2 

Shift+F7 
Shift+F8 
Shift+F10 

•• foot 
.• hf::!ad 
.• page 
•• P<3 no 
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Chapter 4 

GEM Draw 

Computer graphics have traditionally been bit-mapped images. GEM Paint pictures, for 
example, are bit-mapped graphics. By definition, these images are composed of in
dividual screen pixels whose position and color characteristics are stored as bits of in
formation. Therefore, everything that you see on a bit-mapped program's screen is 
composed of these singular pixels. Even GEM Paint's various tools and patterns are 
nothing more than pre-defined, bit-mapped shapes. Unfortunately, all is not bliss in 
the bit-mapped world. 

There are three major strikes against graphics software that follows the bit-mapped 
tradition. First, no two bit storage methods are the same. This foul point melds into 
the second slap against this graphics method, namely, the inability to import images. 
Finally, the last empty swing by bit-mapped programming concerns the enormous con
sumption of storage memory. What all of this means is that, for the most part, bit
mapped graphics are unique to the program that created them. As a result, this sin
gularity can lead to some serious limitations in an environment like GEM. 

One graphics program that presents pictures in an entirely different framework 
is GEM Draw. All of the negative aspects cited for the bit-mapped graphics crowd be
come strengths with GEM Draw. GEM Draw pictures are portable; they can be used 
in every other GEM application. GEM Draw pictures are compact; they consume less 
disk storage space than an equivalent bit-mapped image. GEM Draw pictures are not 
bit-mapped; they are composed of picture elements. All of these strong points center 
around GEM Draw's different solution to the graphics creation game. 

Instead of using individual pixels for picture illustration, GEM Draw uses picture 
elements. In this case, an element is a unique user-defined screen characteristics. For 
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example, a circle placed on the GEM Draw Drawing Surface is an element. So is a 
square that is placed inside the circle. Therefore, in GEM Draw, this picture of a square 
within a circle is actually composed of two separate elements. Whereas, the same pic
ture in GEM Paint would be composed of hundreds of individual pixels. Likewise, the 
disk storage of the GEM Draw picture requires only elementary information (very 
punny), while the GEM Paint disk space is packed with a bit map of the picture. By 
using picture elements, GEM Draw is also able to read and write other GEM applica
tion pictures, like those of GEM Graph (see the Advanced Techniques section at the 
end of this chapter). 

This power doesn't alter a commonly shared misconception about GEM Draw. Ba
sically, the unjust rap against GEM Draw is that its picture production is limited to 
geometric shapes. This belief stems from the exclusive use of picture elements and 
the omission of a microscope-like tool. Counteracting this claim, however, is one of 
GEM Draw's more versatile elements-the Sketch element. Sketch is a freehand 
drawing element, which gives the design the flexibility of GEM Paint within the sophisti
cation of GEM Draw. 

INSTALLING GEM DRAW 

GEM Draw is shipped on two floppy disks. The main GEM Draw application master 
disk is identified as disk 1 of 2, while the main Picture Library master disk is disk 2 
of 2. Before you go any further, you should make a backup copy of these two floppy 
disks. Later, you will use these backup copies for your GEM Draw installation. 

Backing Up GEM Draw 

o Place your DOS disk in drive A:. 

Format a floppy disk. 

o Type: FORMAT 
o Press the ENTER key. 

Follow the formatting instructions. (Remember to remove your DOS disk from A: 
before you begin.) 

Repeat this procedure for another floppy disk. 

o Insert the GEM Draw master disk in drive A:. 
o Insert one of your newly formatted disks in drive B:. 

Make two new subdirectories on the disk in drive B:. (The abbreviation MD will 
be used for the make directory command MKDIR.) 

o Type: MD B:" GEMAPPS 
o Press the ENTER key. 
o Type: MD B:" PICTLlB1 
o Press the ENTER key. 
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Copy the contents of one master disk subdirectory to the disk in drive B:. 

o Type: COPY A:' GEMAPPS B:' GEMAPPS 
o Press the ENTER key. 

This command will copy DRAW.APP and DRAW. RSC. 
Copy the contents of the other master disk subdirectory to the disk in drive B:. 

o Type: COPY A:'PICTLlB1 B:'PICTLlB1 
o Press the ENTER key. 

This command will copy BRITAIN.GEM, BULLETIN. GEM , CALIF.GEM, CITY
HALL.GEM, EUROPE.GEM, FIRSTAID.GEM, FRTREES.GEM, FRUIT.GEM, 
H20FACET.GEM, JAPAN.GEM, KIDBUS.GEM, and KIDCHOIR.GEM. 

o Insert the Picture Library master disk in drive A:. 
o Insert the other newly formatted disk in drive B:. 

Make two new subdirectories on the disk in drive B:. 

o Type: MD B:' PICTLlB2 
o Press the ENTER key. 
o Type: MD B:'PICTLlB3 
o Press the ENTER key. 

Copy the contents of one master disk subdirectory to the disk in drive B:. 

o Type: COpy A:' PICTLlB2 B:' PICTLlB3 
o Press the ENTER key. 

This command will copy AUTOS.GEM, BANK.GEM, BIGTRUCK.GEM, 
BORDERS.GEM, BUS.GEM, CABOOSE.GEM, CAMERAS.GEM, CAPITOL.GEM, 
COALCAR.GEM, COMPUTER.GEM, CRANE.GEM, CYCLES.GEM, DOC
TOR.GEM, FACES.GEM, FACES2.GEM, FACTORY.GEM, FORKLIFT.GEM, 
GASPUMP 1. GEM , GEMS.GEM, HELICOPT.GEM, HOUSE.GEM, LIGHT.GEM, 
MANPOWER.GEM, MAP.GEM, MICSCOPE.GEM, MONEY.GEM, OBSER
VAT.GEM, OIL.GEM, PENSETC.GEM, PHONE.GEM, POWERPLNT.GEM, 
README.GEM, SAFETY. GEM, SCARCROW.GEM, STUDENT. GEM, and TA
BLES.GEM. 

Copy the contents of the other master disk subdirectory to the disk in drive B:. 

o Type: COPY A:' PICTLlB3 B:' PICTLlB3 
o Press the ENTER key. 

This command will copy TELSCOPE.GEM, TOOLS. GEM, TRACTOR. GEM , 

TVS.GEM, WINDMILL.GEM, and TRAINS.GEM. 
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Both of the GEM Draw backup disks are now complete. Label both of these mas
ter disk copies and hide the originals in Al Capone's secret vault. 

Installing GEM Draw 
You are now ready to install GEM Draw on the GEM Desktop. This installation 

is completely different from the other GEM application installation procedures. In ad
dition to two, blank floppy disks, you will also need your GEM DESKTOP disk. 

Note: Systems with the GEM Desktop installed on a hard disk drive need only copy 
the GEMAPPS folder into the appropriate hard drive subdirectory. As for the three 
picture library folders, either place them on the hard drive or transfer them to sepa
rate floppy disks. 

o Start the GEM Desktop. 
o Select the floppy disk B icon. 
o Display the File Menu. 
o Choose the Format ... command. The warning dialog appears. 
o Insert a blank floppy disk in drive B:. 
o Click on the "ok" button. (Label this disk "GEM Draw Application.") 
o Repeat the above steps for a second floppy disk. (Label this disk "GEM Draw 

Pictures.' ') 
o Insert the copied master GEM Draw disk in drive A:. 
o Double-click on the floppy disk A icon (or press the Escape key, if this win-

dow is active). 
o Insert the GEM Draw Application disk in drive B:. 
o Drag the GEMAPPS folder from the disk in drive A: to the disk in drive B:. 
o Insert the GEM Draw Pictures disk in drive B:. 
o Drag the PICTLIBI folder from the disk in drive A: to the disk in drive B:. 
o Insert the GEM DESKTOP disk in drive A:. 
o Insert the GEM Draw Application disk in drive B:. 
o Drag the GEMSYS folder from the disk in drive A: to the disk in drive B:. 
o Drag the COMMAND.COM application from the disk in drive A: to the disk 

in drive B:. 
o The installation of GEM Draw is now complete (Fig. 4-1). 

Warning: GEM Draw might not work properly following this installation. To avoid 
getting too technical, the nature of the GEM Desktop MET AFIL.SYS application de
termines whether or not GEM Draw can be used. Basically, MET AFIL5.SYS will run 
GEM Draw properly, while METAFIU.SYS will not. These METAFIL.SYS appli
cations come from the GEM DESKTOP GEMSYS folder. Only recent versions of the 
GEM Desktop have the MET AFIL5.SYS application (look for Serial Numbers above 
5054-0000-092578 or purchase GEM W ordChart). Therefore, if you are having prob
lems running GEM Draw, consult with DRI about a GEM Desktop upgrade. Once you 
upgrade to this desktop, you will have to reinstall all of your other GEM applications 
(refer to Chapter 1 for GEM Desktop installation instructions). 

Two unique warning dialogs will appear when GEM Draw is NOT running prop
erly. The first dialog notes that it can't find the Metafile. This dialog returns you to 
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o 
D~~"l.~SC 

GEM~Vi COMMAND. (011 

Fig. 4-1. A properly completed GEM Draw Application disk. 

the GEM Desktop and cancels your attempt to run GEM Draw. The other dialog notes 
that you should insert your font disk. "What the font?" you ask. There is no font disk 
with GEM Draw. Once again, the wrong Metafile has caused program execution to 
return to the GEM Desktop. If you get either one or both of these warning dialogs dur
ing the initial running of GEM Draw, you will need a more recent version of the GEM 
Desktop. 

USING GEM DRAW 

To start GEM Draw, enter the GEM Desktop and insert the GEM Draw Application 
disk into drive A: and your GEM Draw Pictures disk in drive B:. 

o Double-click on the floppy disk A icon. 
o Double-click on the GEMAPPS folder icon. 
o Double-click on the DRAW .APP icon. (A better starting method is to double

click on a .GEM type document. This ensures the proper drive alignment in 
subsequent saves.) 

Following this brief loading exercise, you are greeted by a blank GEM Draw screen 
(Fig. 4-2). There are six distinguishing features on the GEM Draw screen: the Menu 
Bar, the Title Bar, the Drawing Surface, the Element Menu, the Panner, and the Se
lect Mode Icon. Additionally, there are the other, now familiar, GEM attributes of Close 
Box, Full Box, Size Box, Sliders, Scroll Bars, and arrows. All of the members of this 
latter group of GEM Draw features are described more fully in Chapter l. 

Menu Bar 

Covering the top of the GEM Draw screen, is a line containing all of the drop-down 
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menus. All of GEM Draw's commands are found on these menus. There are nine 
menus on the GEM Draw Menu Bar: Desk, File, Edit, Font, Page, Arrange, Pattern, Line, 
and Color. The GEM DRAW REFERENCE section later in this chapter fully anno
tates all of the commands found on each of these menus. 

Title Bar 

This descriptive line situated underneath the Menu Bar displays all of the disk in
formation concerning the current picture. This disk data includes: the drive designa
tion, the Directory Path Name, the Picture Name, and the Picture Type. When dealing 
with GEM Draw pictures, the Picture Type will always be .GEM. 

Drawing Surface 

The central portion of the GEM Draw screen is the Drawing Surface. This is e 

the element work area where each picture is created and edited. The size, format, and 
view of the Drawing Surface is controlled through various menu-resident commands. 

Element Menu 
This menu running along the far left-hand border of the Drawing Surface, holds 

eight different icons. Each of these icons represents a GEM Draw element. The eight 
GEM Draw elements are: Rectangle, Rounded Box, Circle, Polygon, Sketch, Line, Are, 
and Text. These elements are individually selected and then applied directly on the 
Drawing Surface. 

Desk File Edit Font Page Arrange Pattern line Color 

.. 
Fig. 4-2. The opening GEM Draw screen. 
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Panner 

The next icon directly above the Element Menu is the Panner. Panner is used for 
selectively moving the view window to a new location. The final results are similar 
to those obtained with Scroll Bars, Sliders, and arrows, but the process is much more 
precise. This precision comes from the Panner switching your viewpoint to that of a 
full page view. With this new vantage point, you are able to move the view window 
quickly to a new location. Panner cannot be used with the Full View command (refer 
to the next section for an explanation of this command). 

Select Mode Icon 

The last GEM Draw screen feature is an icon that sits above the Panner. Selecting 
this icon changes the function of the pointer. When the pointer is in this mode, the 
following actions can be performed: select elements, move elements, scale elements, 
and make a selection from the Font, Line, Pattern, and Color menus. During the exe
cution of some of these actions the pointer can change from its traditional arrow to 
either a hand or a finger. These changes will only take place, however, when the Se
lect Mode Icon is highlighted. 

Picture Element Control 

GEM Draw's usage of elements for picture creation requires a special set of iden
tification, movement, and shape controls. These controls are not commands. Rather 
they serve as aids in managing element design. 

The Current Element is the active element. This element can be easily identi
fied by the presence of a surrounding field of extents (Fig. 4-3). 

... 
INVESTMENT 
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Fig. 4-3. A current element is surrounded by a field of extents. 
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Or, 

To Make an Element Current: 

o Choose the Select Mode Icon. 
o Place the pointer directly over the element. 
o Click the mouse button. The extent field surrounds the element. 

To Make Multiple Elements Current: 

o Choose the Select Mode Icon. 
o Place the pointer directly over the first element. 
o Click the mouse button. The extent field surrounds the first element. 
o Press and hold the Shift key while positioning the pointer over each other ele

ment and clicking the mouse button. 

o Choose the Select Mode Icon. 
o Place the pointer in an upper left area of the element group. 
o Drag the pointer to a lower right area of the element group. 
o When the dashed rectangle completely encloses the elements, release the mouse 

button. 

To make a Selective Element Current (Use this method when you have one or more 
elements sitting on top of each other): 

o Choose the Select Mode Icon. 
o Place the pointer directly over the layered elements. 
o Press and hold the Ctrl key while clicking the mouse button. The extent field 

surrounds the first layered element. 

Extents identify the current element. Extents are the combination of a black, rec
tangular border and several small, black boxes that encrust its border. Besides label
ing the current element, this extent field is also used for moving and sizing an element. 

To Move an Element: 

o Choose the Select Mode Icon. 
o Place the pointer directly over the element. 
o Click the mouse button. The extent field surrounds the element. 
o Place the pointer inside the extents. 
o Press and hold the mouse button. The pointer changes into a hand. 
o Drag the element to its new location. 
o Release the mouse button. 

To Size an Element: 

o Choose the Select Mode Icon. 
o Place the pointer directly over the element. 
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D Click the mouse button. The extent field surrounds the element. 
D Place the pointer on one of the extent field's small black boxes. 
D Press and hold the mouse button. The pointer changes into a finger. 
D Drag the element to its new size. 
D Release the mouse button. 

Tip: Use this method on the comer extents to change an element's size in both 
a vertical and a horizontal direction. 

Warning! You cannot size Text elements with this method. To change the size 
of text, use the point commands on the Font Menu. 

GEM DRAW REFERENCE 

Total element control is directed by commands found on the Menu Bar. While several 
of these menus and the commands that they contain are familiar to every veteran GEM 
Desktop user, the bulk of these nine menus support the composition and design of ele
ments on the Drawing Surface. Likewise, the resource pool of these elements, the Ele
ment Menu, is unique to GEM Draw. Even though each element has an equivalent in 
the GEM Paint Tools Palette, their application in GEM Draw is completely different 
and will require an alteration in your mental visualization during picture creation. 

Desk Menu (Fig. 4-4) 

Draw Info ... displays an information dialog containing copyright and author 

File Edit Font Page Arrange Pattern Line Color 

Calculator 
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Print SpclI)ler 
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Fig. 4-4. The GEM Draw Desk Menu. 
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Fig. 4-5. The GEM Draw File Menu. 

identification and a value indicating the percentage of memory space available for pic
ture creation. 

Calculator displays a multifunction calculator. Refer to Chapter 1 for complete 
operation instructions. 

Clock displays a real-time clock and calendar. Refer to Chapter 1 for complete 
operation instructions. 

Print Spooler displays a list of documents and pictures for printing. Refer to Chap
ter 1 for complete operation instructions. 

Snapshot displays a screen-to-disk camera. Refer to Chapter 3 for complete oper
ation instructions. 

File Menu (Fig. 4-5) 

New creates a new, blank picture. If you are working on a picture when you choose 
this command, GEM Draw erases this picture without saving it. 

Open ... loads a previously saved picture into GEM Draw. You can use this com
mand to load and work on two different pictures simultaneously. 

To Work on two pictures: 

o Display the File Menu. 
o Choose the Open ... command. The ITEM SELECTOR dialog appears. 
o Double-click on the first picture's name. This picture will be loaded into GEM 

Draw. 
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o Reduce the size of the current GEM Draw window with the Size Box. 
o Display the File Menu. 
o Choose the Open ... command. The ITEM SELECTOR dialog appears. 
o Double-click on the second picture's name. This picture will be loaded into GEM 

Draw. 
o Position the second picture's window. 
o Click in the window that you will be copying from. 
o Choose the Select Mode Icon. 
o Place the pointer directly over the element. 
o Click the mouse button. 
o Drag the element to the window that you will be copying to. 

Repeat these last five steps for all elements that need to be copied. 

o Close and save both of the windows. 

Close closes the active window and saves the current picture, if any changes were 
made. The picture is removed from the Drawing Surface. 

Save saves the current picture under its same name. This is also called "updat
ing." The picture stays on the Drawing Surface following the save. 

Save as ... saves the current picture under any specified name. An ITEM SELEC
TOR dialog appears for naming this picture. The picture stays on the Drawing Sur
face following this save. This is known as "backing up." 

Abandon erases the current picture and replaces it with a picture of the same 
name from the storage disk. 

To Output ... sends one or more pictures to the selected output device via the 
OUTPUT application. Refer to Chapter 1 for complete operation instructions on GEM 
OUTPUT. 

Quit erases the current picture without saving it, exits GEM Draw, and returns 
to the GEM Desktop. 

Edit Menu (Fig. 4-6) 

Delete erases the current element from the Drawing Surface. 
Undelete restores the last element that was erased from the Drawing Surface. 

The action of this command is dependent on any layer changes that you make between 
the element deletion and restoration. In other words, barring any changes, an element 
will be restored to its original layer. If any layer changes have occurred, then the re
stored element will be placed in the top layer. 

Duplicate makes a single copy of the current element. This copy is placed in the 
top layer and in the grid unit that is to the right and down. The copy then becomes 
the current element. 

Select All makes every element in the picture current. With this command, ex
tents appear around every element. Clicking the pointer in an open space on the Draw
ing Surface will cancel this command. 
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Font Menu (Fig. 4-7) 

Font Faces comprises the top command section of this menu. Determines the 
font that will be used with the Text element. The leading font is Swiss. Other Font 
Faces will be installed as they become available. If a font is unavailable, it appears 
as a light, dimmed name. A check mark is placed next to the current Font Face. 

Font Point comprises the middle command section of this menu. Sets the font 
point or size characteristic. Sizes range from 10 point to 72 point. This command is 
used for changing the size of Text elements. A check mark is placed next to the cur
rent Font Point. 

Font Style comprises the bottom command section of this menu. Selects the font 
style or print characteristics. The styles include: Normal, Bold, Italic, and Underline. 
A check mark is placed next to the current Font Style. More than one of these styles 
can be used at the same time. To deactivate a style, click on the same command and 
remove the check mark. 

Page Menu (Fig. 4-8) 

Full View places the complete picture in the active window. 
Normal View displays Text elements in their proper proportions. The preferred 

view for dealing with pictures containing text. 
Zoom in magnifies the selected portion of a picture. Choosing this command in

creases the size of the picture window by a factor of two. A maximum enlargement 
of six times is obtainable through this command. 

Zoom out reduces the selected portion of a picture. Choosing this command 
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Fig. 4-6. The GEM Draw Edit Menu. 
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Fig. 4-7. The GEM Draw Font Menu. 
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Fig. 4-8. The GEM Draw Page Menu. 
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decreases the size of the picture window by a factor of two. A maximum reduction 
to an equivalent Full View condition is obtainable through this command. 

Hide/Show Grid removes or displays the Drawing Surface grid. This grid is simi
lar to a sheet of graph paper being placed over the GEM Draw active window. 

Turn Snap On/Off. In the "On" state, this command causes each element to 
be placed at the nearest grid intersection. The grid does not need to be visible for this 
command to be used. Only the element "snaps" to this grid position and not the pointer. 

Hide/Show Rulers removes or displays a pair of scaled drawing rulers. These 
rulers appear along the top and left-hand borders of the Drawing Surface. Either met
ric or U.S. measurements can be set on these rulers. The type of measurements is de
termined by the current settings of the Format ... command. These rulers will not 
print on any output device. 

Ruler Spacing ... sets the measurement units for the rulers. Choosing this com
mand displays the RULER SPACING dialog. This dialog contains two selection fields: 
inches and centimeters. Only one of these fields can be active at a single time. The 
Format ... command determines which of these fields is active. 

In the inches selection field there are six choices: 1132, 1116, 118, 114, 112, and 1. 
This field sets the U.S. measurement units that will be used by the rulers. 

In the centimeters selection field there are six choices: .1, .2, .5, 1, 2, and 3. This 
field sets the metric measurement units that will be used by the rulers. 

Format ... controls the physical layout of the picture. Choosing this command 
displays the FORMAT dialog. This dialog contains three fields: layout, paper, and bor
der. The choices made in these fields will affect many of the other commands in the 
Page Menu. 

The Layout Format ... Field contains two choices: portrait and landscape. This 
field determines how the picture will be oriented during drawing and in any subsequent 
output. 

Portrait-A vertical placement. 
Landscape-A horizontal placement. 

The Paper Format ... Field contains six choices: letter, legal, double, AS, A4, 
and A3. Each of these choices also has an accompanying set of dimensions. Two addi
tional subfields serve to separate these choices into U.S. and metric measurements. 

U.S.-Letter, legal, and double. 
Metric-AS, A4, and A3. 

The Border Format ... Field contains six choices: .5, 1, 1.5,2,3, and 4. Once 
again, these choices are further subdivided into U.S and metric subfields. 

Arrange Menu (Fig. 4-9) 

U .S.-.5, 1, and 1.5. 
Metric-2, 3, and 4. 

All of the commands in this menu are inactive until an element has been made cur
rent. These inactive commands are displayed as light, dimmed names. When an ele
ment is current all of these commands will have dark, bold names, which indicates that 
they are active. 

Put in Front places the current element in the top layer. In a group of elements, 
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Fig. 4-9. The GEM Draw Arrange Menu. 

this command puts the current element on top of the other elements. 
Put in Back places the current element in the bottom layer. In a group of ele

ments, this command puts the current element underneath the other elements. 
Group collects all current elements into a single "grouped" element. This com

mand combines multiple current elements into one element (refer to the Using GEM 
Draw section for instruction on making multiple elements current). These grouped ele
ments are treated by GEM Draw as a single element. One extent field surrounds this 
new, single element. 

Ungroup breaks a current grouped element into its former multiple elements. This 
command reverses the action of the Group command. 

Align Left aligns all current elements with the left boundary of the farthest left 
element. 

Align Center aligns all current elements halfway between the left boundary of 
the farthest left element and the right boundary of the farthest right element. 

Align Right aligns all current elements with the right boundary of the farthest 
right element. 

Align Top aligns all current elements with the top boundary of the top element. 
Align Middle aligns all current elements halfway between the top boundary of 

top element and the bottom boundary of the bottom element. 
Align Bottom aligns all current elements with the bottom boundary of the bot

tom element. 
Page Center aligns all current elements halfway between the left and right borders 

of the current picture. 
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Even Spacing places all current elements within the top boundary of the top ele
ment and the bottom boundary of the bottom element with equal vertical spacing be
tween each element. This command does NOT align the current elements. 

Pattern Menu 

This menu contains 39 different patterns, which can be used to fill any current 
element. A check mark is placed next to the currently selected pattern. The None 
pattern is transparent. Any bottom layer element will be visible through this pattern. 
The Shadow pattern places a proportional, black shadow under and to the lower right 
of the current element. 

Line Menu 

This two-part menu holds line style and arrowhead selections. There are nine differ
ent line styles, ranging from None and dashed lines to thick, solid lines. The arrow
head portion of the menu forms lines with triangular arrowheads on various ends of 
the line. A check mark is placed next to the currently selected line style and arrow
head. Both a line style and an arrowhead can be selected at the same time. 

Color Menu 

Color can be applied to the current element by choosing one of the sixteen colors 
from this menu. Each color is'assigned a numerical code between zero and fifteen. The 
degree of visibility of these colors on both the computer screen and the selected output 
device will vary according to the system. One standard does exist, however. The color 
code "0" is used to represent the background color. Therefore, using this color will 
cause an element to "disappear" into the background. A check mark is placed next 
to the currently selected color code. 

Element Menu (Fig. 4-10) 

This menu is different from the standard drop-down GEM menu. Each "command" 

Fig. 4-10. The GEM Draw Element Menu. 
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or, in this case, element is constantly visible. Contrary to some other GEM Draw menu 
commands, only one element may be used at a time. Once an element has been selected, 
its icon remains highlighted on the Element Menu. All of the governing command selec
tions can be altered after the element has been drawn. Just make the element current 
and choose a new command. 

Rectangle draws a four-sided element. 
Governing Commands: Line Style, Pattern, and Color. 

Rounded Box draws a four-sided, rounded corner element. 
Governing Commands: Line Style, Pattern, and Color. 

Circle draws a circle or ellipse element. 
Governing Commands: Line Style, Pattern, and Color. 

Polygon draws a multi-sided element. 
Governing Commands: Line Style, Pattern, and Color. 

Sketch draws a freehand element. 
Governing Commands: Line Style and Color. 

A pattern can be added from the Pattern Menu after the Sketch element has been 
completed. 

Line draws a straight line segment element. 
Governing Commands: Line Style and Color. 

Arc draws one-quarter of a circle or ellipse element. 
Governing Commands: Line Style, Pattern, and Color. 

Text draws a text element. 
Governing Commands: Font Face, Font Point, and Font Style 

ADVANCED TECHNIQUES 

As pointed out at the beginning of this chapter, one of GEM Draw's strong points is 
that it is able to work with documents and pictures created by other GEM applications. 
Two of these "other" GEM applications are GEM Graph and GEM WordChart. The 
graphs and word charts created by these two applications can be directly modified 
through GEM Draw (see the ADVANCED TECHNIQUES sections of Chapter 5 
on GEM Graph, and Chapter 6 on GEM Word Chart, for information on using GEM 
Draw in this manner). 

Another use for GEM Draw that is directly related to GEM Graph is in creating 
Symbol Graph symbols. A Symbol Graph displays data with descriptive symbols ar
ranged in a Bar Graph fashion. These symbols are used to represent a given unit on 
the graph. This symbol is then repeated until the graph amount has been reached. When 
GEM Graph is in the Symbol Graph mode it reads a special file for obtaining these 
symbols. This file is labeled GRAPH.SYM. Actually, GRAPH.SYM is a GEM Draw 
picture file that has been created especially for use in GEM Graph with a Symbol Graph. 
By using GEM Draw, you can make your own custom symbol library and .SYM 
document. 
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Creating MY.SYM with GEM Draw 

o Choose the Rectangle element. 
o Draw a rectangle on a New Drawing Surface. (This rectangle should be propor

tional to the final symbols dimensions.) 
o Fill this rectangle with the solid pattern. 
o Choose the appropriate elements and draw the symbol inside the box. (This 

symbol should be in the top layer and the box in the bottom layer.) 
o Make the entire symbol and box current. 
o Display the Arrange Menu. 
o Choose the Group command. The entire symbol and box are a single element 

(Fig. 4-11). 
o Display the File Menu. 
o Choose the Save as ... command. The ITEM SELECTOR dialog appears. 
o Type in the picture name and type: MY.GEM. 
o Display the File Menu. 
o Choose the Quit command. Return to the GEM Desktop. 
o Click on the MY.GEM picture icon. 
o Display the File Menu. 
o Choose the Show Info ... command. The ITEM INFORMATION dialog 

appears. 
o Change picture types. Type MY.SYM in the Name field. 
o Drag this renamed document to the GRAFSYMS folder. (Floppy users, this 

Desk File Edit Font Page Arrange Pattern line Color 
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Fig. 4-11. Designing a symbol for use in a GEM Graph Symbol Graph. The Group command is used 
for making all of the elements current. 

129 



is on the GEM Graph Data disk. Hard users, this is in the root directory.) 
o Double-click on the GRAPH.APP icon. This starts GEM Graph. 
o Display the File Menu. 
o Choose the Load Symbols ... command. The ITEM SELECTOR dialog 

appears. 
o Double-click on MY .SYM. 
o Begin the procedure for making a Symbol Graph. 

When making your own symbol document, pay attention to these points: 

1. The beginning rectangle can be any size. GEM Graph automatically reduces each 
symbol to the correct graph size. 

2. Use uniform rectangles for consistent symbols. 
3. Symbol spacing within the rectangle is part of the final printed symbol. 
4. A maximum of 12 symbols can be placed inside a single .SYM document. 
5. Neither the Text nor the Sketch element should, be used in symbol creation. 
6. Finally, KISS (or Keep It Simple Stupid). This is the most important point to suc

cessful symbols. A complex symbol will print as an amorphous blob, while a discreet 
symbol will convey the full impact of your graph. 
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Chapter 5 

GEM Graph 

Data is dry. No matter how you slice the pie chart, data that is presented in a tabular 
form is bound to bore any business presentation to a screeching halt. Nevertheless, 
dull, dry figures are continually hurled unmercifully on audiences, from boardrooms 
to poster sessions. The reason for this sadistic behavior is based on a failure to master 
the basic art of data-to-graph conversion. So much mystery is steeped into the process 
of taking data from spreadsheets to graphs that this activity is usually reserved for 
the corporate figure alchemist. This secrecy is unwarranted. 

Good graph and chart preparation is a time-consuming chore that requires the dex
terity of a juggler, the composure of a jeweler, and the strength of an orthopedic sur
geon. During a typical graph development session, the initial step is to determine the 
best method for displaying the data. In this example, let's use a standard bar graph. 
Next, the values of both the x and y axis must be established with reference to the 
range of figures contained in the original data. After these definitions have been fixed, 
we can begin plotting our data. Once all of the data has been plotted, we can add labels 
and the bar graph is complete. Of course, this four sentence outline camouflages the 
length of time necessary for accomplishing this bar graph result. 

What if a microcomputer is assigned to this graph and chart preparation? Computer
generated graphs and charts can lend a dramatic impact to the final business report. 
The only problem is finding the appropriate software for realizing these spectacular 
goals. Up until this point, two GEM applications would be adequate for designing graphs 
and charts. Both GEM Paint and GEM Draw are capable of turning data into pictures. 
The only problem with this approach is that you must still perform the conversion by 
hand. Therefore, the assignment of the microcomputer to this task has made our graphs 
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prettier, but still has not enhanced our productivity. 
One GEM application that is dedicated to the painless conversion of data into graphs 

and charts is GEM Graph. This highly specialized program is a professional presenta
tion graphics studio that takes your data and automatically creates the specified graph 
or chart. With GEM Graph, you have a choice of eight different graph and chart forms, 
numerous labeling possibilities, and the ability to directly import spreadsheet data into 
the program. Actually, this spreadsheet data can be either created at the GEM Graph 
keyboard or read from Lotus 1-2-3 and dBase III files. 

Once you have created your perfect graph or chart, you can print it on a wide selec
tion of output devices. One virtue of this output method is that after you examine this 
printout, you can quickly and easily edit the results. Adding to this virtue is GEM Draw's 
ability to manipulate GEM Graph produced graphs and charts. Without a doubt, using 
GEM Graph for your data duties will help tum the boredroom back into the boardroom. 

INSTALLING GEM GRAPH 

GEM Graph is sold on one floppy disk. You should immediately make a backup copy 
of this floppy disk before attempting to install GEM Graph. This backup copy will then 
be used for the actual installation. An unfortunate oversight by DRI has left this GEM 
Graph master disk in a write-enabled condition. In other words, if you use the wrong 
DOS command, you could erase this disk and destroy GEM Graph; good-bye boardroom, 
hello boredroom. Well, to prevent this possible calamity, immediately write protect 
your DRI-issued GEM Graph master disk (use the small sheet of rectangular, self
adhesive tabs that come packaged with your floppy disks). Now, you are ready to back 
up your GEM Graph disk. 

Backing Up GEM Graph 

o Place your DOS disk in drive A:. 

Format a floppy disk. 

o Type: FORMAT 
o Press the ENTER key. 

Follow~ formatting instructions. (Remember to remove your DOS disk from A: 
before you begin.) 
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o Insert the GEM Graph master disk in drive A:. (Make sure that you have write 
protected this disk.) 

o Insert your newly formatted disk in drive B:. (This disk should NOT be write 
protected.) 

Copy the root directory. 

o Type: COpy A:*. * B: 
o Press the ENTER key. 



This command will copy INSTALL.APP, INSTALL.TXT, and READ.ME. 
Make four new subdirectories on the disk in drive B:. (The abbreviation MD will 

be used for the make directory command MKDIR.) 

D Type: MD B:" GEMAPPS 
D Press the ENTER key. 
D Type: MD B:" GRAFMAPS 
D Press the ENTER key. 
D Type: MD B:" GRAFSYMS 
D Press the ENTER key. 
D Type: MD B: "GRAPHS 
D Press the ENTER key. 

Copy the contents of the first master disk subdirectory to the disk in drive B:. 

D Type: COPY A:" GEMAPPS B:" GEMAPPS 
D Press the ENTER key. 

This command will copy GRAPH.APP, GRAPH.RSC, and HGRAPH.RSC. 
Copy the contents of the second master disk subdirectory to the disk in drive B:. 

D Type: COpy A:" GRAFMAPS B:" GRAFMAPS 
D Press the ENTER key. 

This command will copy USMAP.MAP and EUROMAP.MAP. 
Copy the contents of the third master disk subdirectory to the disk in drive B: 

D Type: COpy A:" GRAFSYMS B:" GRAFSYMS 

D Press the ENTER key. 

This command will copy GRAPH.SYM. 
Copy the contents of the last master disk subdirectory to the disk in drive B: 

D Type: COPY A:" GRAPHS B:" GRAPHS 
D Press the ENTER key. 

This command will copy SPREAD.WKS, AREA.GRF, BAR3D.GRF, BARLINE.GRF, 
and STBARVER.GRF. 

The backup disk is complete. Remove and label this disk. Place the original GEM 
Graph master disk in a rolled-up sock, in the fourth shoe from the left, in the upstairs 
closet. 

Installing GEM Graph 

You are now ready to install GEM Graph on the GEM Desktop. To perform this 
installation, you will need two, blank floppy disks. 
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GEHAPPS GRAFMAPS G~AFSl(HS G~APHS IIISTALL .APP 

Fig. 5-1. Double-click on the INSTALL.APP icon for installing GEM Graph. 

o Start the GEM Desktop. 
o Select the floppy disk B icon. 
o Display the File Menu. 
o Choose the Format ... command. The warning dialog appears. 
o Insert a blank floppy disk in drive B:. 
o Click on the "ok" button. (Label this disk "GEM Graph Application.") 
o Repeat the above steps for a second blank floppy disk. (Label this disk "GEM 

Graph Data.") 
o Insert the copied GEM Graph disk in drive A:. 
o Double-click on the floppy disk A icon. 
o Double-click on the INSTALL.APP icon (Fig. 5-1). 
o A warning dialog appears informing you that this installation requires two for-

matted floppy disks, GEM Graph Application disk and GEM Graph Data disk. 
o An insert dialog appears. Insert GEM Graph Application disk in drive B:. 
o An insert dialog appears. Insert GEM Graph Data disk in drive B:. 
o An insert dialog appears. Insert GEM DESKTOP in drive A:. 
o An insert dialog appears. Insert GEM Graph Application disk in drive B:. 
o A finish dialog appears. GEM Graph is now in the GEMAPPS folder on the 

GEM Graph Application disk and several sample graphs, maps, and symbols 
are on the GEM Graph Data disk. 

o Return to the GEM Desktop. 

If you fill up your GEM Graph Data disk, you can easily make additional work co
pies for holding maps, symbol libraries, and graphs. Preparation of these extra work 
disks requires the creation of three folders on each GEM Graph Data disk. These folders 
are named: GRAFMAPS, GRAFSYMS, and GRAPHS. You can place these folders 
on a GEM Graph Data disk with either the DOS MD command or the GEM Desktop 
New Folder ... command (look for this command on the File Menu). Whichever 
method you use, make sure that you are in the root directory (this directory is identi
fied by A: ", B: ", or C: ,,) when you add these subdirectorieslfolders. 

USING GEM GRAPH 

To start GEM Graph, enter the GEM Desktop and insert the GEM Graph Application 
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disk into drive A: and your GEM Graph Data disk in drive B:. 

o Double-click on the floppy disk AI icon. 
o Double-click on the GEMAPPS folder icon. 
o Double-click on the GRAPH.APP icon. 

Following this brief loading exercise, you are deposited on a blank GEM Graph 
screen (Fig. 5-2). There are three predominant features on the GEM Graph screen: 
the Menu Bar, the Title Bar, and the Data Window. In addition to these features, the 
GEM Graph screen also contains the standard GEM control attributes: Close Box, Full 
Box, Size Box, Sliders, Scroll Bars, and arrows. 

Menu Bar 

Running across the top border of the GEM Graph screen is the Menu Bar, a line 
containing the drop-down menus. All of GEM Graph's commands are located on these 
menus. There are six menus on GEM Graph's Menu Bar: Desk, File, Edit, Gallery, 
Options, and Font. A complete explanation of each of these menus can be found in 
the GEM GRAPH REFERENCE section later in this chapter. 

Title Bar 

Directly underneath the Menu Bar is the Title Bar, a disk information line. Every
thing related to the exact disk location of the current document is registered on the 
Title Bar. This document disk data includes: the drive desig~ation, the Directory Path 

Desk File Edit Galle 

X AXIS 
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Fig. 5-2. The opening GEM Graph screen. 
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Name, the Document Name, and the Document Type. Only documents with a .GRF 
type can be used by GEM Graph. This type is automatically appended to every GEM 
Graph document. 

Data Window 
The remainder of the GEM Graph screen comprises the Data Window. There are 

seven parts to the Data Window: The Editing Line, the Title Line, the Subtitle Line, 
the X Axis Label, the X Axis Row Labels, the Y Axis Label, and the Y Axis Column 
Labels. A special highlight box indicates which of these Data Window parts is currently 
active. Only an active part can be written on or edited. Both the Enter key and the 
mouse can be used for moving the highlight box (of course, you keyboard fans can also 
use the arrow keys). 

Editing Line. This is the only Data Window part that is never highlighted. The 
Editing Line is used exclusively for composing the data and text that will be written 
on the highlighted box. At the beginning of the Editing Line is the name of the current 
location of the highlighted box. If this box already contains data or text, then the Edit
ing Line displays this information. Use either the Backspace key or the Escape key 
for clearing the Editing Line. Subsequently, you can edit this information and the high
lighted box will receive this new information when the Enter key is pressed or the mouse 
button is clicked. 

Title Line. The title of your graph is typed on this line. Use the highlight box 
to mark this line and then enter the title on the Editing Line. 

Subtitle Line. This line places a subtitle on your graph. When the highlight box 
is marking this line, type the subtitle on the Editing Line. 

X Axis Label. Place the highlight box on this line to enter an X Axis name. 
X Axis Row Labels. Place the highlight box on each of these lines to enter in

dividual X Axis Row names. 
Y Axis Label. Place the highlight box on this line to enter a name for the Y Axis. 
Y Axis Column Labels. Place the highlight box on each of these lines to enter 

individual Y Axis Column names. 
After you have assigned all of the names and labels that will be used in your graph, 

it is time to add the data. Data is entered in GEM Graph's Data Window by using the 
mouse and keyboard. The mouse is used for moving the highlight box and the key
board is used to type in the data. 

D Place the pointer in the first box of Column A and Row l. 
D Click the mouse button. The highlight box fills this box. The Editing Line shows 

the box's name with the original coordinate system, AI:. 
D Type the data on the Editing Line. 
D Press the ENTER key. The data now fills Column A and Row 1. (Alternatively, 

you could move the pointer to a new column and row and click the mouse but
ton to enter the data.) 

When all the labels, names, and data have been added to the Data Window, GEM 
Graph is able to automatically convert this information into the graph or chart of your 
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choice. The graph or chart format is selected from the Gallery Menu (a complete ex
planation of this menu is provided in the GEM Graph Reference section later in this 
chapter). As soon as your choice is made, the Data Window changes into the Display 
Window. 

The Display Window contains two points of interest: the Toolkit and the graph. 
The Toolkit is a series of four different tools that can be applied to the graph that is 
in the active Display Window. Opposite the Toolkit is the graph. This graph is derived 
from your Data Window information and is arranged in the graph format that you 
selected from the Gallery Menu. 

Toolkit 

The Toolkit is located along the left-hand border of the Display Window. There 
are four tools in the Toolkit: the Pointer Icon, the Text Icon, Color Boxes, and the 
Pattern Boxes. The exact nature of the Toolkit's tools will vary according to the type 
of graph that has been selected in the Gallery Menu. For example, a symbol graph 
will display a Symbol Library tool in the Toolkit. 

Pointer Icon: This option selects any graph element. 
Text Icon: This selection enters comments on a graph. 
Color Boxes: This Option applies colors to any graph element. 
Pattern Boxes: This Option changes patterns on any graph Data Set. 

Graph 

The remainder of the Display Window is filled with the graph. The graph's form 
is determined by a selection from the Gallery Menu. Regardless of which graph form 
is used, there are eight basic graph elements: the Axis Scale, the Data Set, the Grid 
Lines, the Labels, the Legend, the Tick Marks, the X Axis and the Y Axis. 

Axis Scale. This scale represents the numeric increments between Tick Marks 
on both axes. 

Data Set. This is the data that constitutes the graph plot. 
Grid Lines. These lines are extensions of the axes' Tick Marks. 
Labels. The labels define each axis measurement. 
Legend. The Legend assigns descriptions to graph patterns, lines, and symbols. 
Tick Marks. These are the individual measurement units on each axis. 
X Axis. This is the horizontal axis-usually reserved for classification labels. 
Y Axis. This is the vertical axis-usually reserved for graph measurement. 

Working in the Display Window 

A graph can be altered once it is in the Display Window. These modifications are 
made possible through the tools in the Toolkit. When you choose a symbol graph, pie 
chart, line graph, or a bar and line graph a fifth tool is added to the standard four tool 
Toolkit. This extra tool is a symbol library, explode-slice icon, and line-thickness indi
cator, respectively, depending on the type of graph. In addition to the tools in the Toolkit, 
you can also use the commands on the Options and Font menus for manipulating a 
graph in the Display Window. 
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To change Colors, Patterns, Lines, Symbols, and Slice Explosions: 

D Choose the Pointer Icon. 
D Place the pointer on the graph element for changing. 
D Click the mouse button. The selector field surrounds the graph element. (The 

selector field is a series of small boxes, which marks a selected graph element.) 
D Place the pointer on the new color, pattern, line, symbol, or slice explosion. 
D Click the mouse button. 

To Move Graph Elements: 

D Choose the Pointer Icon. 
D Place the pointer on the graph element for moving. 
D Click the mouse button. The selector field surrounds the graph element. 
D Keep the pointer on the graph element and drag it to its new location. 

Note: Certain graph elements are unmovable. When the selector field is connected 
by a line, the graph element is movable. Conversely, if there is no connecting line, then 
the graph element can't be moved. 

To Add Text Comments: 

D Choose the Text Icon. The pointer changes its shape to a large "I." (Alterna
tively, you can double-click the pointer in the Display Window to activate the 
Text Icon.) 

D Place the pointer at the site for the comment. 
D Click the mouse button. This indicates the starting position for the comment. 
D Type the comment. 

GEM GRAPH REFERENCE 

The six menus found on the Menu Bar hold all of the commands used by GEM Graph. 

Desk Menu (Fig. 5-3) 

Graph Info ... displays the copyright and author information for GEM Graph. 
Calculator displays a multifunction calculator. Refer to Chapter 1 for complete 

operation instructions. 
Clock displays a real-time clock and calendar. Refer to Chapter 1 for complete 

operation instructions. 
Print Spooler displays a list of documents for output. Refer to Chapter 1 for com

plete operation instructions. 
Snapshot displays a screen-dump camera. Refer to Chapter 3 for complete oper

ation instructions. 

File Menu (Fig. 5-4) 
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New erases the current Data and Display Windows without saving the document. 
Open .. . loads the specified .GRF type document. The ITEM SELECTOR dia-



Calculatl)r 
Clock 
Print SpOOler 
Snapshot 

Fig. 5-3. The GEM Graph Desk Menu. 
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Fig. 5-4. The GEM Graph File Menu. 
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log appears for selecting the document. 
Close Closes the active window and stays in GEM Graph. 
Save saves the current document under its same name. This save will replace the 

previous document. Another name for this action is "updating." 
Save As ... saves the current document under the specified name. The ITEM 

SELECTOR dialog appears for naming the document. This action is called "backing 
up." 

Abandon erases the current document and replaces it with the most recently saved 
version of the same document. 

Import Data ... loads data from another non-GEM application into GEM Graph. 
The ITEM SELECTOR dialog appears for selecting the spreadsheet or database 
document. 

Load Symbols ... loads a symbol library for use in the Toolkit. The ITEM 
SELECTOR dialog appears for selecting the symbol library document. Refer to the 
Advanced Techniques section of Chapter 4 for instruction in making a symbol library 
document. 

Load Map ... loads a map for use in making a map chart. The ITEM SELEC
TOR dialog appears for selecting the map document. 

To Output ... starts the OUTPUT application and sends the specified docu
ment to the selected output device. This command will only work on hard drive sys
tems. Using this command with a floppy drive system will generate a warning dialog. 

To use the To Output ... Command with a Floppy System: 

D Save the current graph. 
D Display the File Menu. 
D Choose the Quit command. Remove the GEM Graph Application disk and in-

sert the GEM DESKTOP disk in drive A:. 
D Display the File Menu. 
D Choose the To Output command. The ITEM SELECTOR dialog appears. 
D Specify the graph for printing. 
D Proceed with the remainder of the OUTPUT application. 

Quit exits GEM Graph and returns to the GEM Desktop. 

Edit Menu (Fig. 5-5) 

The commands in the Edit Menu are only active in the Data Window. Light, dimmed 
commands indicate that they are inactive. When the Data Window is active these com
mands become dark and can then be selected. 

Cut erases data and stores it in memory for later action through the Paste 
command. 

Copy duplicates data and stores the duplicate in memory for later action through 
the Paste command. 

Paste prints data from Cut and Copy commands to the lower right of the high
lighted box location. 

Delete erases the selected data. 
Insert places a blank column to the left of the highlighted column label or places 
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a blank row above the highlighted row label. 
Plot alternates between "Plot" and "Don't Plot" for the highlighted row or column. 

This command is used primarily with imported non-GEM application data. 
Clear Data erases all data from the Data Window. All of the labels, titles, and 

subtitles remain intact, only the row and column data is removed. 
Flip Data changes all row data and row labels into column data and column labels. 

This command will also do the converse and change all column data and column labels 
into row data and row labels. 

Gallery Menu 

Pie Chart displays all data as a pie chart. Slice size is set by the first Y Axis column, 
while the number of slices is determined by the number of X Axis labels. A slice can 
be "exploded" in the Display Window by clicking on the explode-slice icon in the Toolkit. 

Line Graph displays all data as a line graph. Usually, the X Axis is used as a 
time factor and the Y Axis is used for a quantity. Both the pattern filling the lines and 
the thickness of each line can be altered by tools in the Toolkit. 

Area Graph shows data as an area graph. Either single or multiple data sets can 
be used with this graph. With single data sets an area graph is just a variation of a 
line graph. When several data sets are used, however, each Y value becomes a sum 
of all Y values up until that point. 

Bar Graph depicts data as rectangular bars of varying magnitude in a bar graph. 
The Y Axis of data from the Data Window creates the bars. These bars can be ar-
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Fig. 5-5. The GEM Graph Edit M~nu. 
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ranged in either a vertical or an horizontal fashion. GEM Graph has four possible bar 
graph arrangements: 

Vertical Clustered Bar Graph-Data bars are placed side-by-side. The Y Axis is 
used for quantity and the X Axis shows the time factor. 

Vertical Stacked Bar Graph-Data bars are placed on top of each other. The results 
are cumulative over time. This graph shows data effects over time. 

Horizontal Clustered Bar Graph-Data bars are placed side-by-side. The Y Axis 
is used to label the X Axis measured data. 

Horizontal Stacked Bar Graph-Data bars are placed on top of each other. The 
Y Axis values are the sum of every Y column value up until that point. This graph 
is used for item comparisons. 

Three-Dimensional Bar Graph displays data as a set of 3-D bars vertically 
arranged from front to back. The first column of Data Window data is shown in the 
front with each following column placed towards the back. 

Bar and Line Graph shows two different data sets linked through a common 
element as a bar and line graph. The final right-hand column of data is used for the 
line portion of this graph. Various tools in the Toolkit can be used for changing the 
pattern and line thickness in this graph. 

Symbol Graph displays data as a bar graph composed of meaningful symbols. 
The left-hand Y Axis column is used for plotting the symbol data. A special symbol 
library tool is placed in the Toolkit when this graph is selected. 

Map Chart depicts data as a map chart. The left-hand Y Axis column of data 
is used for plotting the map chart. GEM Graph can make two different types of map 
charts: 

Statistical Map Chart-Shows every region in the map that contains the specified 
range of data. Values are given in the Y Axis column under each GEM Graph gener
ated regional name. 

Regional Map Chart-Shows the actual data value for every region inside a given 
region. The display of this data can be altered through the Preferences ... com
mand on the Options Menu. 

Options Menu (Fig. 5-6) 
Preferences ... controls the visual display of a graph. The dialog that appears 

will contain several different selection fields. These fields are different depending on 
the type of graph that has been selected from the Gallery Menu. 
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For Pie Charts, there are two selection fields: 
Slice Names-Place slice names in legend or on chart. 
Value Labels-Use numbers, percentages, or neither. 
For Axis Graphs, there are four selection fields: 
Column Labels-Place line, bar, and area labels in legend or on graph. 
Value Labels-Place values on the graph or not. 
Accumulate-Sums Y values up until the current point or not. 
Percent-Makes Y values a percent of the total or not. 
For Map Charts, there are two selection fields: 
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Fig. 5-6. The GEM Graph Options Menu. 

Region Names-Places region names on the chart or not. 
Value Labels-Use numbers, percentages, or neither. 
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Enhanced/Standard displays the current graph as a three-dimensional enhanced 
graph or as a standard two-dimensional graph. 

Magnify On/Off selectively enlarges a portion of a graph for detailed work. Mag
nify Off returns the graph to a normal, full-size view. 

Page Format ... displays the PAGE FORMAT dialog for selecting the final 
printed appearance of the graph. This command should be used prior to saving the 
final version of the graph for subsequent output. 

Axis ... displays the AXIS dialog for setting your own axes. There are five fields 
in this dialog: 

Axis Scale-GEM Graph will set the axes. 
Minimum-Sets the smallest value on an axis. 
Maximum-Sets the largest value on an axis. 
Step-Sets the incremental units between tick marks. 
Axis Crosses At-Sets the value for the intersection of the X and Y Axis. 
Grid ... displays the GRID dialog for setting the type of line used by the Grid 

Lines on the graph. There are three choices in this dialog: dotted, dashed, or solid. 
Scale Ranges ... displays the SCALE RANGE dialog for setting the ranges used 

in a statistical map chart. There are two selection fields in this dialog: 
Range Number-Sets the number of ranges for the map chart. The maximum range 

number is 9. 
Range Indicator-Sets the size for each range. This size is changed by dragging 
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the range boundary to the desired level. 

Hide/Show Tools removes or displays the Toolkit in the Display Window. 

Font Menu (Fig. 5-7) 

Font Style. A choice of five different font styles are available : Normal, Bold, 
Italic, Underlined, and Boxed. Several of these styles can be combined together. A 
check mark is placed next to the currently active style. The Normal style is used to 
cancel all other styles. Text that is going to be placed inside a patterned area should 
be printed with the Boxed style. This will make the text appear isolated from the pattern. 

Font Point. Six different text sizes can be selected through this command, rang
ing from 10 Point to 72 Point. A check mark is placed next to the currently active point. 

Font Face. This selection sets the type of font that will be used for text appear
ing on the graph. Unavailable fonts have light, dimmed names. After these fonts have 
been installed, their names will become dark and they will be active on the Font Menu. 

ADVANCED TECHNIQUES 

There are several popular spreadsheet and database programs on the market that would 
benefit from GEM Graph's remarkable graphing prowess. These non-GEM applica
tions are able to transfer their files, documents, and data to GEM Graph through a 
simple data importation and conversion process. In order for this data transfer to work, 
the outside files must correspond to one of five GEM Graph-accepted formats. These 
usable formats are: 

Desk File Edit 
Normal 
B.jld 
ItaliC 

GROW'TH THRO Underlined 

~ Boxed 
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Fig. 5-7. The GEM Graph Font Menu. 
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Formalt Definition 

CSV Comma Separated Values; from dBase II and dBase III. 
DIF Data Interchange Format; from Lotus 1-2-3 and VisiCalc. 
PRN ASCII printer output files. 
WK1 Lotus 1-2-3 worksheet document. 
WKS Lotus 1-2-3 worksheet document. 

Note: The PRN format might cause problems with GEM Graph. Empty cells and 
erroneous carriage returns are the major culprits in fouling the smooth importing of 
this data format. The best method for dealing with these incompatible areas is to ex
amine the output from this file prior to sending it to GEM Graph. Then go through 
the PRN file and manually eliminate all of these trouble spots. 

Importing Data into GEM Graph 

o Display the File Menu. 
o Choose the Import Data ... command. The ITEM SELECTOR dialog ap

pears. (Make sure that you have inserted the correct data disk in drive B:.) 
o Double-click on the name of the foreign document. 
o The data is entered into the Data Window beginning underneath the Y Axis 

column labels. 
o No data is entered into the title, subtitle, and X Axis row labels. 
o Use the Cut and Paste commands on the Edit Menu for arranging the data 

into their proper bpxes. 

Another interesting application for GEM Graph is modifying its graphs with GEM 
Draw. In Chapter 4, GEM Draw was used for creating a symbol library (see the 
ADVANCED TECHNIQUES section of that chapter). Additionally, GEM Draw can 
be used for combining multiple graphs on the same page. 

Placing Two Graphs on a Single Page 

o While in GEM Graph, display the Options Menu. 
o Choose the Page Format ... command. The PAGE FORMAT dialog appears. 
o Set the graph size to either half page or quarter page. 
o Save the graph. (Repeat this procedure for the other graph.) 
o Exit GEM Graph and start GEM Draw. 
o Display the File Menu. 
o Choose the Open ... command. The ITEM SELECTOR dialog appears. 
o Double-click on the name of the first graph. 
o Size the window to fit on half of the GEM Draw screen. 
o Load the other graph with the Open ... command. 
o Display the Edit Menu and choose the Select All command. 
o Display the Arrange Menu and choose the Group command. 
o Drag the grouped second graph into the window of the first graph (Fig. 5-8) 
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Fig. 5-8. GEM Draw can be used for combining two separate GEM Graph graphs onto the same 
page. 

D Arrange, rearrange, and edit the two graphs on the single page. 

A special program that is marketed by DRI for use with GEM Graph is the GEM 
Map Editor. The GEM Map Editor is used for modifying the characteristics of GEM 
Graph map charts. This application can be identified by its name, MAPED.APP. When 
the GEM Map Editor application is being run, its operation is similar to GEM Graph 
in the Display Window. There are several different tools and command features, how
ever. For example, in the GEM Map Editor Toolkit, a special Map Symbol library might 
be available. The presence of this tool is controlled by a document called MAP .SYM. 
If MAP.SYM is missing, then this special library tool will not be available. 

A much more dramatic difference between the standard GEM Graph Display Win
dow and the GEM Map Editor can be found on the Edit Menu. A new set of commands 
are on the GEM Map Editor's Edit Menu: 

Make Region . . . displays a dialog for naming the selected region. Multiple 
regions can be combined under one name with this command. 

Break Region dispels a combined region into its original regions. 
Delete erases the selected region or symbol. 
Undelete replaces the last deletion. 
Hide/Show Text removes or displays region names and data. 
Magnify On/Off enlarges the selected portion of the map or returns the map to 

a full-size, normal view. 
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Chapter 6 

GEM WordChart 

An increasingly popular supplement to every business presentation is textual charts. 
A textual chart is usually composed of straight text organized on a plain field. These 
charts serve as a method for breaking up a continual stream of graphs, drawings, and 
spreadsheet data into more digestible parts. While the amount of actual text contained 
on a chart is minimal, the information achieves its impact through selective and crea
tive arrangement. Granted, any word processing program is marginally capable of 
producing a textual chart, but the results from this attempt suffer from a loss of impact. 

The trouble with using standard word processing software, like WordStar, to make 
these charts is that these programs lack the special capabilities that will make a tex
tual chart both impressive and informative. Even powerful word processing software, 
like GEM Write, lacks the necessary "extras," which translate into a captivating tex
tual chart. Basically, in order to create the type of textual chart that will compliment 
a business presentation, a word processing package needs to be able to generate varia
bly spaced text, situated on flexible margins, with numerous font styles. An added en
hancement for this chart-creating word processing program would be the ability to insert 
graphics "bullets" into the text for selective emphasis. 

Digital Research has done every business person a favor by assembling all of these 
capabilities, plus a few that haven't even been mentioned yet, into a dedicated, textual 
chart preparation program called GEM WordChart. Creating textual charts or, as DRI 
calls them, wordcharts is virtually automatic with GEM W ordChart. Only three basic 
actions are necessary for making a wordchart. First, you specify the word chart' s for
mat. This step creates a template on the GEM Word Chart screen. Next, you type the 
needed text into the GEM WordChart-supplied text blanks. These blanks are prepared, 
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controlled, and arranged by GEM W ordChart as you enter the text. The results from 
this step are automatic and provide instant "feedback" as to what the final appearance 
of the word chart will be. As a bonus, you can even add text bullets during this step. 
A healthy Toolkit supplies both graphics and alphanumeric bullets for insertion into 
the wordchart. Finally, you complete the wordchart by adding a border around the text 
template. This final feature is sadly missing from standard word processing software 
and serves as an ideal finishing touch for every word chart. 

Warning! GEM W ordChart has different memory requirements from all of the other 
GEM applications. You will need a minimum of 320K bytes RAM for DOS 2.X and 
384K bytes RAM for DOS 3.X. These increased memory requirements stem from the 
incorporation of a new font, Dutch, into the GEM environment. Refer to the next sec
tion for information about installing this new font. 

INSTALLING GEM WORDCHART 

GEM W ordChart is sold as a three-disk set. The master application disk is identified 
as disk 1 of 3, with Font Disk #1 labeled 2 of 3, and Font Disk #2 called 3 of 3. Before 
you perform the GEM Word Chart installation, you should back up all three of these 
floppy disks. These backup copies will then be used for the actual installation. An un
fortunate oversight by DRI has left all three of these GEM Word Chart disks in a write
enabled condition. In other words, if you use the wrong DOS command, you could erase 
any of these disks and destroy GEM WordChart. To prevent this error in good disk 
management, immediately write protect each of the DRI -issued GEM W ordChart disks 
(use the small sheet of rectangular, self-adhesive tabs that came packaged with your 
floppy disks). With this disk protection ensured, you are ready to back up your GEM 
W ordChart disks. 

Backing Up GEM WordChart 

o Place your DOS disk in drive A:. 

Format a floppy disk. 

o Type: FORMAT 
o Press the ENTER key. 

Follow the formatting instructions. (Remember to remove your DOS disk from A: 
before you begin.) 
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Repeat these steps for the other two floppy disks. 

o Insert the GEM Word Chart master disk in drive A:. (Make sure that you have 
write protected this disk.) 

o Insert one of your newly formatted disks in drive B:. (This disk should NOT 
be write protected.) 

Copy the root directory. 



o Type: COpy A: *. * B: 
o Press the ENTER key. 

This command will copy INSTALL.APP, READ.ME, and INSTALL. TXT. 
Make two new subdirectories on the disk in drive B:. (The abbreviation MD will 

be used for the make directory command MKDIR.) 

o Type: MD B:" GEMAPPS 
o Press the ENTER key. 
o Type: MD B:"WCHARTS 
o Press the ENTER key. 

Copy the contents of one master disk subdirectory to the disk in drive B:. 

D Type: COpy A:" GEMAPPS B:" GEMAPPS 
o Press the ENTER key. 

This command will copy WORDCHRT.APP, WRDCHTHI.RSC, and 
WRDCHTLO.RSC. 

Copy the contents of the other master disk subdirectory to the disk in drive B:. 

o Type: COpy A:" WCHARTS B:" WCHARTS 
o Press the ENTER key. 

This command will copy FREEFORM.WCH, METRIC.WCH, SALARY.WCH, 
AGENDA.WCH, and CHILL.WCH. 

Make an additional subdirectory for a subdirectory. 

o Type: MD B:" GEMAPPS " BORDERS 
o Press the ENTER key. 

Copy the contents of the master subdirectory subdirectory to the disk in drive B:. 

o Type: COPY A:" GEMAPPS "BORDERS B:" GEMAPPS " BORDERS 
D Press the ENTER key. 

This command will copy 1J.GEM, 2_L.GEM, 2J.GEM, 3J.GEM, 5J.GEM, 
6_L.GEM, 6J.GEM, 7J.GEM, 9J.GEM, SAMPLEJ.GEM, 4J.GEM, 
3J.GEM, 5J.GEM, 4J.GEM, 8_L.GEM, 7J.GEM, 9_L.GEM, 8J.GEM, 
and 1J.GEM. 

The backup disk for the GEM Word Chart master disk is complete. Remove and 
label your backup disk. Place the DRI GEM WordChart disk inside a hollow copy of 
Thomas Carlyle's The French Revolution. 

Insert the master copy of Font Disk #1 in drive A: and another formatted disk in 
drive B:. (Be sure to observe the proper write protect practices.) 
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Copy the root directory. This will copy all 42 files on this disk. 
Remove both disks, label the copy, and place the original in spot where the sun 

don't shine. 
Repeat these last three steps for the final GEM Word Chart disk, Font Disk #2. 

Installing GEM WordChart 

With the backup disks in hand, you are now ready to install GEM W ordChart on 
the GEM Desktop. To perform this installation, you will need two, blank floppy disks. 

o Start the GEM Desktop. 
D Select the floppy disk B, icon. 
D Display the File Menu. 
D Choose the Format ... command. The warning dialog appears. 
D Insert a blank floppy disk in drive B:. 
o Click on the "ok" button. (Label this disk "GEM Word Chart Application.") 
D Repeat the above steps for the second blank floppy disk. (Label this disk "GEM 

Word Chart Data.") 
D Insert the copied GEM WordChart disk in drive A:. 
D Double-click on the floppy disk a icon. 
D Double-click on the INST ALL.APP icon (Fig. 6-1). 
D A warning dialog appears informing you that this installation requires two for

matted floppy disks, named GEM Word Chart Application and GEM Word Chart 
Data. 

D An insert dialog appears. Insert GEM W ordChart Application disk in drive B:. 
D An insert dialog appears. Insert GEM Word Chart Data disk in drive B:. 
D An insert dialog appears. Insert GEM DESKTOP in drive A:. 
D An insert dialog appears. Insert GEM Word Chart Application in drive B:. 
D A finish dialog appears. GEM Word Chart is now in the GEMAPPS folder on 

the GEM Word Chart Application disk and some sample word charts are in the 
WCHARTS folder and sample borders are in the BORDERS folder on the GEM 
Word Chart Data disk. 

D Return to the GEM Desktop. 

If you ever need to make additional GEM W ordChart Data disks, they will need 

DO 
GEMAPPS WCHARTS 
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Fig. 6-1. Double-click on the INSTALL. 
APP icon for installing GEM WordChart. 



to contain a WCHARTS folder. This folder can be made directly from the GEM Desk
top with the New Folder ... command on the File Menu. 

Installing the Dutch Font 

An optional font is included with GEM W ordChart. This font and its associated 
setup application is located on the GEM Word Chart Font Disk #1 and Font Disk #2. 
Before you attempt this installation consider these points: 

1. This is an option and isn't required for GEM W ordChart operation. 
2. Using these fonts will consume extra disk storage space. 
3. Using these fonts will consume extra system memory. 
4. Only the GEM Desktop version that came with GEM Word Chart can be used for 

this installation. 
5. This Dutch font will NOT work with GEM Draw Version 1.0. 

o Insert the copy of Font Disk #1 in drive A:. (Floppy systems use drive B:.) 
o Double-click on the floppy disk A icon. (Floppy systems use drive B:.) 
o Double-click on the GEM SETUP .APP icon. 
o Floppy systems insert the GEM STARTUP disk in drive A:. 
o Display the Categories Menu. 
o Choose the Screen Fonts command. 
o Drag all of the available fonts into the Chosen window. 
o Display the Categories Menu. 
o Choose the Printer Fonts command. 
o Drag all of the available fonts into the Chosen window. 
o Save this setup and follow the remainder of the dialogs. 

USING GEM WORDCHART 

To start GEM W ordChart, enter the GEM Desktop and insert the GEM W ordChart 
Application disk into drive A: and your GEM Word Chart Data disk in drive B:. 

o Double-click on the floppy disk A icon. 
o Double-click on the GEMAPPS folder icon. 
o Double-click on the WORDCHRT.APP icon. 

Following this loading exercise, you are placed on a blank GEM W ordChart screen 
(Fig. 6-2). There are six features marking the GEM WordChart landscape: the Menu 
Bar, the Title Bar, the Ruler, the Text Template, the Pointer, and the Toolkit. Sup
plementing these major features are Sliders and Scroll Bars, which function identically 
to their GEM Desktop cousins. 

Menu Bar 

Starting at the top of the GEM WordChart screen is the Menu Bar, a line that holds 
all of the drop-down menus. Every command used in GEM W ordChart is directly ad
dressable from these menus. There are five menus on GEM WordChart's Menu Bar: 
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Desk File Edit TeMPlate Options 
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Fig. 6-2. The opening GEM WordChart screen. 

Desk, File, Edit, Template, and Options. The GEM WORDCHART REFERENCE 
section later in this chapter describes each of these menus in detail. 

Title Bar 

Running underneath the Menu Bar is the Title Bar. This line holds all of the disk 
information related to the current wordchart. The information on this line consists of: 
the drive designation, the Directory Path Name, the Word chart Name, and the Word
chart Type. GEM W ordChart will always use a . WCH type on the Title Bar when dealing 
with a wordchart. 

Ruler 

The Ruler, located at the top of the Text Template, gives an accurate measure
ment of the horizontal working distance in the current wordchart. Also on the Ruler 
is a pair of movable Margin Indicators. These Margin Indicators are used for marking 
the left and right margins of the wordchart. To change the position of a Margin Indica
tor, place the pointer on the Margin Indicator, press the mouse button (the pointer will 
change into a finger), and drag the Margin Indicator to its new location. 

Text Template 

Filling the bulk of the GEM Word Chart screen is the Text Template. The actual 
word chart is composed on the Text Template. There are three parts to the Text Tem
plate: fields, rows, and zones. 
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Ft'elds are the shaded rectangles that hold the typed text. 
One or more fields on the same line in the Text Template make up a Row. 
There are four subdivisions, called Zones in the Text Template. 

1. Title-The zone at the top of the Text Template. 
2. Column Head-A subtitle zone underneath the title. 
3. Text Body-The major text zone. 
4. Footer-A concluding zone at the bottom of the Text Template. 

Text can only be typed into the active zone. Two different indicators are used to 
mark the active zone. The text cursor is a flashing vertical line that is only present in 
the active zone. Additionally, the text cursor shows the point where the typed text will 
be inserted. 

Another indicator of the active zone is the presence of the select boxes at the zone's 
corners. These are small, clear boxes that appear at the four corners of the active zone. 

An interesting characteristic of the four zones of the Text Template is that each 
one has a default set of features. These features govern the eventual display of the 
typed text. For example, the features will set the font style, font face, and font point 
for the active zone. You are free to alter any or all of these features with the Toolkit, 
however. 

Pointer 

This mouse-operated pointer is used for moving margins, choosing commands, and 
selecting Toolkit tools. The pointer is also used for marking active zones. When text 
is typed at the keyboard, the pointer disappears from the screen. This invisibility is 
merely a convenience. Once the mouse is moved, the pointer reappears. 

Toolkit 

This area sits on the left-hand border of the GEM WordChart screen and holds 
six different tools for altering the characteristics of text typed on the active zone. These 
tools are: text color, bullet style, text style, text size, text alignment, and font. The 
GEM Word chart Reference section, later in this chapter, discusses each of these tools 
in greater depth. 

Keyboard Commands 

For those users who detest the intrusion of a mouse into a text-oriented applica
tion, GEM W ordChart provides many keyboard command equivalents (Table 6-1). Each 
of these keyboard commands has a mouse-accessible representative on a drop-down 
menu. 

GEM WORDCHART REFERENCE 

Compared to the other GEM applications, GEM W ordChart has only a modest num
ber of menu-resident commands. Supporting these commands, however, is a compre
hensive Toolkit. A unique feature of the GEM Word Chart Toolkit is that several menu 
commands can alter the tools found in the Toolkit. 
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Command 

Abandon 
Bullets 
Delete Row 
Get Border ... 
Insert Row 
Landscape 
Lines & Boxes ... 
New 
Numbers & Letters 
Open ... 
Portrait 
Quit 
Remember Template 
'Remove Border 
Save 
Save as .. . 
Shortcuts .. . 
Template Gallery ... 
To Output 
Toolkit 
Use Template from ... 
Zone Markers 

Desk Menu (Fig. 6-3) 

Keyboard Command 

Ctrl+A 
Ctrl+K 
Ctrl+ Y 
Ctrl+B 
Ctrl+N 
Ctrl + L 
Ctrl+Z 
Ctrl+W 
Ctrl+K 
Ctrl +0 
Ctrl+P 
Ctrl+Q 
Ctrl +R 
Ctrl + F 
Ctrl +V 
Ctrl+M 
Ctrl +C 
Ctrl +G 
Ctrl +U 
Ctrl +J 
Ctrl + T 
Ctrl +J 

Table 6-1. A listing of Mouse Activities 
and Their GEM WordChart Equivalents. 

W ordChart Info ... displays author and copyright information in a dialog. 
Calculator displays a multifunction calculator. Refer to Chapter 1 for complete 

Calculator 
Clock 
Print Spooler 
Snapshot 
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- ..... , 
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~ Bold 28 
~ Italic ~ 36 

Underline 72 

Fig. 6-3. The GEM WordChart Desk Menu. 
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operation instructions. 
Clock displays a real-time clock and calendar. Refer to Chapter 1 for complete 

operation instructions. 
Print Spooler displays a list of documents for output. Refer to Chapter 1 for com

plete operation instructions. 
Snapshot displays a screen-dump camera. Refer to Chapter 3 for complete oper

ation instructions. 

File Menu (Fig. 6-4) 

New erases the current word chart and places anew, blank word chart in the ac
tive window. This command retains the current template. 

D Press: Ctrl + W 

Open reads the specified wordchart from a storage disk. The ITEM SELECTOR 
dialog appears for identifying the required wordchart. 

D Press: Ctrl + 0 

Save saves the current wordchart under its same name. This action is called "up
dating." 

D Press: Ctrl + V 

Edft 
AW 
· .... 0 

Save · .... V 
Save as ... AM ." 
Abandon AA 

0 To Output , ... U -• Quit ~'''Q 

Hor~al 20 
~ Bold 28 
.. Italic .. 36 

Underline 72 

Fig. 6-4. The GEM WordChart File Menu. 
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Save as ••. saves the current word chart under the specified name. The ITEM 
SELECTOR appears for providing this name. This action is called "backing up." 

o Press: Ctrl + M 

Abandon erases the current word chart and places the most recently saved ver
sion of the same word chart in the active window. 

o Press: Ctrl+A 

To Output starts the GEM OUTPUT application for sending the specified word
chart to the selected output device. 

o Press: Ctrl + U 

Quit ends GEM Word Chart and returns to the GEM Desktop. 

o Press: Ctrl + Q 

Edit Menu (Fig. 6-5) 

Insert Row Inserts a row in the active zone. This new row is placed directly above 
the current position of the text cursor. 

o Press: Ctrl+N 

Desk 
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Fig. 6-5. The GEM WordChart Edit Menu. 
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Delete Row erases the row in the active zone at the exact location of the text 
cursor. 

D Press: Ctrl+ Y 

Get Border . . . reads the specified border from the storage disk. The ITEM 
SELECTOR dialog appears for identifying the required border. All borders follow a 
standard word chart naming convention: 

Portrait borders-Wordchart Name = *J Word chart Type = .GEM 
Landscape borders-Wordchart Name = *_L Word chart Type = .GEM 

In both of these cases, the asterisk (*) represents any six-letter word, name, or charac
ter set. To a limited extent, any border format (portrait or landscape) can be used with 
any word chart format (portrait or landscape), as long as the border doesn't interfere 
with the text. 

D Press: Ctrl + B 

Remove Border erases the border that you added with the above command. 

D Press: Ctrl + F 

Designing Your Own Borders with GEM Draw 

Be sure to observe these points when designing your own borders: 

1. Don't create a border picture larger than 4K bytes in size. 
2. Always save your final border in the BORDERS folder of your GEM Word Chart 

Data disk. 
3. Make the border fill the entire page, so that it will hold the Text Template. 

D Start GEM Draw. 
D Draw the border using any of GEM Draw's elements. 
D Group the border's elements into a single element with the Group command 

on the Arrange Menu. 
D Draw the locator rectangle inside the border. This rectangle is used for telling 

GEM Word Chart where to place the Text Template. The locator rectangle needs 
to be 112" inside the border on all sides. 

D Fill the locator rectangle with the solid pattern. 
D Assign the Color 0 to the locator rectangle. 
D Choose the Put in Back command. This moves the locator rectangle to the 

first element drawn in this picture. 
D Label and save the completed border. 

Template Menu (Fig. 6-6) 

Use Template From ... reads the Text Template from the specified word-
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Fig. 6-6. The GEM WordChart Template Menu 

chart. The ITEM SELECTOR dialog appears for naming the required wordchart. This 
command loads every feature, border, and Toolkit tool that is found on the named word
chart. This command does not, however, load the specified word chart's text. 

o Press: Ctrl + T 

Remember Template replaces the specified template gallery word chart with 
the current wordchart Text Template. This command permanently saves the current 
word chart template in the template gallery replacing one of the resident templates. 
The template that is highlighted in the template gallery at the time of this command's 
execution is the template that will be replaced. The original templates can all be re
stored in the template gallery by erasing the documents DEFAULTP.WCT (for por
trait formats) and DEFAUL TL.WCT (for landscape formats) from the GEMAPPS folder 
on the GEM Word Chart Application disk. 

o Press: Ctrl + R 

Template Gallery ••. displays the Template Gallery dialog for selecting the 
Text Template for the current wordchart. There are three general categories of tem
plates: columnar, outline, and free form. Once you have made your Text Template selec
tion by clicking on the template's icon, you exit the Template Gallery dialog by clicking 
on the "ok" button. 
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o Press: Ctrl+ G 

Options Menu (Fig. 6-7) 

Portrait creates a vertical wordchart layout. 

o Press: Ctrl + P 

Landscape creates a horizontal wordchart layout. 

o Press: Ctrl + L 

Lines & Boxes ... adds highlighting boxes and/or lines to active zones. The 
Lines & Boxes dialog appears for selecting or de-selecting the type of line and box. 
There are four fields in this dialog: 

Boxes-Adds or removes a text highlighting box. 
Lines-Adds or removes lines above, below, or above and below the text. 
Line Length-Makes an added line outline the field or outline the text. 
Thickness-Sets one of four different thicknesses for the line or box. 
Numbers & Letters/Bullets alternates between a Numbers & Letters tool and 

a Bullets tool in the Toolkit. Generally, the Bullets tool is used for highlighting text, 
while the Numbers & Letters tool is used for itemizing text entries. No matter which 
tool is used, GEM W ordChart automatically adds the selected field within each tool 
to the active zone. The selected field from each tool takes on the text features of the 
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Fig. 6-7. The GEM WordChart Options Menu. 
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Fig. 6-8. Replacing the Toolkit with the Zone Markers gives you control over the position of the tem
plate's zones. 

active zone with regard to font style (e.g., Bold) and font size (e.g., 28). The empty 
box field is used for removing the bullets, numbers, or letters from the active zone. 

o Press: Ctrl + K 

Zone Markers/Toolkit alternates between Zone Markers and the Toolkit be
ing visible on the GEM W ordChart screen. The Zone Markers are a group of sliders 
that are used for positioning and sizing the Text Template's zones (Fig. 6-8). These 
sliders are dragged with the mouse for moving them. The Toolkit, on the other hand, 
contains several tools, which can be used for directly controlling the appearance of the 
typed text. A description of the Toolkit's tools is at the conclusion of these menu/com
mand definitions. 

o Press: Ctrl + J 

Shortcuts . . . displays a dialog listing the editing keystrokes used in GEM 
Word Chart. 

The Tools of the Toolkit 

Color. This tool is at the top of the Toolkit. By selecting the differently numbered 
boxes in this tool, the final color output of the wordchart can be altered. A special color 
in this tool is the Color O. This white color matches the standard background of GEM 
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W ordChart. Only by using a different colored background will this color be visible. 
A different colored background can be created at the same time you make a border 
using GEM Draw. This background is added inside the border before you add the loca
tor rectangle. 

Bullets/Numbers & Letters. Underneath the Color tool is this variable tool. 
The Numbers & Letters/Bullets command on the Options Menu is used for alter
nating between these two different tools. By using the pointer, a different bullet, num
ber, or letter can be selected for insertion into the active zone. 

Fonts. This tool will only be present if you have installed the Dutch font. Install
ing this extra font gives you a choice between Swiss and Dutch. A mark is placed next 
to the currently selected font. 

Font Style. One or more of these features can be combined for making a text 
style in the active zone. A mark is placed next to the currently selected style(s). You 
can remove a style by clicking on this mark. 

Font Size. This tool sets the size of the text in the active zone. The actual num
ber of points available with this tool is limited by the resolution of your system. The 
7- and 14-point tools are only present on high-resolution systems using either the IBM 
Enhanced Graphics Adapter or the Hercules Graphics Card. A mark is placed next to 
the currently selected size. 

Text Alignment. This tool determines the alignment of the text in the active 
zone. A mark is placed next to the currently selected alignment. The decimal align
ment is used for aligning columns of numbers with reference to their decimal points. 
This method of alignment is only available in the text body zone. 

ADVANCED TECHNIQUES 

After you have completed your wordchart, you might want to add a suitable picture 
or alter the arrangement of the text in a fashion that is beyond the abilities of GEM 
W ordChart. In these cases, you will need to import the word chart into GEM Draw for 
modification. 

GEM Draw is able to: 

Manipulate text fields, rows, and zones. 
Alter attributes in text fields, rows, and zones. 
Group various fields, rows, and zones into single elements. 
Change a border and background pattern. 
Add a picture to the wordchart. 

Using GEM Draw on a Wordchart 

o Save the current word chart. 
o Display the File Menu and choose the Quit command. 
o Start GEM Draw. 
o Display the File Menu and choose the Open ... command. The ITEM SELEC

TOR dialog appears. 
o Move through the drives, folders, and documents until you find the required 

wordchart. 
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Fig. 6-9. GEM Draw can be used for enhancing a wordchart. Notice how the text is mishandled by 
GEM Draw. 

o Double-click on the name of the word chart. 
o Modify the word chart (Fig. 6-9). 
o Display the File Menu and choose the Save as ... command. The ITEM 

SELECTOR dialog appears. 
o Type in a new name for this modified word chart. (This step is necessary be

cause GEM Word Chart cannot read a GEM Draw modified wordchart.) 
o The GEM Draw word chart conversion is complete. 

A valuable feature of GEM Word Chart is the creation of automatic backup word
charts. These documents are made each time a word chart is updated with the Save 
command. A GEM WordChart backup word chart has a .BAK type. Unfortunately, GEM 
W ordChart is unable to read these .BAK wordcharts. Before you can "reuse" a .BAK 
word chart , it must be converted into a .WCH word chart. 

Converting .BAK Wordcharts 
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o Start the GEM Desktop. 
o Double-click on the drive icon with the .BAK word chart. 
o Click on the .BAK wordchart. 
o Display the File Menu. 
o Choose the Show Info ... command. The ITEM INFORMATION dialog 

appears. 



o Type a new name in the Name field with a .WCR type. 
o Click on the "ok" button. 

You will also need a .GEM type for sending this wordchart to the GEM OUTPUT ap
plication. 

o Start GEM Word Chart. 
o Display the File Menu and choose the Open ... command. 
o Double-click on the newly renamed wordchart with .WCR type. 
o When this word chart is on the screen, display the File Menu. 
o Choose the Save command. Click on the "replace" button. 
o The .GEM type wordchart is now ready for OUTPUT. 

Curiously enough, when you follow this procedure, another .BAK type wordchart 
is created. 
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Chapter 7 

Some Notes on The 
GEM Programmer's Toolkit 

Now that you have been filled with the wonder of GEM, you might like to test your 
hand at designing your own GEM application or desk accessory. Digital Research has 
a special programming package that enables you to do just that. The GEM Program
mer's Toolkit is a three-disk set that contains a complete set of utility software for 
creating drop-down menus, designing icons, and arranging windows and dialogs. The 
only requirements for using these utilities are: 

1. An BOBB-based IBM PC-compatible computer (see Chapter 2 for a comprehensive 
listing of acceptable computers). 

2. A minimum of S12K bytes RAM, regardless of the DOS version number that you 
use. 
3. The Lattice C compiler. This is the preferred compiler, although others can be 

used. If you elect to use another C compiler, then you may have to rewrite the GEM 
bindings for successful application. 

4. A C editor. 
5. Copy all of the utilities from The GEM Programmer's Toolkit disks into a folder 

named TOOLS. 

With these five steps taken care of, you can begin your GEM programming. Con
tained in this programming package are two complete GEM sample programs-one 

_. application and one desk accessory. DRI has supplied the source code, batch files, and 
resource files for both of these illustrative programs. By studying the construction of 
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each of these programs, you will have a comprehensive understanding of the techniques 
used in GEM programming. 

A Sample GEM Application 

The GEM application example is called DEMO.APP. Several different files sup
port your programming education with this sample application: 

DEMO.APP-actual GEM application. 
DEMO.BAT-batch file for RASM. 
DEMOM.BAT -batch file for MASM. 
DEMO.C-Lattice C source code. 
DEMO.DEF -definitions for DEMO.H. 
DEMO.H-inc1ude file. 
DEMO.lNP-LINK-86 link input. 
DEMO.RSC-resource file. 

The two batch files are used for supporting different compilers. 
Several different standard GEM Desktop operations are also demonstrated by 

DEMO.APP: 

Drop-down menus 
Error dialogs 
Warning dialogs 
Opening windows 
Scrolling windows 
Closing windows 

The basic procedure for programming a GEM application, similar to DEMO.APP, 
follows these highly generalized steps: 

1. Use the GEM Resource Construction Set for creating the Menu Bar and the dialogs. 
2. Design the application's icons with the GEM ICONEDIT (Fig. 7-1). 
3. Write the application source code in Lattice C and a word processing program (such 

as WordStar in Non-document mode). 
4. Compile the source code. 
5. Debug the compiled code with GEM-SID. 
6. Market your completed application. 

A Sample GEM Desk Accessory 

The GEM Programmer's Toolkit-supplied desk accessory example is called 
HELLO.APP. Once again, several different files complement your programming edu
cation with this sample application: 

HELLO.APP-actual GEM desk accessory. 
HELLO. BAT-batch file for RASM. 
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DIsk Fil! Op!ration 

Fig. 7-1. ICON EDIT is used for designing GEM icons. 

HELLOACC.BAT-batch file for RASM HELLO accessory. 
HELLOM.BAT-batch file for MASM. 
HELLOMAC.BAT-batch file for MASM HELLO accessory. 
HELLO.C-Lattice C source code. 
HELLO.INP-LINK-86 link input. 
HELLOACC.lNP-RASM link input as accessory. 

The four batch files are used for supporting different compilers and for making HELLO 
an application, as well as a.desk accessory. 

The basic procedure for programming a GEM desk accessory, similar to 
HELLO.APP, follows these highly generalized steps: 

1. Use the GEM Resource Construction Set for creating the Menu Bar and the dialogs. 
2. Write the application source code in Lattice C and a word processing program (such 

as WordStar in Non-document mode). 
3. Copy DESKAPPO.H to DESKACCO.H. 
4. Compile the source code. 
5. Debug the compiled code with GEM-SID. 
6. Copy DESKAPP1.H to DESKACC.H. 
7. Recompile. 
8. Sell your completed desk accessory to the highest bidder. 

The extra copy and recompile steps are necessary because a desk accessory is non-
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executable during the debugging stages. Therefore, the accessory must be first con
verted into an application, debugged, and then converted back into an accessory. The 
batch files for the RELLO.APP accessory cover several methods for performing this 
conversion. 

Porting GEM 

The term porting is greatly misused in non-programming circles. The average com
puter user assumes that a portable program is one that can be made to run on vastly 
different computer systems. To a programmer, however, porting refers to the modifi
cation of a program so that it will run on any other computer. The computer being 
ported to can have either the same MPU as the original system or an entirely foreign 
MPU. Therefore, in a programmer's eyes, a GEM application would have to be ported 
to run on an IBM PCjr, for example. Conversely, the non-programmer would only con
sider taking GEM into the 68000 MPU environment as porting. Aside from all of this 
hairsplitting, suffice it to say that GEM applications are highly portable. 

The included files (.R type) in The GEM Programmer's Toolkit are the site of the 
major porting chores. By altering these files with the new machine-specific function 
and system calls, a GEM application can be easily (this is a relative term) ported over 
to the new environment. Application areas that would require additional conversion 
would be those containing resolution-dependent features. Such features would include 
icons. By far, the best way of making a GEM application portable is to use a program
ming module approach that clearly labels each machine-specific portion. Then, when 
you decide to port the application to another environment, the new machine-specific 
code can be quickly (again, relatively speaking) substituted for the marked modules. 

GEM VOl 

The obvious strong suit of GEM is its graphics-oriented approach to solving operating 
system limitations. This graphics system also provides convenient "hooks" for organiz
ing dissimilar applications into a common environment. One of the potential flaws in 
organizing a true graphics environment is incompatibility among the hundreds of pos
sible graphics devices used with today's microcomputers. This diversity in hardware 
could actually destroy the ability of GEM to deal effectively within a graphics environ
ment. In order to combat any possible degradation in GEM, DRI developed the VDI, 
or virtual device interface. The VDI gives GEM a portable hardware interface for deal
ing with graphics 110 (input/output). 

Basically, the GEM VDI is a programming interface that offers operating system 
compatibility. Additionally, like on the open range, the GEM VDI rides herd over any 
connected I/O device. This leaves the programmer free to concentrate on the applica
tion creation without worrying about device drivers. Two major components make up 
the GEM VDI: the Graphics Device Operating System (GDOS) and the specific device 
driver and face file (or system fonts). The amount of system memory consumed by 
the GEM VDI is less a function of the GDOS than it is the device driver. On the aver
age, the GDOS takes 5K-7K bytes, while the device driver takes 30K-40K bytes. In 
order to appreciate both the significance and the diverse memory use of the device 
driver, you must realize its function. 
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The device driver portion of the GEM VDI houses all of the device drivers used 
by the installed GEM Desktop. This includes the graphics card, mouse, printer, and 
font drivers. By using this method, DRI has removed a prime concern of the applica
tion programmer-peripheral support. Following a typical GEM application scenario, 
the program addresses each device in a standard method with the GEM VDI device 
driver performing all of the translation. 

The other portion of the GEM VDI, the GDOS, controls the coordinate scaling sys
tem used on the particular computer system. This means that the GDOS is a machine
specific module within the GEM VDI. Two different types of coordinate scaling methods 
are used by the GDOS: Normalized Device Coordinate and Raster Coordinate systems. 
The Normalized Device Coordinate method transforms the display coordinates into de
vice coordinates through a normalized space. Conversely, the Raster Coordinate sys
tem deals in real device coordinates without any transformation. Of these two coordinate 
methods, the Raster Coordinate system is stressed by The GEM Programmer's Toolkit. 
Supporting this recommendation are several raster operations that enhance the pro
gramming of a GEM application or desk accessory. 

The Open Workstation function is used for setting the coordinate method: 

v _opnwk( worLin, &handle, worLout ) 

This is the Lattice C binding supplied with The GEM Programmer's Toolkit. 
The device drivers serve as translators between the graphics primitives of the GEM 

VDI and the connected graphics output device. Each device is given a specific driver, 
which is installed during GEMPREP (or added later with GEMSETUP). Based on this 
bit of information, your next question should be, "How is GEM able to manage the 
several device drivers that it uses?" In the GEM VDI, each memory-resident device 
driver is assigned a number. The currently running GEM application is then able to 
selectively output data to the specified device through the proper identification number. 

This same installation and memory management system applies to the GEM VDI 
face files as well. In other words, the required system fonts are installed with GEM
PREP (or added later with GEMSETUP). These system fonts are for both the screen 
and the selected output device. A special text file called ASSIGN.SYS holds a listing 
of the device drivers, the face files, and their associated device numbers. The device 
numbers are set by the selected output device. For example, the printer output device 
uses 21-30 as device numbers. 

Displaying these system fonts can be performed in either the Point mode or the 
Absolute mode. In the Point mode, text created with the face files are fixed to either 
a IX or a 2X size. On the other hand, text displayed with a face file in the Absolute 
mode uses variable scaling from OX to 2X. There is a slight difference, however, in 
the way in which printer device drivers interpret these face file scaling modes. With 
the device printer drivers in The GEM Programmer's Toolkit, all face file text output 
to a printer is rounded down to the nearest scale. 

GEM AES 

Whereas the GEM VDI served as the universal graphics output interface, the GEM 
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AES (Application Environment Services) handles all of the user-generated, graphics
based input through the GEM Desktop features. In other words, the GEM AES is able 
to read user input to icons, drop-down menus, dialogs, and menu-resident commands. 
Watching over these actions, there are five GEM AES parts that hold memory space: 
subroutine libraries, limited multitasking kernel, the Shell, desk accessory buffer, and 
menu/alert buffer. 

The subroutine libraries provide all of the subroutines or mini-applications that per
form windowing, mouse movement, error handling, and screen/object manipulation. 
The subroutines will remain memory resident until the programmer intentionally re
moves them. 

Without a doubt, the success of GEM is hinged on the limited multitasking kernel. 
This AES component is directly responsible for dividing the 8088's time for the appli
cation, any background maintenance (including desk accessories), and the Screen Man
ager. Remarkably, this time division must be carried off without the user becoming 
aware of the missing MPU time. Additionally, the other elements receiving the 8088's 
attention can't remove too much time from the application's execution. Therefore, the 
Dispatcher watches the consumption of the MPU's time. Two lists are made by the 
Dispatcher for 8088 time use-the Not-Ready List and the Ready List. 

The Not-Ready List holds all actions that are waiting for a particular series of events 
to occur. These events might be the press of a key, a wiggle of the mouse, or a tick 
on the clock. In contrast, the Ready List contains actions that are ready to run. Basi
cally, an action is on the Ready List, if it is not waiting for one of the Not-Ready List 
events to happen. From these elementary descriptions, you can see that actions will 
move from one list to the other as one of the events occurs. Guiding the smooth trans
fer or dispatching of each of these moving actions is how the Dispatcher earned its name. 

Only six desk accessories can be watched by the limited multitasking kernel. These 
six accessories are arranged into three different documents labeled DESK1.ACC, 
DESK2.ACC, and DESK3.ACC. These .ACC type documents are held in the desk ac
cessory buffer of the GEM AES. For the programmer, there are three points to remem
ber when dealing with accessories and the limited multitasking kernel. 

1. Use the overlay option (03H) of the DOS EXEC function call (4BH; Load or Exe
cute a Program) for loading the accessory into memory. This desk accessory will then 
stay in memory until the programmer removes it. 

2. There must be at least 128K bytes RAM remaining after the desk accessory and 
the GEM application have both been loaded. 

3. The desk accessory must register (use the menlLJegister call) with the GEM AES 
before it will appear on the Desk Menu. 

In addition, you will need to know the accessory's: 

a. process indentifier. 
b. menu item indentifier. 
c. text string address. 

All mouse activities are monitored in the limited multitasking kernel by the Screen 
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Manager. The Screen Manager comes into play when the mouse leaves the area oc
cupied by the active window. In particular, the Screen Manager is looking for mouse 
actions related to the following: 

Sizing and other window scaling 
Window movement 
Menu Bar and drop-down menu selection 
Limited shape change of the mouse to an arrow pointer 
Non-active window icon selection 

As its name implies, the Shell is an interactive layer between the subroutine libraries 
and the limited multitasking kernel. Granted, in the true context of the GEM AES, 
the Shell is a subroutine library, but it operates independently. These independent ac
tions of the Shell are most visible when a GEM application is started from the GEM 
Desktop. Under these conditions the following happens: 

1. The Shell determines the nature of the application 

Is it graphics based? 
Is it character based? 
Is it a DOS application? 
Is it a GEM application? 

2. The GEM Desktop leaves the screen 
3. The Shell takes control 

no application is present-returns to the GEM Desktop 
graphics based-converts the screen to graphics mode and initiates GEM VDI 
Open Workstation call 
character based-converts the screen to character mode and initiates GEM VDI 
Close Workstation call 
DOS application-follows character-based execution 
GEM application-follows graphics-based execution 

Finally, the GEM AES is associated with screen refreshment. No, this isn't a GEM 
breath mint. Whenever a dialog or a menu fills the screen two events occur. First, the 
displayed dialog or menu is placed in the top layer of the GEM screen. Second, this 
dialog or menu covers a portion of the underlying GEM screen. Following these two 
events is the subsequent removal of the dialog or menu. Along with this erasure goes 
the piece of the screen that was underneath the dialog or menu. Therefore, a problem 
in screen refreshment becomes vital. 

The menu/alert buffer serves as a quick method for redrawing a portion of the screen 
that has been erased by a dialog or menu. Essentially, this buffer holds up to one fourth 
of the screen imagery prior to the arrival of the dialog or menu. After the dialog or 
menu is removed from the screen, the menu/alert buffer redraws the piece of the screen 
that had been covered. The speed of this redrawing is set by the buffer being memory 
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resident. Unfortunately, since this redraw buffer is located in the system memory, only 
a maximum of one fourth of the screen can be correctly restored. Therefore, limit the 
size of your dialogs and menus to less than one fourth the size of the screen. 

GEM RESOURCE CONSTRUCTION SET 

The finishing touch for a GEM application is the incorporation of icons, drop-down 
meilUs, and dialogs into the desktop. This last bit of graphics wizardry is accomplished 
with a tool found in The GEM Programmer's Toolkit-the Resource Construction Set 
(RCS). The RCS helps in the preparation of all of the key graphics features that are 
used by GEM. These graphics features are called resources in the parlance of the RCS. 
Adding a little bit of confusion to this issue is the naming convention that is used for 
the resource files that are created by the RCS. A file made by the RCS uses the .RSC 
type. In order to minimize this confusion, all .RSC files will be referred to as resource files. 

A resource file contains object trees. The "objects" in these object trees include 
text strings, exit buttons (e.g., "ok" buttons), and icons. Using the RCS is quite simi
lar to any other GEM application (Fig. 7-2). 

D Choose the tree option. 
D Name the tree option. 
D Open the tree. 
D Collect the objects. 
D Name the objects. 

Desk File Global OPtions 

Fig. 7-2. The Resource Construction Set (RCS) develops the graphics for applications and desk ac
cessories. 
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o Arrange the objects. 
o Close the tree. 
o Save the tree. 

Dealing with object trees can lead to some complicated, if not amusing, side ef
fects. The Options Menu of the RCS holds several commands that operate on object 
trees. These commands manipulate parents, children, and, even, grandchildren. While 
this might add a bit of whimsy to the otherwise dreary activity of C programming, abus
ing these commands can completely disrupt a resource file. The best advice here is 
to avoid the Options Menu, unless you are intimately familiar with the family opera
tions of an object tree. Otherwise, you might see your resource file receive the Snap, 
Flatten, and Hide command treatment. 
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Chapter 8 

Twin Gems 
On September 30, 1985, the boom was lowered on Digital Research. It was on this 
date in history that Apple Computer struck a solid blow for visual copyright laws. But, 
given the proceedings in this case, this had to be the oddest legal battle ever fought 
in or out of a courtroom. 

In a nutshell, Apple's contention against GEM was that it mimicked the Macin
tosh interface to such a faithful degree that GEM could be interpreted as a copyright 
infringement. Not being known for its fairness in this legal argument, the computer 
press belittled Apple's contentions by debasing its suit into a "look and feel" issue. 
Even magazine editorials (see BYTE Vol. 11 No.1) childishly lambasted Apple for 
pursuing such a destabilizing action. But no matter what your opinion is in this case, 
Apple was justifiable in calling GEM to task for its overly familiar Macintosh inter
face. GEM does closely follow the visual interface of the Macintosh. Let me hasten 
to add that this statement isn't meant to suggest that the outcome of the eventual set
tlement was either fair or just. It only serves as reinforcement of the grounds that Ap
ple used for basing its contention. 

Actually, this is a court case that was never fought. The bottom line is that DRI 
settled out of court with Apple. Now, there are two sides to this type of settlement: 
the implied guilt side and the "cut your losses" side. With implied guilt, it is assumed 
that DRI was guilty of copyright infringement based solely on their pressing for an 
out-of-court settlement. This belief is pure hogwash. 

A more truthful accounting of DRI's action in this non-case is that they realized 
the legal ramifications of Apple's suit and decided to stave off a considerable waste 
in resources by settling out of court. It wasn't the money so much that concerned DRI, 
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it was the market life of GEM that was presented as the perishable resource. Basi
cally, this resource absorption wouldn't have been limited to financial wealth; it would 
almost have certainly included a suspension in GEM sales during the legal proceed
ings as well. The loss in revenue is a tangible fact, but the loss in sales is ephemeral 
and could spell the doom of GEM. In other words, a fickle market faced with Win
dows, DESQview, and TopView isn't about to wait several months or even one year 
for the eventual release of a legally contested product. The end to all of this legal in
trigue arrived on March 24, 1986, when DRI formally announced that a new version 
of the GEM Desktop (version 2.1; refer to Appendix A for a complete introduction to 
the new GEM Desktop) had been officially sanctioned by Apple as not violating the 
Macintosh visual copyright. 

How closely did the original GEM Desktop match the Macintosh interface? Just 
study the next few pages and judge for yourself. 

FINDER 

The operating system of the Macintosh was unlike that of any other contemporary 
microcomputer. This totally graphics-oriented environment is managed with icons 
through a graphics input device. Icons are used for representing physical disk drives, 
files, and a file deletion buffer (the Trash icon). By clicking, dragging, and double
clicking the mouse input device, the user can perform all of the Macintosh system 
management duties. 

One file that supports the Macintosh operating system is Finder. Finder serves 
as the disk and file management segment of this no-name operating system. While much 
of the previous paragraph listed Macintosh features that have similar counterparts in 
GEM, there are several interesting differences between GEM and Finder. For one, 
Finder is slow. Finder is so slow, in fact, that RAM drives, file caching, and memory 
management systems are used to increase the performance of this lethargic operating 
system (Apple has even recognized this speed deficit and attempted several operating 
system upgrades). 

Another area of difference between GEM and Finder is in the management of disk 
drives and disk files. 

Disk Management 

o Turn the Macintosh on. 
o Insert the System Disk into the internal disk drive. 
o Double-click on the System Disk icon. 
o Eject the System Disk. 
o Insert the Mac Write disk. 
o Double-click on the Write disk icon. 

The Macintosh desktop is now filled with two open windows and two floppy disk icons 
(Fig. 8-1). This is sloppy disk management. These windows and icons all came from 
the same physical disk drive, but were actually housed on two different floppy disks. 
This unusual one drive/multiple icon setup can lead to confusion. Just close both win-
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Fig. 8-1. Two open windows on the Macintosh. In this case, the disk icon is used for representing each physical disk 
and not the number of system disk drives. 

dows and single click on the System Disk icon. Now, which disk is currently in the 
disk drive? Furthermore, try and open the System Disk (double-click on the icon). Finder 
certainly is not a very friendly operating system. 

Renaming a File 

D Click on the file's icon. 
D Click the pointer on the name of the icon. A text cursor appears. 
D Type the new name. 
D Click anywhere else in the desktop. The new name is added to the disk's 

directory. 

Several other Finder-related activities also differ from the equivalent action in GEM. 
An important point to remember here is that one operating system can't be judged 
as better than the other based on their relative merits and demerits in these disk and 
file management actions. 

One area, however, where GEM holds a superior edge over Finder is in peripheral 
support. GEM offers a large assortment of graphics cards, printers, plotters, and cameras 
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for receiving its output. Conversely, Finder is limited to Apple products. Although, 
if you happen to own the Apple Computer's LaserWriter, then your Macintosh couldn't 
care less about not having a variety of output devices. 

DESKTOP 

The Macintosh uses the desktop metaphor for describing the visual appearance of its 
operating system. While Finder serves as the disk and file management portion of this 
operating system, several other files form the backbone of the Macintosh operating 
system. Collectively, these operating system files are known as the System Folder. 
Within this System Folder there are commonly six files: System, Finder, ImageWriter, 
Note Pad, Clipboard, and Scrapbook. There is one file, however, that you can't see 
in the System Folder. Desktop is an invisible file that is completely responsible for the 
maintenance of the Macintosh desktop (Fig. 8-2). Why is Desktop invisible? So that 
you won't accidentally remove this vital file from the System Folder. 

Generally speaking, there are three highlights to the Macintosh desktop: the Menu 
Bar, the disk icon, and the Trash icon. The disk and Trash icons have already been 
mentioned. This leaves only the Menu Bar for receiving the final judgment. 

Menu Bar 

This command line runs along the top portion of the desktop. The Menu Bar holds 

r 

" Control Disk fHp Mise 

01: RAMdisk - K free 
Ham. Prtct lckd Invis last Hodifi.d 

9K Clipboard Fil. 0 0 0 Sun, Jun 22, 1 986 

4K Df'skTop ~O 0 • Sun, Jun 22, 1986 

46K Find.r 0 0 0 Sun, Jun 22, 1 986 

27K Imagf'writf'r 0 0 0 Sun, Jun 22, 1 986 

9K Scrapbook Fil. 0 0 0 Sun, Jun 22, 1986 

Systf'm 0 0 0 Sun, Jun 22, 1986 

57K HacTools" 4.2 0 0 0 Thu, Aug 1 5, 1 985 

Fig. 8-2. A disk utility found in the program Copy II Mac shows that the file Desktop is indeed invisible from the user. 
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five menus: the Apple menu, the File menu, the View menu, and the Special menu. 
Each of these menus must be physically pulled down by placing the pointer over the 
menu name and clicking the mouse button. To continually display a menu for com
mand selection, the mouse button must be held down until the command has been cor
rectly highlighted. Then, once the command has been identified, the mouse button is 
released and the command is executed. 

Apple Menu. This menu holds the desk accessories and information dialogs. These 
accessories can be selectively removed for increasing disk storage space. 

About the Finder ... 
Scrapbook 
Alarm Clock 
Note Pad 
Calculator 
Key Caps 
Control Panel 
Puzzle 

File Menu. This is the disk and file management menu. 

Open 
Duplicate 
Get Info 
Put Back 
Close 
Close All 
Print 
Eject 

Edit Menu. The commands on this menu are used for editing text. 

Undo 
Cut 
Copy 
Paste 
Clear 
Select All 
Show Clipboard 

View Menu. These commands structure the icon directory arrangement for all 
windows. 

By Icon 
By Name 
By Date 
By Size 
By Kind 
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Special Menu. This menu holds the commands for controlling the appearance 
of the desktop. 

Clean Up 
Empty Trash 
Erase Disk 
Set Startup 

From this brief introduction to the Macintosh, what is your final verdict on the 
validity of Apple's claimed visual copyright infringement? Does GEM follow the Macin
tosh desktop and interface to a plagiaristic degree? How about the new version of GEM? 
Does it offer a completely unique graphics environment perspective? Of course, with 
the release of GEM version 2.1, this point is moot. The plaintiff in this case, Apple, 
has accepted GEM 2.1 as being within acceptable boundaries for avoiding copyright 
infringement. Once again, be your own judge. Compare GEM 2.1 from Appendix A 
with the information presented in this chapter. Who knows, you might just get an un
expected lesson in corporate law. 
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Chapter 9 

Paste 
Performing several functions, simultaneously-this is an adequate definition of mul
titasking. In reality, true multitasking on a microcomputer can't be accomplished. Be
cause a microcomputer uses a single MPU, the time allotted for different functions 
must be shared. Therefore, a better definition of multitasking in the microcomputer 
environment would be "performing several functions so that they appear to be executed 
simultaneously.' , 

A truer representative of multitasking with microcomputers is known as concur
rency. With concurrency, programs are made to run in the background. This background 
operation is similar to the print queuing function of GEM's Print Spooler desk ac
cessory (or for that matter, DOS's PRINT command). In this case, the listed documents 
are printed in the background, while the GEM application continues to run. Expand
ing this principle to other computer applications, a concurrent operating system ena
bles several programs to operate from the same MPU. For example, you could have 
Lotus 1-2-3 recalculate a spreadsheet and WordStar reformat a manuscript, while you 
search a dBase III database. All three of these operations would be happening concur
rently. 

There are three popular operating systems that open an entirely new window on 
concurrent operation. DESQview, Windows, and TopView are DOS alternatives that 
support concurrent program execution. Furthermore, the use of icons, drop-down me
nus, and windows makes these three operating systems potential competition for GEM. 

Much to the chagrin of DESQview, Windows, and TopView, GEM can be made 
to function as a concurrent operating system. The procedure is simple and the results 
are far more comprehensive than those that are available from these other three con-
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current systems. By using Concurrent PC-DOS 4.1 (available from DRI) as a separate 
application, a concurrent graphics-based operating system can be created. There are 
two points to remember when making GEM concurrent, however. First, this applica
tion must be executed from the GEM Desktop. Second, and more important, the con
current GEM can only be used on a hard drive system. If you obey these two minor 
rules, then you can tum GEM into a concurrent operating system that is capable of 
running up to four applications simultaneously. 

DESQVIEW 

DESQview is a character-based concurrent operating system (Fig. 9-1). Three special 
DESQview features are remarkably powerful: Learn, load files, and virtual memory. 
The remainder of DESQview leaves a lot to be desired. 

Learn 

If you need to type lengthy key sequences to perform a given task, then DESQ
view's Learn ability will save your fingers. With Learn, each key sequence, or macro, 

A _____________________________________________________ _ ] 

DESQview Help ] 
Version 1.02 ] 

A HOW TO USE HELP: Use the Tab key or the mouse to 
A position the cursor on a highlighted word. Press 
A the Gray + key or crick the mouse to display help. 

] 

] 

] 

] 

] 

] 

] 

] 

] 

] 

] 

] 

] 

] 

] 

]" 

A 

.-\ 

.-\ 

DESQview COMMANDS 

Open Window Switch Window Close Window 

Rearrange Zoom Mark 

Transfer Auto Dialer Quit DESQview 

DESQview PROGRAMS 

DOS Services Lea-I"n t"~larrn Clock 
J 

Add a Program Delete a Program Change a Program ] 
] 

]" 

A Press ? to end help. Press for help index. ]" 
A \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \] 

Fig. 9-1. The DESQview Help Screen. 
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is stored by DESQview in a buffer for subsequent recall. Later when you need to type 
in that sequence, just press a key and DESQview enters the information for you. 

Load Files 

A series of special load files enables DESQview to run several popular programs 
concurrently in its windowed environment. Now, these load files shouldn't be thought 
of as pedestrian device drivers that just shoehorn an application like Lotus 1-2-3 into 
a window. Quarterdeck Office Systems (the maker of DESQview) has cleverly written 
each load file for the named program, which gives a program like Lotus 1-2-3 true con
currency and windowing ability. For example, these Lotus windows run faithfully in 
the background, in any sized, colored, or positioned window. 

Virtual Memory 

This feature is nothing more than a fancy name for disk/file swapping. In other 
words, if an application is no longer in concurrent use, DESQview will "swap" it to 
the indicated storage medium (floppy, hard, or RAM). There are problems with this 
memory management technique (swapping active applications because of memory limi
tations) that can lead to a reduction in productivity. 

WINDOWS 

Windows is Microsoft's entry into the graphics-based operating system market. This 
much ballyhooed environment was originally scheduled for a mid-1985 release. Pro
gramming delays, however, pushed the official market arrival back until the first of 
1986. Once Windows was on store shelves, it was quickly adopted as the leading com
petitor for GEM. 

Windows approach to the graphics environment combines the power of a bit-mapped 
screen with the unpleasantness of DOS. This bizarre juxtapositioning seriously limits 
Windows replacement of conventional DOS or even Concurrent PC-DOS (if you need 
concurrency). For example, MS-DOS Executive is the original "desktop" that fills the 
PC screen. This application serves as the directory of the Windows Desktop Applica
tions disk. The MS-DOS Executive sports the standard GEM-like features, including 
a Menu Bar, disk drive icons, and directory path names. Additionally, the MS-DOS 
Executive lists all of the Windows applications in a typically DOS-like manner (Fig. 9-2). 

A typical session with Windows shares many of the same mouse actions that are 
found in GEM. 

o Start Windows. (The Windows Startup disk goes in drive A: and the Windows 
System disk goes in drive B:.) (Hard drive users will have to change the direc
tory with the CD command, first.) 

o Insert a Windows application disk in drive A:. (e.g., Windows Desktop Appli-
cations disk.) 

o Click the mouse button. 
o Double-click on the Cardfile application. (CARDFILE.EXE) 
o Cavort around the Cardfile index. 
o Open the MS-DOS Executive application. (Drag the disk icon to the right border.) 
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, MS-DOS Executi ve ~ , .' '. _ • 
File Uiew Special 

A6 IIJm 'I B:\HN SYSTB1 \ 
OOlUmll,U. 
COURC.FON 
COURD.FON 
EPSON.DRU f\ 
HELUA. FON ~~ 
HELUC. FON 
HELUD.FON 
MSDOS.EXE 
SPOOLER.EXE 
TMSRA.FON 
Tt,1SRC. FON 
TMSRD.FON 
WIN.INI 
WIN100.0UL 
WINOLDAP.GRB 
WINOLDAP.MOD 

Fig. 9-2. The opening Windows MS-DOS Executive screen. Even IBM systems with PC-DOS will use the MS-DOS Execu
tive window. 

o See what time it is. 
o Press and hold the Shift key. 
o Double-click on CLOCK.EXE. 
o Drag the Clock icon into active window border area. 
o Size the Clock window. 
o Display the System Menu and choose the Size command. 
o Drag the size pointer to the needed size. 
o Shrink the Cardfile. Drag the Cardfile's Title Bar into the lower icon area. 
o Stop Windows. Display the Special Menu on the MS-DOS Executive's Menu 

Bar. 
o Choose the End Session command. 

Windows Menus 

Just like in GEM, Windows applications have a unique Menu Bar. The basis for 
all desktop operations, however, stems from the System Menu and the MS-DOS Ex
ecutive Menu Bar. 
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About,., 

System Menu. This menu, which is represented by an icon located in the upper 
left corner of each application window, remains constant throughout all Windows ap
plications (Fig. 9-3). 

Size-the Size command. 
Move-the Move command. 
Icon-shrinks the active window into an icon. 
Zoom-enlarges a window to full screen size. 
Close-the Close command. 
About •.. -displays information about the application. 

MS-DOS Executive Menus. The commands on these menus operate as disk 
and file managers. 

File Menu: 

Run-the Run command. 
Load-the Load command. 

.~ . 
File View S ecial 
~!!J BI---I A:APPS \ 
ABC. TXT 
CALC.EXE 
CALENDAR.EXE 
CARDFILE.EXE 
CLI PBRD. EXE 
CLOCK.EXE 
CONTROL.EXE 
DOTHIS.TXT 
NOTEPAD. EXE 
PAINT. EXE 
REVERSI. EXE 
TERMINAL. EXE 

Fig. 9-3. The System Menu is displayed on the Calculator window. 
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Copy-the Copy command. 
Get Info ... -displays information about the selected file. 
Delete-the Delete command. 
Print-the Print command. 
Rename-renames the selected file. 

View Menu: 

Short-displays the directory horizontally. 
Long-displays the directory vertically. 
All-displays all of the files in the directory. 
Partial-displays a specified file list in the directory. 
Programs-displays only program files in the directory. 
By Name-sorts the directory alphabetically. 
By Date-sorts the directory by creation dates. 
By Size-sorts the directory by byte size. 
By Kind-sorts the directory by file types. 

Special Menu: 

End Session-quits Windows 
Create Directory-makes a new directory. 
Change Directory-the Change Directory command. 
Format Data Disk-the Format Data Disk command. 
Make System Disk-the Make System Disk command. 
Set Volume Name-gives a disk a name. 

Tying down the graphics environment with excessive DOS-like commands pollutes 
the virtue of Windows. Maybe this is Microsoft's method for avoiding any legal tan
gles with Apple over visual copyright infringement. Regardless of the reasoning be
hind this odd combination, Windows loses much of its concurrent benefits by 
hamstringing its user interface. 

POSTMORTEM 
This last concurrent operating system doesn't present any competitive threat to GEM, 
DESQview, or Windows. IBM's Top View is a character-based environment that suffers 
from several performance flaws that seriously undermine either its recommendation 
or its endorsement. Two features stand out as prime examples of IBM Top View's fail
ings. First, Top View tries its best to be a graphics environment as well as a text han
dler. This dual desire leads to enormous problems. For example, TopView's Calculator 
is a marvelous credit to character programming, but it is of little practical value in its 
current environment. IBM should heed DESQview's lead and stick to a true character
based operating system. The second major tick against Top View comes from IBM's 
insistence on paralleling DOS. This duplication is so complete, in fact, that several DOS 
commands appear verbatim in the TopView menus (e.g., DOS's TYPE = TopView's 
Type). What's the benefit of this "alternate" operating system? To IBM's credit, they 
have scheduled upgrades to Top View. Unfortunately, these "improvements" do very 
little to resuscitate the comatose Top View. 
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Appendix A 

GEM Version 2.1 Summary 

In the fall of 1986, DRI released a revised version of the GEM Desktop. The impetus 
for creating this physically remodeled GEM was a pending lawsuit initiated by Apple 
Computer (see Chapter 8). Dubbed GEM Version 2.1, this new desktop shared many 
of the same operations and functions found in the former GEM Version 1.0. Improve
ments to the GEM design, however, can be noted in several key areas: 

1. The presence of optional keystrokes for specific menu commands. 
2. Improved OUTPUT layout and function. 
3. The addition of a new font set-Dutch. 
4. Each drive has a window. 
5. Each window is always active. 
6. Pressing the Escape key (Esc) updates all active windows. 
7. All Version l.X GEM applications (GEM Collection, GEM Draw, GEM Graph, and 

GEM Word Chart) can be installed on the GEM 2.1 Desktop. 

Along with these enhancements, there are several disappointments in GEM Ver
sion 2.1: 

1. There is no Size Box on the disk drive windows. (Curiously enough, there is a Size 
Box on the OUTPUT window.) 

2. Disk drive windows can't be dragged to a new location on the GEM 2.1 Desktop. 
3. The trash icon has been removed. 
4. Menus on the Menu Bar are no longer grouped from left to right. 
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Before the GEM 2.1 Desktop can be used, it must be installed through the GEM
PREP command. The procedure is identical to the GEM Version 1.0 GEMPREP in
stallation, which is discussed in Chapter 1. 

o Place your copy of the GEM SYSTEM MASTER disk in disk drive A:. (Yes, 
GEM Version 2.1 is not copy protected.) 

o Type: GEM PREP 
o Press the ENTER key. 

You will be greeted by: 

We1come to GEMPREP! This procedure will install the GEM Desktop on your 
computer. 

Do you want to put the GEM Desktop on a hard disk? YIN? 

Answer this question and proceed through the remainder to the installation. 
Note: Dual-floppy-disk-drive systems will follow a slightly different installation path 

from that used by hard drive systems. 

o Respond with "N" to the above question. 

The following question appears: 

Does your system have two floppy disk drives? YIN? 

o Type Y 
o Prepare a GEM DESKTOP disk and a GEM STARTUP disk. 

In both installation cases, you will be required to know the following hardware ~pecifics: 

1. Type of graphics display card. 
2. Type of graphic input device (e.g., mouse). 
3. The port that connects the graphic input device to your system (e.g., COMl). 
4. The type of output device. (e.g., Apple LaserWriter). 
5. The port that connects the output device to your system (e.g., COM2) 

Once all of these questions have been answered, the completed GEM 2.1 Desktop 
is configured and copied onto either the hard disk or the twin floppy disks. Table A-I 
lists all of the subdirectories and files that constitute the GEM 2.1 Desktop. 

Like its GEM 1.0 Desktop ancestor, the GEM 2.1 Desktop must be rebooted fol
lowing the GEMPREP installation (floppy disk users, remember to place the GEM 
STARTUP disk in drive A: prior to using the Ctrl + Alt + Del rebooting keystroke se
quence). After the computer has been restarted: 

o Type: GEM 
o Press the ENTER key. 
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STARTUP 

COMMAND.COM 
MODE.COM 

DESKTOP 

EMAPPS < DIR > 
GEMDESK <DIR> 

GEMBOOT <DIR> DESKTOP .APP 
DESKTOP.RSC 
DESKTOP.lNF 
DESKTOP.ICN 
DESKHI.ICN 
DESKLO.ICN 

GEM.EXE 
GEM.RSC 
CALCLOCK.ACC 

GEMSYS < DIR > Table A-1. GEMPREP 2.1 Copies These 
Directories, Subdirectories, and Flies onto 

Either a Hard Disk or Two Separate Floppy Disks. 
GEMVDI.EXE 
ASSIGN.SYS 
IBMCHMPS.SYS 

GEMSYS < DIR > 
FORMAT.COM 
*.FNT GEM.BAT 
*.SYS 
METAFILS.SYS 
OUTPUT.APP 
OUTPUT.RSC 

GEMSCRAP < DIR > 
COMMAND.COM 

Make sure that you are in the root directory before you enter this command (us~ the 
change directory DOS command, if necessary). 

Figure A -1 fills your display as your initial welcome to the GEM 2.1 Desktop. Con
trol of the new GEM Desktop, menu contents, and dramatic changes to specific con
trol dialogs are illustrated in Figures A-2 through A-S. 

Another area of the GEM Desktop that received drastic alteration was OUTPUT. 
Selecting the To Output command from the File Menu of the GEM Desktop places 
the OUTPUT application on the screen (Fig. A-9). Although the operation of OUT
PUT 2.1 remains identical to its Version 1.0 cousin, there are major differences in the 
execution of OUTPUT 2.1. The most obvious changes are in: 

1. Removal of the Edit Menu (Fig. A-10). 
2. Numbered item entries (there are a total of 36 entry spaces). 
3. Output device icons. 
4. A new menu-Preferences (Fig. A-11). 
5. Two new commands on the Preferences Menu: 

Global ... This command controls the preferences for all output devices, regard
less of their type. For example, the number of output copies is set with this command 
(Fig. A-12). 

Shortcuts ... A two-page dialog listing several keystroke and mouse button short
cuts that can be used with OUTPUT (Fig. A-13). 

The final area of the GEM 2.1 Desktop to receive a revamping was GEM SETUP . 
Unlike the Desktop and OUTPUT, GEM SETUP sports only a superficial physical 
"touchup." Other than a Menu Bar rearrangement, the repositioning of one command, 
the addition of several extra peripheral choices, and the inclusion of the "new" GEM 
look (no active windows, modified Sliders, and new direction arrows), GEM SETUP 
2.1 is the same as GEMSETUP 1.0 (Fig. A-14 and Fig. A-15). 

The bottom line with any revision as major as that found in the GEM 2.1 Desktop 
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File Options Arrange DESKTOP 

Fig. A-1. The GEM 2.1 Desktop. 

~ 
FLOPPY 0 ISK FLOPPY 0 ISK 

DDDDDDD 
N~w F old~r GEMSOOT GEMSVS AUTOE:~EC .eAT GEMJAT COMMAND. COM QWH ICs.cOM 

DD 
Fig. A-2. Either disk drive can be assigned to either window. The Close Box is used for moving back
wards through a disk's subdirectories. 
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To ut GEHDESK GEI-1$CW GEI-1S'v'S CQllH~ND. COI'1 

Exi DOS 

Fig. A-3. The GEM 2.1 Desktop File Menu. Notice the keystroke options for certain commands. 

DO 
GEHSYS COHH~NO. COH 

Fig. A-4. The GEM 2.1 Desktop Options Menu. 
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• New Fold 
• GEMAPPS 
• GEMDESK 
• GEMSCRAP 
• GEMSYS 

COMMAND COM 

• New Folder 
DRAW APP 
DRAW RSC 

12:88 aM 
09:29 aM 
89:29 aM 

87-15-86 89:29 aM 
87-15-86 89:29 aM 

23791 12-38-85 12:88 PM 

00-80-80 12:88 aM 
78336 04-89-85 82:17 aM 
10259 04-09-85 82:18 aM 

Fig. A-S. The GEM 2.1 Desktop Arrange Menu. The Show as text command has been previously 
selected. 

.... ,'.y 

Add HaMe", 

hd ~!l;~! N(l!~~! 

~':'~1:.:. ;;~~:'\l:'\\ ~ :~::.:t .: -:' . ,... .,,',11 • /;,t \", ' :: '-::, .. ~ $ ~ :' .. ~ :'" .... : . .: :: ' ~, 

Fig. A-6. All of the standard 2.1 Desk Accessories are on the Desktop. 
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SET PREFERENCES 

ConfirM deletes? ~ CJBQ:] 
ConfirM copies? ~ CJBQ:] 

Double-click speed: []IQ[J II rn rn ClliD 
Sound effects: IImII ~ 

T be forMat: ,"'Wi, I 24 Hour I 
Date forMat: Itlt,.,.,III, I Do-AA-YY I ~ 

I OK I I cancel! 

Fig. A-7. Two format parameters are now controllable with the Set Preferences ... command on 
the Options Menu. 

Application naMe: ~OMlljA_ND I C_OH 
DocuMent types: !-

Application type: ~ ~ 

Needs full MeMory? ~ ~ 

Icon type: 

DOS-takes paraMeters 

Fig. A-S. Very little has changed with the Configure application •.• command. 
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File Preferences OUTPUT 

Fig. A-g. The OUTPUT 2.1 screen. 

Fig. A-10. The OUTPUT File Menu. 
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Fig. A-11. The OUTPUT Preferences Menu. 

File OUTPUT 

GLOBAL PREFERENCES 

NUMber of copies: 1~ 
Horizontal position: [eh ImD I Ri hfl 

Vertical position: To~ IIm~!1I I BottOM I 
Auto display? Yes .~I'II ~ 

~R I ~anceI I 

Fig. A-12. The Global .•. command is a new addition to OUTPUT 2.1. 
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File 

MOUSE BUTTON SHORTCUTS 

Double-click on a device icon to 
display and set its preferences. 

ITEH SElECTOR SHORTCUT 

To add All naMes specified in the 
Directory line to your output list, 
leave the "Selection" line eMpty and 
click on OK or press Enter. 

Fig. A-13. Selecting the Shortcuts .•• command displays a two-page dialog. 

OUTPUT 

GEMSETUP 

aQ or 0 er e Wl S 
I" Enhanced Card I MonochroMe Dis~la~ (6 -----

Enhanced Card I Color Display (640x200) 8 c rs 
:,:':': Enhanced Card I Color Display (640x200) 16 color-----
,',' IBl,j Enhanced Card & Display (640x3S0) 8 colors 
:':,', IBM Enhanced Card & Display (640x350) 16' color-s -----

IBM 3270 PC (720x3S0) 2 colors 
Hercules Card I ~fonochroMe PC W"'I'Ol-sp""la-y-'('IIII'JI72~Ox"'lt"'341nr'8T"'"') ------
AT&T MonochroMe Card (640x400) 

::: AT&T DEB Card (640x400) 16 col-or-s ---------
.:. " 

Fig. A-14. The GEMSETUP File Menu. 
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CEMSETUP 
,'I,; ,!\l: '" 

Chosen Screen Fonts 
olnt point-------------

Point ____________ _ 
Point ____________ _ 

Available Screen Fonts 
olnt Point-------------

Point ____________ _ 
Point ____________ _ 
Point ____________ _ 

~ ____ ii-irr~""'T-,_,r_'Point--------_-----

Fig. A-15. The GEMSETUP Categories Menu. 

, 

is, "should I upgrade?" O'f course, the definitive answer in this situation is "maybe." 
Before you write off this response as being unduly flip, let's weigh the pros and cons 
of upgrading from the GEM 1.0 Desktop to the GEM 2.1 Desktop. First, the pros: 

1. Approved desktop configuration. 
2. Improved user interface through optional command keystrokes. 
3. Enhanced output device control. 
4. Addition of a new system font. 
5. Future GEM applications will be compatible. 

Now, the cons: 

1. Unnecessary expense. 
2. Reduced flexibility in Desktop management. 
3. New Dutch font is available through GEM Word Chart 1.0. 
4. Restricted to GEM 1.0 applications. 

In short, upgrade to the GEM 2.1 Desktop, if you wish to remain compatible with 
future version releases of GEM applications. On the other hand, if you are satisfied 
with the current crop of GEM applications, keep the GEM 1.0 Desktop. Either way, 
it sure beats plain DOS. 
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Appendix B 

GEM/DOS Equivalents 

The following list provides a reasonable comparison between GEM Desktop commands 
and their PC-DOS representatives. 

GEM Desktop Command 

Calculator 
Clock 
Close 
Close Window 
Drag icon 
Desktop Info 
Enter DOS Commands 
Format 
Install Disk Drive 
Install Application 
ITEM INFORMATION dialog 
New Folder 
Open 
Print Spooler 
Quit 
Save Desktop 
Set Preferences 

196 

PC-DOS Command 

TIME & DATE 
Ctrl + Alt + Del 
CLS 
COPY 
VER 
Default state 
FORMAT 
CONFIG.SYS w/LASTDRIVE = 

FDISK 
RENAME 
MKDIR 
DIR 
PRINT 
Ctrl + Alt + Del 
AUTOEXEC.BAT 
MODE 



GEM Desktop Command 

Show as Icons 
Show as Text 
Show Info 
Snapshot 
Sort by Date 
Sort by Name 
Sort by Size 
Sort by Type 
To Output 
Trash 

PC-DOS Command 

DIR 
CHKDSK 
GRAPHICS 

SORT (text files only) 

MODE + PRINT 
ERASE 
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Appendix C 

GEM Icon Summary 

Six standard icons are used through the GEM Desktop. These icons represent physi
cal system contributions. Each icon, with its conventional written label, is illustrated 
in Fig. C-l. 
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Document 

Fig. C-1. 

A 

~ 
I 

Floppy Disk 

Application Folder 

c 

• WhYNNM'hWN.'I,Wh\\Wh 

Hard Disk Trasn 
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Appendix D 

The GSX Standard 
A precursor to the GEM VDI was the Graphics System Extension or GSX developed 
by DRI (refer to Chapter 7 for a complete discussion of the GEM VDI). The GSX pro
gram, like its VDI counterpart, added a device-independent graphics ability to an oper
ating system. Therefore, applications written under the tutelage of the GSX standard 
would be highly portable programs with a ready implementation possible on any com
puter that is able to address the parental operating system. 

A good example of the GSX is found in DRI's CP/M-86 operating system. GSX-86, 
as this GSX version is known, provides three general functions in the CP/M-86 environ
ment (this can be either the "normal" CP/M-86 operating system or the multifunction 
Concurrent CPIM-86 operating system): coordinate translation, fielding graphic requests, 
and supporting device drivers. 

The usual downfall for any graphics program centers around the handling of the 
aspect ratio. Generally speaking, the aspect ratio is what makes a circle look like a cir
cle instead of appearing to be an oval. An example of a bad aspect ratio is seen when 
you draw a circle on the monitor and it prints as an oval on your output device. GSX-86 
delivers a perfect aspect ratio by dealing in a separate set of two-dimensional, carte
sian coordinates for both the monitor and the output device. A special translation for
mula provides the conversion between the monitor coordinate system and the version 
used by the output device. Therefore, any graphics image designed on the monitor shares 
the exact same proportions on the output device. 

All graphics requests sent from the application to the output device are intercepted 
by GSX-86. This sidetrack allows GSX-86 to customize the graphics messages for un-
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derstanding all of the special requirements exhibited by the selected output device. 
An attractive fringe benefit from this request fielding is that any application running 
under a GSX-86 supported operating system can remain detached from all matters that 
pertain to driving the connected peripherals. 

The actual information that is used by GSX-86 for dealing with these peripherals 
is contained within unique, specialized utility programs known as device drivers. Each 
device driver used by GSX-86 is written specifically for the device that will be receiv
ing the output. But GSX-86 is not limited to a single device driver. Even if you plan 
on using several different peripherals, GSX-86 can address all of the device drivers 
that are needed for supporting these mUltiple output devices. An ASSIGN .SYS file 
holds the device driver names that will be loaded by GSX-86. By modifying this file, 
extra drivers can be added as new peripherals are connected to your system. 

Once GSX-86 has been installed and the device drivers have been read from the 
ASSIGN.SYS file, the application is able to deal with any connected peripheral and 
monitor combination. Of course, this action is familiar to every GEM user. Manyelabo
rations have been added to the GEM VDI from this humble beginning at device inde
pendence. Probably the greatest attraction of this universal driver interface, however, 
is that the function of GSX-86 is invisible to the user. Thoughtfully, DRI retained this 
feature when they developed the GEM VDI. 
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Appendix E 

Using DOS-based Software 

in the GEM Environment 
Not only is the GEM Desktop able to utilize GEM-based applications, it is also able 
to manipulate numerous standard DOS-based applications as well. Before any of these 
DOS products can be used by GEM, however, they must be installed on the GEM Desk
top. Any software product can be installed in this manner, including programs on both 
floppy and hard drives. 

To Install a DOS-based application: 

o Start GEM 
o Select the blank icon that represents the DOS software for installation. 
o Display the Options Menu. 
o Choose the Install Application ... command. The INSTALL APPLICA-

TION dialog appears. 
o Fill in the fields on the dialog. 
o Click on the "install" button. 
o Display the Options Menu. 
o Choose the Save Desktop command. 

These last two steps are vital for making GEM "memorize" this installed DOS 
program. In the future, whenever you start the GEM Desktop, this installed program 
will be both recognized by GEM and executable from the GEM Desktop. 

The following completed INSTALL APPLICATION dialogs (Fig. E-l through Fig. 
E-5) will guide you during the installation of several popular DOS programs: 
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Fig. E-1. 

Fig. E-2 

I [\JSTALL APPLICATION 

Application Nanle: ACAD.EXE 
Do(:unlent Types: CI'NG ______ _ 

Application Type: I GENll Em ID()S -takes parametersl 
r'Jeeds Full rVlenl,jry: I YES I 1m 
Icon Type: Dravv 

t 

+ 

I Remove I I Cancel I 

I [\JST ALL APPLI CATI (>N 

.Application [\Janle: ~·~TALK. C()~ll 
Docunlent Types: ~·:T"r:: ______ _ 

Application Type: I GErVll1D ID<)S -takes pararnetersl 
Needs full rVlenlQry: \YEsl a 
Icon Type: 

+ 

II nstalll I Renlove I I Cancel I 
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Fig. E-3. 

Fig. E-4. 
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INSTALL APPLICATIC)N 

Application Nan1€.-: C:C)~,~~,~A(\JD. CO~ll 
Docunlent Types: _______ _ 

Application Type: I GErVll1 DC)S I 
Needs FuJI rvlenl0ry: iYESI IB 
Icon Type: I:::::::::::: r-. rl-II' .. a ..... n1 ~ .. ,.... TO ,-.1 :::::::::::::::::1 '"'''',,''' r- "':-t I 1111 "= I ,:j I .q ,,,,,,,,,,,,,,,,,' 

:::::::::::: .. ::::::::::::::::: 

+ 

II nstall , I Remove I 

I [\JSTALL APPLICATION 

Application Nan1€.-: 123. E;-:E 
DI)(:unlent Types: \~l'r::~, 'NK1 _____ _ 

Application Type: IGEN1! 1m IDOS -takes paranletersl 
Needs Full rVlenl0ry: iii I NO I 

Icon Type: I:::::::::::: ,... - j n -_ .. 
"""""" .--rlr ... al S ...... 1 
111111111111 '..I t- - - - • 

:::::::::::::::::::1 

t 

t 

I' nstalll i Renl0ve I I Cancel I 



I [\JSTALL APPLICATION 

Application (\Janle : TURBO. C()~II 
[)o(:unlent Types: F',l.5 ______ _ 

Application Type: I GEM I_I DOS -takes parameters I 
r\Jeel:1s Full rVlen1(lry: IVESI • 
Icon Type: :::::::::::: Programmer's Tool ::::::::::::::::: ....... u... .. ............... 

1111 ...... 11 .It. 1111' 1111 1111 ............ .. ............... 

[iJ @ 
t 

I ••••••• 

"""" 

........ ........ .. , ..... 
~pplic~,tiorl docurlicnt~ , •• ,1, •• 

I ••••••• 

t 

I Install I I Remove I I Cancel I 
Fig. E-S. 
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Glossary 

address-The location in memory where a given binary bit or word of information 
is stored. 

alphanumeric-The set of alphabetic, numeric, and punctuation characters used for 
computer input. 

analog/digital (A/D) conversion-A device that measures incoming voltages and 
outputs a corresponding digital number for each voltage. 

ASCII-American Standard Code for Information Interchange. 
assembly language-A low level symbolic programming language that comes close 

to programming a computer in its internal machine language. 

binary-The base two number system, in which 1 and 0 represent the on and off states 
of a circuit. 

bit-One binary digit. 
boot-To start a computer. 
bottom layer-The element or elements that are drawn first in GEM Draw. Con-

trast this definition with top layer. 
byte-A group of eight bits. 

chip-An integrated circuit. 
click-One press of the mouse button. 
concurrent operation-Executing two or more RAM-based applications through 

shared CPU time. 
CP/M-Control Program for Microprocessors; an 8-bit microcomputer operating sys-
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tem developed by DR!. 
CPU-Central Processing Unit; the major operations center of the computer where 

decisions and calculations are made. 
CPU time-The execution time used by the CPU, exclusive of I/O functions. 
CMOS-A Complementary Metal Oxide Semiconductor IC that contains both P-channel 

and N-channel MOS transistors. 

data-Information that the computer operates on. 
data rate-The amount of data transmitted through a communications line per unit 

of time. 
debug-To remove program errors, or "bugs," from a program. 
digital-A circuit that has only two states, on and off, which are usually represented 

by the binary number system. 
disk-The magnetic media on which computer programs and data are stored. 
double-click-Two rapid clicks of the mouse button. The length of the pause be

tween clicks can be set by the user through the Set Preferences ••. command. 
DOS-Disk Operating System; allows the use of general commands to manipulate the 

data stored on a disk. 
drag-Click on an icon and continue holding the mouse button down, while moving 

the mouse. 
driver-A utility application containing the necessary information for supporting the 

specified peripheral. 

EPROM-An Erasable Programmable Read-Only Memory semiconductor that can 
be user programmed. 

firmware-Software instructions permanently stored within a computer using a read 
only memory (ROM) device. 

floppy disk-See disk. 
flowchart-A diagram of the various steps to be taken by a computer in running a 

program. 

hardware-The computer and its associated peripherals, as opposed to the software 
programs that the computer runs. 

hard disk-A non-removable storage medium with a fast access time. IBM refers 
to this media as fixed disks. 

hexadecimal-A base sixteen number system often used in programming in assem
bly language. 

icon-A pictorial representation of a definable object. 
input-To send data into a computer. 
input/output (110) devices-Peripheral hardware devices that exchange informa

tion with a computer. 
interface-A device that converts electronic signals to enable communications be

tween two devices; also called a port. 
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languages-The set of words and commands that is understood by the computer and 
used in writing a program. 

loop-A programming technique that allows a portion of a program to be repeated 
several times. 

LSI-Large Scale Integration; a layered semiconductor fabricated from approximately 
10,000 discrete devices. 

machine language-The internal, low level language of the computer. 
memory-An area within a computer reserved for storing data and programs on which 

the computer operates. 
microcomputer-A small computer, such as the Commodore Amiga, that contains 

all of the instructions it needs to operate on a few internal integrated circuits. 
mnemonic-An abbreviation or word that represents another word or phrase. 
mouse-A small desk-top rolling device that sends electronic codes to the computer, 

causing cursor movement. 
moving-Moving the mouse on the physical desktop produces a representative move-

ment on the GEM Desktop. 
MOS-A Metal Oxide Semiconductor containing field-effect MOS transistors. 
MPU-MicroProcessor Unit; the central processing IC or chip. 
multitasking-Executing two or more applications or tasks at the same time. 

NMOS-An N-channel Metal Oxide Semiconductor with N-type source and drain diffu
sions in a P substrate. 

octal-A base eight number system often used in machine language programming. 
opcode-An operation code signifying a particular task to be performed by the 

computer. 

parallel port-A data communications channel that sends data out along several wires, 
so that entire bytes can be transmitted simultaneously, rather than by one single 
bit at a time. 

peripheral-An external device that communicates with a computer, such as a printer, 
a modem, or a disk drive. 

PMOS-A P-channel Metal Oxide Semiconductor with P-type source and drain diffu
sions in an N substrate. 

point-A reference "mark" produced by moving the GEM Desktop pointer via a mouse 
movement. 

program-A set of instructions for the computer to perform. 
RAM-Random Access Memory; integrated circuits within the computer where data 

and programs can be stored and recalled. Data stored within RAM is lost when the 
computer's power is turned off. 

ROM-Read-Only Memory; integrated circuits that permanently store data or pro
grams. The information contained on a ROM chip cannot be changed and is not lost 
when the computer's power is turned off. 

RS-232C-A standard form for serial computer interfaces. 
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select-Clicking the pointer on an icon. 
serial communications-A method of data communication in which bits of infor

mation are sent consecutively through one wire. 
soft crash-A system loss that can be recovered through rebooting the software disk. 

Data will still be lost through this crash, however. 
software-A set of programmed instructions that the computer must execute. 
statement-A single computer instruction. 
subroutine-A small program routine contained within a larger program. 

terminal-An input/output device that uses a keyboard and a video display. 
top layer-The element or elements that are drawn last in GEM Draw. Contrast this 

definition with bottom layer. 

tree-A hierarchical file or object structuring with the root or base element situated 
at the top of the network. 

word-A basic unit of computer memory usually expressed in terms of a byte. 
write protect-A technique for preventing a computer's disk drive from writing data 

to the storage medium. 
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6 
68000 instruction set, mnemonic al

phabetical listing of, 52 

8 
8088 instruction set, mnemonics for, 

51 

A 
absolute mode, 168 
active zone, 153 
alarm mode, 21 
ambiguous file reference, xii 
application environment services 

(AES), 169 
arrows, 17 
aspect ratio, 200 
AUTOEXEC.BAT file, 7, 9 

GEM startup disk containing, 9 

BOOS, xi 
BIOS, xi 

B 

bit-mapped images, 112 

C 
calculator accessory, 19, 20 
cameras 

color option for, 42 
film option for, 41 
fonts for, 48 
ports for, 48 

clicking, 10 
close box, 14 

clicks vs. commands, xxiv 
clock accessory 
color monitors 

EBM enhanced graphics adapter, 
62 

Hercules color card, 61 
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Index 

IBM,61 
IBM color/graphics monitor 
adapter, 61 

IBM enhanced color display, 62 
NEC MultiSync, 62 

Orchid TurboEGA, 62 
Paradise modular graphics card, 
62 

Princeton graphic systems HX-12, 
61 

Princeton graphic systems 
HX-12E,62 

STB EGA plus, 62 
Tandy CM-2 high resolution mon-
itor, 61 

Tatung CM1380, 61 
Taxan 630, 61 
Thomson .38mm color, 61 
Zenith ZVM-1330, 61 

color window, 83 
commands, 17-19 

available, 17 
choosing, 17 
open, 18 
show as text, 19 
sort by size, 19 
unavailable, 17 

concurrency, 179 
control program for microprocessors 

(CP/M), ix 
copying, 30 
CP/M-86 commands listing, xiv 

D 
delimiter, xii 
Desktop info, 19 
Desktop work area, 9 
DESQview, 179 

learn feature on, 180 
load files feature of, 181 
virtual memory in, 181 

destination drive, xvii 
dialog 

disk information, 23 
folder information, 24 
item information, 24 
set preferences, 28 
trash information, 24 

directory 
displaying the, 18 
icons for, 15 

disk icons, 9 
disk information dialog, 23 
dispatcher, ready and not-ready lists 

for, 169 
DOS equivalents for GEM, 196-197 
DOS internal and external com

mands for IBM PC-DOS, xvii 
DOS-based software in GEM en

vironment, 202 
dot matrix printers 

Apple computer LaserWriter, 64 
Epson FX, JX, MX, RX, 64 
Hewlett-Packard LaserJet + , 
7470A, 747A, 7440, 7550, 64 

IBM 7372, Color Jetprinter, 
Graphics printer, 64 

Juki 5510, 64 
Polaroid Palette, 65 
Star Micronics SG, SO, and SR, 
64 

double-clicking, 11 
dragging, xxii, 10, 

size box, 15 

elements, 112 
erasing, 31 

fields, 153 
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file directory management, xxiv 
file menu, 23 
filename, xii 
filetype, xii 
folder information dialog, 24 
folders, xxi 

opening, 16 
full box, 15 

GEM 
AES, 168 

G 

compatible computers for, 1 
disk management of, 174 
display requirements for, 2 
DOS equivalents for, 196-197 
DOS versions for, 1 
DOS-based software in environ-
ment of, 202 

environment of, 1 
graphics software for, 68 
hardware requirements of, 1 
icon summary of, 198-199 
input devices (optional) for, 2 
installation of, 2 
Macintosh vs., 174 
Macintosh interface vs., 173 
Macintosh vs. Desktop, 176-178 
memory requirements for, 2 
output device (optional) for, 2 
Paint package, 69 
porting, 166 
renaming a file with, 174 
storage for, 1 
VDI,166 
word processing software for, 68 

GEM compatible computers 50-67 
Apricot PC, F10, F2, 52, 53 
AT&T 6300, 59 
ATARI 520ST, 53 
COMPAQ,58 
displays for, 60 
IBM 3270, PC, PCjr, PCAT, 
PCXT, 54, 56, 57, 58 

ITT XTRA, 59 
other computers for use as, 59 
Sperry PC, 60 
Tandy 1000 & 1200 HD, 60 
Zenith,59 

GEM Desktop 
additional management com-
mands,30 

auto-execution batch file for, 6 
batch file for, 6 
creating AUTOEXEC.BAT file for 
starting, 7 

keyboard equivalents for, 48 
menus for, 19 
mouse movement with, 10 
OUTPUT command for, 32 
two active floopy and one hard 
disk drive in, 6 

two active floppy drives in, 7 
version 2.1 summary for, 185-195 
windows in, 12 
work area of, 15 
working on, 5 

GEM Draw, 112 
advanced techniques for, 128 
arrange menu for, 125 
backing up, 113 
color menu for, 127 
creating MY.SYM with, 129 
desk menu for, 120 
drawing surface for, 117 
edit menu for, 122 
element menu for, 117, 127 
file menu for, 121 
font menu for, 123 
installing, 113, 115 
line menu for, 127 
menu bar for, 116 
page menu for, 123 
panner for, 118 
pattern menu for, 127 
picture element control for, 118 
reference for, 120 
select mode icon for, 118 
title bar for, 117 

GEM Graph, 131 
advanced techniques with, 144 
backing up, 132 
data window for, 136 
desk menu for, 138 
edit menu for, 140 
file menu for, 138 
font menu for, 144 
gallery menu for, 141 
graph for, 137 
importing data into, 145 
installing, 132, 133 
menu bar for, 135 
options menu for, 142 
placing two graphs on single page 
with, 145 

reference for, 138 
title bar for, 135 
toolkit for, 137 
using, 134 
working in display window with, 
137 

GEM Paint 
advanced techniques for, 86 
backing up, 70 
brush shape command for, 79 
color palette for, 74 
desk menu for, 75 
drawing commands for, 85 
file menu for, 77 
font menu for, 82 
installing, 69, 71 
line palette for, 74 
menu bar for, 73 
microscope tool for, 84 

painting surface for, 74 
pattern palette for, 74 
patterns menu for, 79 
reference for, 74 
selection menu for, 79 
size picture for, 79 
snapshot utility, 76 
style menu for, 82 
title bar for, 73 
tools menu for, 77 
tools palette for, 74, 83 
transparent overlay command for, 
79 

using, 73 
GEM Programmer's Toolkit, 164 

GEM AES, 168 
GEM resource construction set 
(RCS), 171 

GEM VOl with, 166, 200 
porting GEM with, 166 
sample application of with, 165 
sample desk accessory with, 165 

GEM VOl, 200 
GEM Version 2.1, 185-195 
GEM WordChart, 147 

advanced techniques for, 161 
backing up, 148 
bullets, numbers, and letters with, 

161 
color with, 160 
converting .BAK to, 162 
designing borders with, 157 
desk menu for, 154 
edit menu for, 156 
file menu for, 155 
font style and size with, 161 
installing, 148, 150 
installing Dutch font of, 151 
keyboard commands for, 153 
menu bar for, 151 
mouse activities and equivalents 
in, 154 

options menu for, 159 
pointer for, 153 
references for, 153 
ruler for, 152 
template menu for, 157 
text alignment with, 161 
text template for, 152 
title bar for, 152 
toolkit for, 153 
toolkit tools for, 160 
using GEM Draw with, 161 

GEM Write 
advanced techniques for, 109 
backing up, 88 
capabilities of, 87 
cursor for, 93 
desk menu for, 97 
double-dot commands for, 
109-111 

edit menu for, 101 
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file menu for, 98-101 
font menu for, 104-107 
highlighting text with, 93 
installing, 88, 89 
keystrokes for, 95 
menu bar for, 91 
mouse activities and keyboard 
equivalents for, 96 

options menu for, 107 
reference for, 97 
search menu for, 102 
special features of, 95 
status line for, 93 
using, 91 
Wordstar command structure vs., 
94 

GEMPREP,2 
GEM PREP 2.1, 187 
GEMSETUP,44 

categories menu for, 47 
desk menu for, 45 
device drivers for, 43 
file menu for, 45 
using, 91 

graphics device operating system 
(GDOS), 166 

graphics environment manager 
(GEM), xviii 

graphics software, 68 
graphics system extension (GSX), 

200 
group select, 12 

H 
hard disk drives, 66 

Mountain Computer 20M-byte 
DriveCard,67 

Plus Development Hardcard, 67 
Seagate 20M-byte Internal Hard 
Drive, 67 

hard return, 95 

icons, xv, 9 
directory, 15 
disk,9 
movement of, 10 
summary of GEM, 198-199 
trash, 9, 11 

information line, 17 
input, mouse devices for, 62 
install application, 26, 27 
item (GEM file), xxi 
item information dialog, xxi, 24 

L 
limited multitasking kernel, 169 

M 
margin indicators, 152 
master control program (MCP), viii 

memory devices, 65 

212 

memory expansion boards 
AST SixPak Plus, 66 
IBM 64/256Kb Memory expansion 
option, 66 

Intel Above Board, 66 
Orchid Conquest, 66 

menu bar, 9, 18 
menu-resident GEM commands, xix 
menus 

desk, 19, 20 
displaying, 17 
GEM Desktop file, 23 
GEMSETUP categories, 47 
GEMSETUP desk, 45 
GEMSETUP file, 45 
options, 25 
output desk, 33 
output edit, 37-38 
output file, 34-37, 
output options, 38-43 
view, 18,24 

metafiles,48 
monochrome monitor 

AST preview, 60 
COMPAQ display adapter, 60 
Hercules graphics card, 61 
IBM monochrome display, 60 
Paradise modular graphics card, 
61 

Princeton graphics systems 
MAX-12,60 

Tandy VM-3 monitor, 60 
Zenith ZVM-1240, 60 

mouse input devices, 63 
LOGITECH LOGIMOUSE C7, 62 
Microsoft mouse, 62 
Summagraphics MM series 
tablets, 63 

SummaMouse, 63 
mouse movement, 10, 169 

duplication through keyboard in
teraction, 49 

special, 12 
movement window, 83 
multitasking, 179 

o 
operating system/360 (OS/360), ix 
options menu, 25, 26 
OUTPUT command 

creating an output list with, 32 
menu bar for, 33 
overview for using, 32 

P 
PATH command, 28 
personal computer disk operating 

system (DOS), xiv 
plotter option and ports for, 41 
plotter ports, 48 
point mode, 168 
pointer, 10 

porting, 166 
print spooler, xxiii 

using the, 22 
printer option, 40 
printers, 40 

fonts for, 48 
ports for, 48 

prompt symbol, xii 

R 
ready acknowledg ment, xii 
renaming, 32 
resource construction set (RCS), 

171 
resource files, 171 

S 
screen manager, 169, 170 
scroll bars, 17 
select boxes, 153 
set preferences dialog, 28 
shell, 170 
shift-click, 12 
show info, xxiii 
size box, 15 
sliders, 17 
soft crash, 3 
source drive, xvii 
subdirectories, xxi 
subroutine libraries, 169 
symbol graph, 128 
system, viii 

tablet ports, 48 
text cursor, 153 
time mode, 21 
TopView, 179 

GEM vs., 184 
TPA, xi 

T 

trash icons, 9, 11, 24 

U 
unambiguous file reference, xii 

V 
~ew menu, 1~ 2~ 25 
virtual device interface (VOl), 166 

W 
wildcard characters, xii 
window, 12, 179 

activating, 13 
closing, 13 
dragging a, 15 
GEM vs., 181 
menus for, 182 
sizing, 13, 14 

word processing software, 68 
word wrap, 95 • 
wordcharts, 147 
work area, moving the, 16 


